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General Information

This user manual is suitable for novice, intermediate, and experienced users and is intended to help use the
features and capabilities of VeEX Inc. products successfully. It is assumed that the user has basic computer
experience and skills, and is familiar with telecommunication and other concepts related to VeEX Inc. product
usage, terminology, and safety.

Every effort was made to ensure that the information contained in this user manual is accurate. Information is
subject to change without notice and we accept no responsibility for any errors or omissions. In case of dis-
crepancy, the web version takes precedence over any printed literature. The content in this manual may vary
from the software version installed in the unit. For condition of use and permission to use these materials for
publication in other than the English language, contact VeEX Inc.

© Copyright VeEX Inc. All rights reserved. VeEX, Sunrise Telecom, Digital Lightwave, Air Expert, CaLan,
FaultScout, Fiberizer, MPA, MTT, RXT, VeGrade, VeriPHY, and VeSion, among others, are trademarks or
registered trademarks of VeEX Inc. and/or its affiliates in the USA and other countries. All trademarks or
registered trademarks are the property of their respective companies. No part of this document may be repro-
duced or transmitted electronically or otherwise without written permission from VeEX Inc.

This manual describes software and/or a device that uses software either developed by VeEX Inc. or licensed
by VeEX Inc. from third parties. The software is confidential and proprietary of VeEX Inc. The software is pro-
tected by copyright and contains trade secrets of VeEX Inc. or VeEX's licensors. The purchaser of this device
and/or software, downloaded or embedded, agrees that it has received a license solely to use the software as
embedded in the device and/or provided by VeEX Inc., and to use it solely as intended and described in this
manual. The purchaser is prohibited from copying, reverse engineering, decompiling, or disassembling the
software. 

Customer Support

For more technical resources, visit www.veexinc.com.

For assistance or questions related to the use of this product, call or e-mail our customer care department for
customer support. Before contacting our customer care department, have the product model, serial number,
and software version ready. Please locate the serial number on the back of the chassis. Please provide this
number when contacting VeEX Inc. customer care. 

Support hours may vary depending on the product.

Product Technical Support Contact Information

Hours: Support is generally available 8:00 AM to 8:00 PM, Eastern Standard Time, Monday to Friday.
Phone: +1 510 651 0500
E-mail: customercare@veexinc.com

10 © VeEX Inc. All Rights Reserved. Table of
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Warranty

For warranty information on VeEX Inc. products, go to www.veexinc.com.

To activate the warranty, please register your production at www.veexinc.com/Support/ProductRegistration.

Patent Information

VeEX Inc. product hardware and software may be protected by one or more patents on file with the United
States Patent Office.

Documentation Conventions

Icons used in this manual:

Marks a helpful tip (action or method), which can save time and improve
usability of the product.

Provides important information needed to use this product and avoid mis-
steps.

Cautions against and action or inactivity, which can hinder productivity.

Strongly warns against a condition, an action, or inactivity which can lead
to a health hazard, injury, equipment damage, data loss, and/or financial
losses.

Stop and read before continuing.
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Safety Information

Safety precautions should be observed during all phases of operation of this instrument. The instrument has
been designed to ensure safe operation; however, please observe all safety markings and instructions. Do not
operate the instrument in the presence of flammable gases or fumes or any other combustible environment.
VeEX Inc. assumes no liability for the customer's failure to comply with safety precautions and requirements.

Lithium-ion Battery Precautions

Lithium-ion (Li-ion) battery packs are compact and offer high capacity and autonomy, which make them ideal
for demanding applications, like providing long lasting power to portable test equipment. For safety reasons,
due to their high energy concentration, these batteries packs and products containing themmust be used,
charged, handled, and stored properly, according to the manufacturer’s recommendations.

Li-ion battery packs contain individual Li-ion cells as well as battery monitoring and protection circuitry, sealed
in its plastic container that shall not be disassembled or serviced.

The test set unit's battery pack is also fitted with a safety connector to prevent accidental short circuits and
reverse polarity.

l Always charge the unit's battery pack inside the test platform battery bay using the AC/DC adapter

supplied by VeEX.

l Do not charge or use the battery pack if any mechanical damage is suspected (shock, impact, punc-

ture, crack, etc).

l Do not continue charging the battery if it does not recharge within the expected charging time.

l Storage: For long term storage, the battery pack should be stored at 20°C/68°F (room temperature),

charged to about 30 to 50% of its capacity. Spare battery packs should be charged and used at least

once a year to prevent over-discharge (rotate them regularly).

l It is recommended to charge and use battery packs at least every three months. Battery packs shall

not go without recharging (reconditioning) for more than six months.
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l After extended storage, battery packs may reach a deep discharge state or enter into sleep mode.

For safety reasons, Li-ion batteries in deep discharge state may limit the initial charging current (pre-

recharge) before starting their regular fast charging cycle. The pre-charging state may take several

hours.

l Air transportation of Li-ion batteries is regulated by United Nations' International Air Transportation

Association (IATA) Dangerous Goods Regulations and by country-specific regulations. Please

check local regulations and with common carriers before shipping Li-ion battery packs or products

containing relatively large Li-ion battery packs.

Optical Connectors

The test sets display a laser warning icon when the laser source is active to alert the user about a potentially
dangerous situation. It is recommended to:

1. Deactivate the laser before connecting or disconnecting optical cables or patchcords.

2. Never look directly into an optical patchcord or an optical connector interface (SFP+) while the laser

is enabled. Even though optical transceivers are typically fitted with Class 1 or 2 lasers, which are

considered eye safe, optical radiation for an extended period can cause irreparable damage to the

eyes.

3. Never use a fiber microscope to check the optical connectors when the laser source is active.

Electrical Connectors

Telephone lines may carry dangerous voltage. Always connect the electrical test ports to known test interfaces
which carry low level signals.
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Introduction

The MTX150x is a fully-integrated and self-contained Ethernet and internet services test solution for Layer 1-
to-4+ applications and Fibre Channel (SAN). This rugged and ultra-portable field hand-held test set can be con-
figured with interfaces and technologies required by field technicians to install, verify, maintain and
troubleshoot Metro Ethernet links, Business services, Internet Access and other packet-base services up to 10
Gbps.

Product Specifications

The most recent product specifications can be downloaded from the product page of the VeEX Inc. website.
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Basic Operation

Chassis Overview

To power on the test set, press for approximately two seconds, until the test set beeps once. See "Hard
Buttons and Interfaces" on page 17 for more information on the test set's buttons and interface.
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Connector Panel

MTX150X Connector Panel

1. Dual RJ45: 10/100/1000, 2.5G/5G, 10G BASE-T

2. Dual SFP+: 10GBASE-X, 1000BASE-X, 100BASE-FX 1/2/4GFC

3. SMA: External Reference Clock Input

4. TRS: 2.5mm: Headset jack (VoIP)

5. LEDs: Activity (P1, P2)

6. LEDs: Link (P1, P2)

Dual SFP+ LEDs
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Hard Buttons and Interfaces

A. Save: Saves current test results in the unit's memory and provides automatic naming and time stamping
function.

B. Power: Press for 2 seconds to turn the test set ON or OFF.

C. Home: Returns the screen to the home menu. Pressing the Home key for 3 seconds puts the unit in sleep
mode. Once in Sleep Mode, press the Home key for 3 seconds to return to normal operation.

More about sleep mode

This is not full power shutdown.
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Standby/Sleep Mode

F. Side Buttons: Side buttons on the left and right side of the unit provide additional feature-specific func-
tionality such as revealing menus and scrolling through table results. Button functions vary depending on indi-
vidual applications (e.g., push to expand left or right menu bar, scroll left/right or up/down, capture
screenshots). Refer to "Hard Buttons" on page 20 for the Quick Guide displayed during boot-up sequence.

Side Button Shortcuts:

l Right side + Save: Saves the screen (bmp)

l Right side + Home: Hibernates device

More about side buttons

Side buttons on the left and right of the unit can reveal menus or other functions depending
on the unit
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D. LED: Power ON and battery charge LED indicator

l Off - Power is OFF, not charging.

l Orange - Battery is charging.

l Green - Power is ON.

E. Micro-B USB: Use an USB-A OTG cable (optional with purchase) to connect a USB to the micro-B USB
port. The port supports memory drives and USB add-on devices such as fiberscopes. An optional Micro-B
OTG to Ethernet adapter is also available for network connection. (Only VeEX approved OTG to Ethernet
Cables can be used.)

G. Test port connector

Use certified CAT 6a or CAT 7 UTP test patch cords.

H. Touch screen LCD
I. Stylus: Use when finer touch screen control is required.
J. DC power socket: Use VeEX-supplied AC/DC chargers only.
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Special Functions

Hard Buttons

The test set buttons provide additional functions when using specific combinations.

Button Quick Guide

Power ON/OFF: Press and hold for approximately two seconds, until the test set emits one beep to turn it
ON. and two beeps to turn itOFF, then wait for the power LEDs to turnOFF.

Wait at least 10 seconds before turning the test set back on.

Forced Power OFF: In the unlikely event that the test set becomes non-responsive or behaves improperly,

press and hold for approximately six seconds to force the test set off.

No results will be saved when forcing the test set to power down.

Standby/Sleep Mode: This mode is used to conserve battery when the test set is required to “boot up” and be
ready to test faster.
First, release any active test application. Then, press and hold the for approximately three seconds to
activate the Sleep or Standby mode. Once activated, the power LEDs will flash green to indicate that the test
set is in standby mode (the fans may stay on until all electronics cool down).

After switching to Standby mode, the fans may stay on until all electronics cool down.

While in Standby mode, quickly press to see the current standby time and remaining battery charge.
Press the button again for three seconds to bring the test set back to full operation.
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Save Results: Press save the current test results.

Home Menu: Press to go back to the Main Menu. Tap on the screen to return to the previous menu
level.

Screen Capture: Press + right slider buttons simultaneously to store a picture of the current screen
(screenshot). The test set will emit a confirmation beep/tone when the screen is captured. The images are
named with a date + time code. Go to Utilities>Files >Saved to manage, view, or transfer captured screens.
Refer to "Working with Saved Results, Profiles, Images" on page 279 for more details.

Touch Screen Calibration: If the touch screen becomes non-responsive, press + sim-
ultaneously to invoke the touch screen calibration procedure. Refer to "Touch Screen Calibration" on page 245
for more details.

Clean Software Install: With the test set OFF, press + buttons simultaneously to initiate a clean
software install from an USBmemory stick. Refer to "Software Update Process" on page 324 for more details.

All settings, test results and user data will be erased when performing a Clean
Software Install. Backing up all data to a USB memory stick is recommended. To back up to
USB, go to Utilities>Files >Saved and tap . Refer to "Working with Saved Results, Pro-
files, Images" on page 279 for more details.

Soft Buttons

On screen soft buttons are used to control tests, alarms and error settings. Refer to the chart below for a
description of each soft button.

Testing, Alarm and Error Soft Buttons
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Touch-Screen Display

The LCD supports touch-screen operation. To operate the touch-screen, use the stylus located in the top cover
to navigate the menus and tabs. Please observe the following precautions:

l Never use excessive pressure on the touch-screen as this may damage its functionality.

l Never use sharp objects such as a pen, screwdriver etc. as this may damage the surface.

l Clean the surface of the touch screen using a soft cloth and mild detergent only. Do not use alcohol.

See "Touch Screen Calibration" on page 245 for instructions on how to recalibrate the touch-screen.
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Platform Screen Icons

File: Provides general internal storage information. indicates the presence/detection of com-
patible USB memory stick and provides proper memory stick ejection function (before removing).

Exit: Return to the previous screen.

Home: Return to the Home Menu.

Help: Displays product help.

Active Test Application: Access to test applications or test application menu which varies
depending on the test set mode. WiFi, SLM, FIBER, OSA, and Fiberscope are some of the applic-
ations available.

Application Tools: Access applications, depending on options purchased i.e. OTDR Viewer,
VeEX Flow, GPON, OLTS, Speedtest, etc.

Utilities Test Application: Opens the System Tools and Utilities menu.

Shift Key: Serve the same function of expanding the side menu bars as pushing the physical
side buttons on the sides of the unit. Tap to reveal/hide icons and test function keys.

AC Charging: The unit is plugged into external AC power. Tap to see battery charge status.

Battery Powered: The unit is powered by the battery. Tap to see battery charge status and
estimated autonomy time.

Fiberscope: Indicates that a fiberscope is connected to the unit. Tap the icon to go to the Fiber-
scope application.

OTDR Viewer: Analyzes standard OTDR .SOR files created by supported VeEX test sets and
controls the OPX-BOXe OTDR.
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FX40/45/48 Viewer: Controls FX40/45/48 optical test loss test sets and analyzes standard OPM
files.

PON: Access Advanced PON tools

Flow: Access the Flow feature to perform and compile multiple tests into a single job report.
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LEDs

Power LED: A single LED indicates the power state of the unit

l The LED is off when the unit is powered off.

l The LED is green when the unit is powered on.

l The LED is orange when the unit is connected to the AC Mains and powered off (charging).

Soft LEDs: Each tests module offers detailed soft LEDs and indicators in its test application.

Ethernet Dual Port LED Status Lights

l Signal: A valid input signal is detected.

l Frame: Valid framing on the input signal is detected.

l Pattern: Indicates test pattern synchronization in BERT, RFC, and Throughput

modes.

l Alarm/Error: Alarms or errors are detected.

l Test Ports: P1 (port 1) and P2 (port 2) can be used to switch views in dual port mode.

The color indicates the alarm status:

l Green: No error or alarm is present

l Red: An error or alarm condition is currently detected

l Red flashing: Event history reminder. Any error or alarm has occurred in the past, but no longer

present.

l Yellow: An error or alarm was detected during the measurement interval but is no longer present or

active

l Grey: Status not applicable or the test has not begun yet

For test modes that support dual ports, P1 and P2 indicates the port in operation.
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Mode/Port Selection

Test mode, test port(s), and network settings are required prior to performing any measurements or applic-
ations.

Test modes are accessed by selecting the Test Application button . Tap on a technology group then
select a test interface.

Test interfaces requiring laser activation will indicate the active test port when the laser is turned on. In the
example below, the Active 2G fiber channel port is active .

Turning the Laser On Activates the 2G Test Port for Fiber Channel

Toggle between Port 1 and Port 2 by tapping on the slider button.

Toggle between Port 1 and Port 2
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Ethernet

Ethernet

Setup

Ethernet Home Menu

When the soft LEDs are steady green, this indicates that the module is ready to perform different tests. This
may require turning the LASER On button for optical interfaces or tapping the History tab to clear blinking LED
reminders of past Errors and Alarms (test results are not affected).

Ports

Port setup or test interface configurations are accessed via the Setupmenu located on the Home page. The
available configuration settings depend on the interface selected in the Test Mode selection.
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Select the operation mode and the interfaces that will be used to carry out tests. Once the operating mode and
interfaces are selected, independently configure the auto-negotiation, speed, duplex, and flow control settings
for each port (where applicable).

After configuring settings, tap Apply to save changes. Tap Discard to revert to previous selections.

100/1000Base-X Port Setup

100/1000Base-X and 100/1000Base-T Port

l Auto Negotiation: On or Off. Matches the test set’s negotiation settings to those of the link partner

l Speed (only when Auto Negotiation is Off for 100/1000T): 10 Mbps, 100 Mbps, or 1000 Mbps

l Duplex (only when Auto Negotiation is Off): Half or Full

l Advertisement (only when Auto Negotiation is On for 100/1000 Base-T): Default-All or Custom.

Custom options include 10/100/1000M/Half or 10/100/1000M/Full.

l Flow Control: TX On, RX On, Both On, or Off

l When flow control is On, the test set will respond to pause frames received by the link partner

by adjusting the transmit rate

l When flow control is Off, the test set ignores all incoming pause frames from the link partner

and continues transmitting at the configured transmit rate

l Clock Offset (1000 Mbps only): The frequency may be offset in parts per million
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l MDIX (100/1000Base-T only): Off, On, or Auto. When MDIX is set to Auto, the test set detects the

required cable connection type and configures the port connection properly for interfacing the part-

ner device, eliminating the need for crossover cables.

l Transmit clock offset (100/1000Base-T only): Disabled or Enabled. Due to hardware limitation,

transmit clock offset is only valid when PHY is working on Master mode. Clock offset measurement

is only valid when PHY is working on Slave mode.

l PHY working mode: Master or Slave.

l Transmit Ignore Link Status: On/Off

l Synchronous Ethernet (SyncE): Disabled or Enabled. When Enabled, makes the signal traceable

to an internal or external reference clock.

For information on configuring SyncE operation, see Port Page 2 - Mode Selection in the
"SyncE" on page 169 section.

Status

Status tab for 10/100/1000Base-T

The Status tab lists current port settings. Please note that the Status tab is only available if a fiber port option is
selected from the Test Port Selectionmenu.
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10 GE Port

l 10GE Mode: LAN or WAN

l WIS Mode (only available in WAN mode): SDH or SONET

l Flow Control: Enable chosen as default option

l Clock Offset (ppm): The frequency may be offset in parts per million

l Link Fault Response: Disable or Enable (also enables Local link and failure, remote, failure)

l Transmit Ignore Link Status: On/Off

l Synchronous Ethernet: (SyncE) Disabled  or Enabled. When Enabled, makes the signal traceable

to an internal or external reference clock.

Measurement Settings

Measurement Setup

The measurement and event log settings are configured in this screen.

l Mode: Manual, timed, or auto mode are available.

l Manual mode: Starts and stops the measurements manually.

l Timed mode: Defines the duration of the test; after the test is started, the test will run for the

configured duration and stop automatically.
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l Event Log: Logs up to 1000 event entries. If there are more than 1000 events,

l Circular keeps the latest entries. The oldest entry will be deleted so that the new event can be

added.

l Blocked stops recording new events after 1000 entries. The latest entries will not be logged.

l TX Start: Separated or Coupled. Configures how the measurements are started when in BERT and

Multiple Streams test modes.

l Separated: Independent control (Start/Stop) of the transmitter is enabled. At the start of the

test only the receiver is turned on -- the user must start the transmitter manually.

l Coupled: Transmitter and receiver are turned on at the same time, and the Tx and Rx meas-

urements start at the same time at the start of the test.

l Clock (ToD) Synchronization Device: Disable, GPS, 1PPS, Local, Atomic 1PPS. Select the

device to be used to synchronize the clock to perform the One Way Delay measurement.

When a device is selected the following fields can be seen on the screen:

l External Clock Input: 1pps (SMA Port). The SMA Port must be used for the 1pps sig-

nal.

l UTC ToD: Displays the Coordinated Universal Time (UTC) Time of Day once it is

acquired.

l Clock Sync Time: Time field to configure the UTC ToD that both test sets, carrying out

a one-way delay test between each other, will be synchronizing their internal time stamp-

ing at.

Both test sets must be configured to the same Clock Sync Time.

Clock Synchronization is not supported on all the test set models.
Check with customer care for availability.
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l Gratuitous ARP: ON or OFF. If set to ON, a gratuitous ARP is performed. When the test port has an

IP connection, an ARP request will be transmitted at regular intervals to keep the router/gateway

ARP table aware of the test set's IP address. This setting is useful for long-term L3 routed testing.

l Results Auto Save: ON or OFF. If set to ON, results will be saved automatically.

MX Discover and Control Settings

Before proceeding with MX Discover or Control, be sure to assign an IP address to each test port. To assign an
IP address, proceed to the home menu and select the IP icon. Refer to IP Connection for additional instruc-
tions.

If using OAM Discover, it is unnecessary to assign an IP address to the local or remote unit.

Using MX Discover

MX Discover enables the test set to discover other VeEX VePal test sets and devices with an assigned IP
address on the same subnet.

To discover other devices usingMX Discover:

1. Tap on the MX Discover button and then press Discover.

2. A list of discovered devices on the same IP subnet will appear. Select a unit to connect to from the

list of devices.

3. Tap Close to exit the window.

MX Discover Tool
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MX Discover Remote Partner

Loop Control

The Loop Control button becomes available on the right side menu when any Ethernet application (V-SAM,
RFC 2544, Throughput, BERT) is selected. Press the Loop Control button to configure loop up and loop down
commands necessary to control a far-end unit. The loop up command contains information about the test layer.
Looping back test traffic is possible as follows:

l MX Discovered: Lists MX discovered devices. Select from the list of discovered devices to loop up/-

down

l User Defined: Input the destination IP address of the far-end device

l X-Loop: Loops non-VeEX networking equipment.

Remote Partner Control
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The Peer-to-Peer option is available only for RFC2544.
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IP

IP Connection

Port setup and IP connection are required prior to performing the following Ethernet applications: Ping, Trace
Route, Web/FTP, ARPWiz, VoIP, IPTV testing, and 1388v2 (except Layer 2).

Tap IP from the Ethernet home menu to access Port and IP settings.

IP menu option

Setup

Select PPoE, IPv4, or IPv6 from theModemenu.

Point-to-Point Protocol over Ethernet (PPoE)

l Authentication: PAP, CHAP, or CHAP & PAP.

l VLAN: Off or 1 Tag.

l ID: VLAN ID. Enter value 0 to 4095.

l Pri: VLAN priority 0 to 7.

l DNS: Selecting Manual DNS opens another menu. Select from Off, Primary, or Primary & Sec-

ondary. Enter the Primary and/or Secondary DNS if required.

IP Setup - IPv4
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IPv4 or IPV6

l IP Type: IPv4 or IPv6

l Profile: Delete, Save, Save as ..., Default

l IP Address: Static, DHCP (IPv4 only) or AUTO (IPv6 only)

l Static: Enter a Local IP, Gateway address, and Subnet. All Static fields can be filled by tapping on

the section to access an alphanumeric keyboard.

o Local IP: IPv4/IPv6 address of the test set

o Gateway: IPv4/IPv6 address of the network gateway

o DNS: Input a primary and secondary DNS.

o CIDR (IPv6 only): Enter a Classless Inter -domain Routing Network.

o Subnet (IPv4 only): Enter a subnet mask.

l Gateway and DNS: Enable/Disable. Enables entering the Gateway and DNS.

l VLAN: Off, 1 Tag, 2 Tags. For each VLAN tag, enter the following:

o ID: VLAN ID. Enter value 0 to 4095.

o Pri: VLAN priority 0 to 7.

Status

Ensure the Status is PASS before continuing with any IP tests. If the connection fails, go back to the setup
screen to verify that the parameters are entered correctly. Verify that the Ethernet cable is properly connected
on the management port on the left hand side of the unit.
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PASS Status

l DHCP: PASS indicates that an IP address has successfully been assigned.

l IP: PASS indicates that the IP address assigned has been verified to be unique in the network.

l Gateway: PASS indicates that the gateway IP address is valid.

l DNS: PASS indicates that the DNS IP address is valid.

Trace Route

Trace Route is a common method used to find the route to the destination IP address or URL. It is often used to
identify routing problems and unreachable destinations. All the remote IP addresses and their response times
are displayed indicating possible network congestion points.

Trace Route - Setup
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Trace Route Setup

The following setup selections are available:

l Profile: Delete, Save, Save as..., Default. Select Default to recall a trace route file or create a new

test.

l Destination: Enter the IP address or URL of the network device to be detected.

l Time Out: Enter the maximum time allowed between an ICMP echo and response at each hop.

l Max Hop: Enter the maximum number of network devices the packet is allowed to transit.

Once the parameters are configured, press Start to begin the test.

Trace Route - Results

Results

l Hop: Order of the routers on the route

l TTL: Time to reach each router on the route

l Address: Address of each router on the route

If there is no response from a particular hop, an asterisk will be displayed.
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ARP Wiz

ARPWiz uses the Address Resolution Protocol (ARP) to verify the status of each IP address in a user-select-
able IP range. ARP is the standard method for finding a host's hardware address when only its network layer
address is known. In other words, ARP is used primarily to translate IP addresses to Ethernet MAC addresses.
ARP is defined in RFC826.

ARP Setup

Configure the following parameters and press Start. The test will continue to run until Stop is pressed. A fin-
ished status indication will display when the test finishes.

l Profile: Default, Delete, Save, or Save As...

l Start IP: Starting IP Address

l End IP: Ending IP Address

l Time Out(s): Range from 1-99 seconds. Input using the numeric keypad.

ARP Wiz Setup

https://tools.ietf.org/html/rfc826
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ARP Result

The MAC addresses associated with active IP addresses in the range are displayed. If no MAC address is
associated with the IP address, a FAILED status is displayed.

ARPWiz uses the ARP protocol and can only work within the same subnet as the IP address provided to
the test set in IP Status.

ARP Wiz Result
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Ping

The Ping Result provides the number of Sent, Received, Unreach, Missing, and the Round Trip delay.

Ping Testing

Ping is a popular computer network tool used to test whether a particular host is reachable across an IP net-
work. A ping is performed by sending an echo request or ICMP (Internet Control Message Protocol) to the echo
response replies.

Ping Setup

Ping Setup

l Profile: Delete, Save, Save as..., or Default

l Destination: Press the drop -down menu and enter the destination IP address or URL to ping.

l Number of Pings: Enter the number of ping attempts (up to 10000) that will be performed to reach

the network device.
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If Continuous Ping is selected, the user is not required to enter the number of pings. The test
set will continuously ping the target host until the user presses Stop.

l Length: Enter the length of the ICMP echo request packet transmitted.

l Ping/Sec: Enter the Ping repetition rate (Ping/second).

l Time Out: Time-to-Live (TTL) in milliseconds. Enter the maximum time allowed (in ms, up to 99999

ms) between an ICMP ping and echo response.

Once the parameters are configured, press Start to begin the test.

Ping Results

Pressing Ping will take you to the Result tab and start the Ping test.

Ping Result

l Destination: Destination IP address

l Ping status: In Progress, PASS, or FAIL

l Sent, Received, Unreach, Missing: Number of pings sent, received, unreached or missing. A Ping

is counted missing if no response is received before timeout. A Ping is counted unreached if an echo

response is received with host unreachable set.
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l PING also estimates the Round-Trip time in milliseconds.

l Current: Current time for a Ping request to be answered

l Average: Average time recorded for a Ping request to be answered

l Max: Maximum time recorded for a Ping request to be answered

l Min: Minimum time recorded for a Ping request to be answered.
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BERT

BERT Setup

Tap on Advanced Tools (Home Menu) > BERT icon to access BER testing features.

Overview

BER testing at Layer 1, 2, 3, and 4 is supported. The BERT can be configured to use either regular PRBS test
patterns, stress patterns (specifically for 10Gigabit Ethernet) or user defined test patterns to simulate various
conditions. The test layer, frame header, traffic profile, error injection, and control settings of the far-end device
(if applicable) must be configured prior to testing.

l Layer 1: Unframed mode (fiber ports only) or Framed mode

o Unframed mode: Test traffic consists of a bit stream of the selected test pattern

o Framed mode: Test pattern is encapsulated into a valid Ethernet frame with SOF, Preamble,

and CRC field

l Layer 2: Framed BERT (same as Layer 1 Framed)

o MAC Address: A default or user configured Media Access Control (MAC) address is added to

the frame

l Layer 3: Framed BERT (same as Layer 1 & 2 Framed)

o MAC Address: A default or user configured Media Access Control (MAC) address is added to

the frame

o IP Address: A default or user configured IP address is added to the frame

l Layer 4: Framed BERT (same as Layer 1, 2, & 3 Framed)

o MAC Address: A default or user configured Media Access Control (MAC) address is added to

the frame

o IP Address: A default or user configured IP address is added to the frame
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o UDP or TCP Address: A user defined source and destination port address is added to the

frame

BERT Setup - Header (Layer 4)

Header Settings

l BERT Profile: Load a previously configured test profile or create a new profile from existing set-

tings.

l Encapsulation Type: None, Provider Backbone Bridge (PBB-TE), or Multiprotocol Label Switching

(MPLS-TP). MPLS-TP is a simplified version of MPLS. Provider Backbone Bridge MAC-in-MAC

(IEEE 802.1ah) encapsulation are configured trunks that add resiliency and configurable per-

formance levels in the provider backbone network. Both options are available for 1GE Copper/Fiber

and 10GE port for all Ethernet tests (Layer 2,3 and 4) - BERT, RFC2544, Throughput, V-SAM.

Tap the PBB orMPLS-TP block to configure the settings. All fields are configurable

o Backbone MAC Source

o Backbone MAC Destination

o Ethernet Type
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o I-SID

o Backbone VLAN ID, Priority, Type

MPLS-TP:
o MPLS-TP MAC Source

o MPLS-TP MAC Destination

o Ethernet Type

o VLAN ID, Priority, Type

o LSP, PW, CW

PBB

l Test: Select the test layer to perform the BERT

l Options are Layer 1 Unframed, Layer 1 Framed, Layer 2, Layer 3, and Layer 4

l Frame Type: Select the Ethernet frame type for Layer 2 or Layer 3

l 802.3 Raw (IEEE 802.3 frame without LLC) - Not available when Layer 3 is selected

l 802.3 LLC (IEEE 802.3 frame with LLC header)

l 802.3 SNAP (IEEE 802.3 frame with SNAP header)
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l Ethernet II (DIX) (named after DEC, Intel, and Xerox, this is the most common frame type

today)

l MAC/IP: Tap the MAC and IP blocks on the Frame image to access the setup menus

l Set the Source and Destination MAC address for Layer 2

l Set the Source and Destination MAC and IP addresses for Layer 3 and Layer 4

l VLAN: Off, 1 tag, 2 tags, 3 tags

l The user is able to configure up to 3 VLAN tags (VLAN stacking, for Q-in-Q applications)

VLAN stacking is an option

l MPLS: Off, 1 tag, 2 tags, 3 tags

l The user is able to configure up to 3 MPLS tags

MPLS tag configuration is only available when the MPLS option is purchased

The most common Ethernet Frame format, Type II

MAC, VLAN, MPLS, IP, and Test Pattern Configurations

To configure the MAC addresses, IP addresses, VLAN tag(s), MPLS tag(s), and test pattern, tap on the frame
image displayed on the screen. This brings up the configuration screens for all the header fields.

l MAC Header Tab:

l MAC Source: Use the default source address of the test set or configure a new or different

address.

l MAC Destination: Configure the destination MAC address of the far-end partner test set or

use the ARP or ARP GW keys to determine the MAC address of the destination IP address
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(ARP) or the Gateway (ARP GW).

A valid IP connection needs to be up to use these functions. Refer to IP Connections

Port setup and IP connection are required prior to performing the following Ethernet
applications: Ping, Trace Route, Web/FTP, ARPWiz, VoIP, IPTV testing, and
1388v2 (except Layer 2).

Tap IP from the Ethernet home menu to access Port and IP settings.

l Ethernet Type: For Layer 2 testing, the user can also configure the Ethertype:

l 0800-IP (Internet Protocol Version 4, IPv4)

l 0600-Xerox

l 0801-X.75 (X.75 Internet)

l 0805-X.25 (X.25 Level 3)

l 0806-ARP (Address Resolution Protocol [ARP])

l 8035-RARP (Reverse Address Resolution Protocol [RARP])

l 8137-IPX (Novell IPX)

l 814C-SNMP

l 8847-MPLS unicast

l 8848-MPLS multicast

l 86DD (Internet Protocol, Version 6 [IPv6]) - Future Release

Tap on Mac Source, ARP, and ARP Gateway buttons to populate the fields with default test port

settings.
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BERT Setup - MAC address settings (Layer 3)

l VLAN Tab: In the VLAN tab the following parameters are configured:

l VLAN ID: Configurable in the range 1 to 4094.

l VLAN ID is the identification of the VLAN, which is basically used by the standard

802.1Q.

l It has 12 bits which allows the identification of 4096 (2^12) VLANs.

l Of the 4096 possible VIDs, a VID of 0 is used to identify priority frames and value 4095

(FFF) is reserved.

l Maximum possible VLAN configurations are therefore set to 4094.

l VLAN Priority: Configurable in the range 0 to 6

l Set by the Priority Code Point (PCP), a 3-bit field which refers to the IEEE 802.1p pri-

ority.

l It indicates the frame priority level from 0 (lowest) to 7 (highest), which can be used to

prioritize different classes of traffic (voice, video, data, etc.).

l Type: The following selections are possible:

l 8100 (IEEE 802.1Q tagged frame)

l 88a8 (IEEE 802.1ad Provider Bridging)
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l Drop Eligible: If enabled, drop eligibility flag will be set.

l VLAN Flooding: Enable/Disable.

l VLAN Flooding Range: Specifies the number of VLAN IDs. Enter a number from 0-4096. The

VLAN IDs will be incremented by 1 until it reaches the number of times entered in the flood

range.

IEEE 802.1Q VLAN Tag in an Ethernet Frame

BERT Setup - VLAN Tag configuration (Layer 3)
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l MPLS Tab: In the MPLS tab the following parameters are configured:

o MPLS label: Configurable in the range 16 through 1,048,575 (labels 0 to 13 are reserved).

Composed of 20 bits which allows for the creation of over one million labels.

o CoS: Configurable in the range 0 to 6.

This field is three bits in length and maps directly to IP Precedence TOS bits to provide

Class of Service (COS).

o S-bit: Configurable 0 or 1.

The S field is one bit in length and is used for stacking labels. This is important as it is

used to indicate the last label in the label stack.

o TTL: Configurable in the range 0 to 255. The default setting is 128 hops.

Used to decrement the time-to-live counter.

BERT Setup - MPLS label configuration

l IP Tab: In the IP tab the user must configure the destination IP address and source address. The

user may also configure the following IP header fields:
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o IP Type: IPv4

o IP Src and IP Dest: For IP Src, if the IP connection is up, refer to "IP Connection" on page 35.

The source address is fixed to the IP address from the IP setup menu.

o IP TOS (for Quality of Service testing):

l Legacy TOS (Precedence): The first three bits of the IP TOS field can be edited:

000 - Best Effort

001 - Bulk Data

010 - Transactional

011 - Call Signaling

100 - Streaming Video

101 - Voice

110 - Routing

111 - Reserve

l DSCP (Differentiated Services Code Point): The first six bits of the IP TOS can be

edited to provide more granular service classification.

For more information on the definition of DSCP field in IPv4 and IPv6 headers, refer to

RFC2474.

l Time To Live (TTL): Configurable in the range 0 to 255.

l Fragment offset byte: Configurable in the range 0 to 65.528.

The fragment offset field, measured in units of eight-byte blocks, is 13 bits long

and specifies the offset of a particular fragment relative to the beginning of the original

unfragmented IP datagram.

l Protocol field: UDP (0x11), TCP (0x06), User Defined.

https://tools.ietf.org/html/rfc2474
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BERT Setup - IP Address settings (Layer 3)

l Layer 2, 3, & 4 test patterns

l PRBS:

l 2^31 -1 (147 483 647-bit pattern used for special measurement tasks, [e.g., delay

measurements at higher bit rates])

l 2^23 -1 (8 388 607 bit pattern primarily intended for error and jitter measurements

at bit rates of 34 368 and 139 264 kbps)

l 2^13 -1 (32 767 bit pattern primarily intended for error and jitter measurements at

bit rates of 1344, 2048, 6312, 8448, 32 064 and 44 736 kbps)

l 2^11 -1 (2047 bit pattern primarily intended for error and jitter measurements on

circuits operating at bit rates of 64 kbps and N x 64 kbps)

l Fixed: All 0s or All 1s

l User Defined pattern: Length depends on size of frame

l Inversion: Normal or inverted
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BERT Setup - Data selection - PRBS Pattern

l Auto (Special Patterns): For special patterns, the most significant bit of the test pat-

tern is populated first into the payload frame, as opposed to non-special patterns, in

which the least significant bit is populated first.

l RX Filter Tab:

Allows the user to filter incoming streams. When checked, the incoming traffic flows not matching

these criteria will not be considered for these results.

o MAC Destination address

o MAC Source address

o VLAN

o VLAN Priority

o VLAN Eligible

o Frame Type

o Type of Service

o Protocol Type
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o IP Destination address

o IP Source address

BERT Setup - RX Filter selection

l UDP/TCP Tab: Input Source Port and Destination Port.

BERT Setup - RX Filter selection

Traffic

Traffic tab: The following Traffic statistics are displayed:

l Frame type: Test and non-test frames

l Traffic type: Layer 2 and Layer 3 Unicast, Broadcast, and Multicast frame percentage
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l Frame size distribution

l Pause frames

Tap on the graph for detailed screens.

BERT Results - Traffic Distribution

Frames tab: The following Frame distribution statistics are displayed in Count (#) and Percentage (%):

l Received (RX) frames:

o Total frames

o Test frames

o VLAN tagged frames

o Q-in-Q VLAN stacked frames

o Non-test frames

l Transmitted (TX) frames:

o Total frame - Total # frames transmitted

l Pause frames: Total number of transmitted and received Ethernet pause flow-control frames
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BERT Results - Frames
Traffic Type tab: The following Traffic distribution statistics are displayed in Count (#) and Percentage (%):

l Layer 2 Unicast frames: Number of Unicast frames received without FCS errors.

l Layer 2 Broadcast frames: Number of Broadcast frames received without FCS errors. Broadcast

frames have a MAC address equal to FF-FF-FF-FF-FF-FF.

l Layer 2 Multicast frames: Number of Multicast frames received without FCS errors.

BERT Results - Traffic Type

Frame Size tab: The following Frame distribution statistics are displayed in Count (#) and Percentage (%):

l < 64 bytes frames

l 64-127 byte frames

l 128-255 byte frames
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l 256-511 byte frames

l 512-1023 byte frames

l 1024-1279 byte frames

l 1280-1318 byte frames

l > 1318 byte frames - Jumbo frames

BERT Results - Frame Size

Error Injection

Error injection can be performed during testing. The error type and injection rate are configured in the Error
Injection tab.

l Error type: Select from Bit, CRC, IP Checksum (Layer 3, 4 only), Pause, TCP/UDP Checksum

(Layer 4 only). With Pause selected, the unit will transmit a pause frame when Error Injection icon

is pressed. The Pause time duration is configurable in units of 512 bit time. At Gigabit Ethernet

speed, this is equivalent to 512 ns. For example, if pause time is set to 1000, the pause duration will

be set to 1000x512 ns.

l Injection Flow: The error injection flow determines how the selected errors will be injected.

o Select a single error injection or specific count.

l Count: Configures the error count via a numeric keypad.
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BERT Setup - Error Injection Error Inj. Function

Error Injection
After pressing Start, error injection can be enabled by pressing the Error Inj. button
on the right side of the screen.

Starting/Stopping a BERT

Once all configurations have been made, the user can start the BERT test (press the Start icon on the top right
section of the screen). The following are three scenarios of how to prepare and start the unit for BERT testing.

If testing on the fiber ports, make sure the LASER is turned on before starting the test.

l End-to-End Testing

o Connect the test set to another unit that supports BERT testing.

o After configuring test settings on both units, start the tests.

l Far-End Unit in Manual Loopback Mode

o If the far-end unit (another MX) is already in a manual loopback mode, do not send a loop up

command since it is not necessary.
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o Once the correct control settings are configured, the user can start the test.

The selected tests will run automatically. When all the tests are complete the test will stop automatically. If the
BERT test suite needs to be stopped before they are done, then simply press the Stop button, located in the
actions drop-down menu. The status of each selected test can be seen in the Results tab.

l Far-End Unit Controlled with Loop Up/Down Commands

o If the far-end unit is not manually looped back, then it must first receive a loop up command

from the control unit before the BERT test suite can be started.

o To loop up the far-end unit with the manual mode loop up/down commands, configure the con-

trol settings mode to manual.

o Enter the MAC and/or IP address of the far-end unit.

o Send the loop up command by pressing Loop Up.

Once the far-end unit has been looped back, start the test by pressing the Start button. When the all of the
selected test are completed, the BERT test suite will stop automatically. Once all tests have been completed
and there is no need to test again, go back to the Control tab, and press the Loop Down button. This will send
a loop down command to the far-end unit to remove the loopback that is in place.

BERT Results

Summary tab: The following results including the Start (ST) and Elapsed (ET) times are displayed:

l Line Rate (Mbps): Negotiated rate of the interface (10M, 100M, or 1000M). This value is always

fixed since it depends on the maximum capacity of the link under test, hence the test interface that is

configured.

l Framed Rate: (Payload + MAC/IP Header + VLAN Tag + Type/Length + CRC) / (Payload + Total

Overhead) * Line Rate % (in Mbps).

l Data Rate: Payload / (Payload + Total Overhead) * Line Rate %.

l Utilization:% of Line Rate. For example, if we transmit 100Mbps on a 1Gbps interface then the util-

ization value is 10% (or 100Mbps) of the total link capacity (or Line Rate).
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l Number of bytes

l Pause Frames: Total number of transmitted and received ethernet pause flow-control frames.

BERT Results - Summary

Errors

Errors tab: The following errors (Current and Total) are displayed:

l Bits: Indicates errors related to test pattern (Bit Error or LSS [Pattern Loss])

l BER: Bit Error Ratio

l Symbol: Declared when an invalid code-group in the transmission code is detected

l FCS/CRC: Number of received frames with an invalid FCS

l IP Checksum (Layer 3 only)

l Jabber frames: Number of received frames larger than 1318 bytes containing an invalid FCS

l Runt frames: Number of received frames smaller than 64 bytes containing an invalid FCS
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BERT Results - Errors

Events

Events tab: A time stamped record or log of anomalies, alarms, test status (start/stop) and test application are
displayed.

BERT Results - Events

Traffic Settings

Traffic tab:
Configure the traffic profile for the stream, including traffic flow, frame size, frame type, and transmit rate.
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l Traffic Flow: Select from the following traffic flows:

o Constant: The selected frame is transmitted continuously according to the selected band-

width %.

o Ramp: The selected frame is transmitted at maximum bandwidth according to the selected

duty cycle and burst period.

o Burst: The selected frame is transmitted in a staircase profile according to user selectable

step time, number of steps, and maximum bandwidth.

o Single Burst: Configure the number of frames to be transmitted in the burst along with the

bandwidth. For example, if 100000 frames are transmitted at 12.5% of bandwidth, on a 1Gbps

line, 100000 frames will transmit at a rate of 125Mbps and then the burst will stop.

l Frame Size Type: Fixed or Uniform min and max frame length values. Uniform traffic is traffic gen-

erated with a uniform distribution of frame lengths.

o Frame Size (bytes): Enter the frame size when a Layer 2, 3, or 4 BERT is selected

l Frame size configuration is not available for Layer 1 BERT

o Frame sizes can be from 64 bytes to 1318 bytes, in addition to jumbo frames up to 10000

bytes

l BW (Transmit Bandwidth): Configure the transmit rate for the test

o When traffic flow is equal to Burst, two burst bandwidths are configured with burst time

o When traffic flow is equal to Ramp, starting and an ending bandwidth are configured along

with the bandwidth step size and duration
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BERT Setup - Constant Traffic

Frame Size Limitation
Layer 1 framed mode - Frame size configuration is not available.
Layer 1 unframed mode - Traffic profile is constant at 100% bandwidth.

Rates

Rates tab: Rate statistics are displayed in a graph format. Tap on either gauge to see rate details in table form.
The table shows transmitted (Tx) and received (Rx) current, minimum, maximum and average frame rates
(FPS) and Data Rates (Mbps).

l Frame rate in Frames per second (FPS): Number of received frames (including bad frames,

Broadcast frames and Multicast frames)

l Data rate in Mbps: Received data rate expressed in Mbps
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BERT Results - Rates

Delay

Delay tab: Delay measures the interpacket gap, start of the frame, and preamble duration. Frame arrival stat-
istics are displayed in tabular format:

l Current

l Minimum

l Maximum

l Variation (Current) - Interframe delay variation

BERT Results - Delay
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Alarms

Alarms tab: The following Alarms (Current and Total) are displayed:

l LOS: Loss of Signal

l LOS Sync: Loss synchronization

l Pattern Loss: Indicates errors related to test pattern

Service disruption associated with loss of signal:

l Current: Duration of the current service disruption

l Total: Total accumulated duration of the service disruptions

l Min/Max: Minimum and maximum duration of the service disruption events

l No. of Occurrences: Counter of service disruption events

BERT Results - Alarms

Signal

The Signal tab (fiber ports only) displays the optical level measured by the SFP or XFP transceiver.

Signal (Page 1) displays the level measurement in dBm for the optical signal.
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Loss of Signal (LOS) and the Saturation level for optical signals are shown graphically including the level meas-
urement in dBm.

BERT Results - Signal (Page 1)

Signal (Page 2) displays the Optical module (SFP) information which includes Vendor name, Part Number
and Optical Wavelength. Tap on the Decode button to view additional information on SFP optics.

BERT Results - Signal (Page 2)

Signal (Page 3) Displays the received signal frequency and offset measured and performed on the optical
interface (SFP).
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BERT Results - Signal (Page 3)

l Current: Indicates the frequency of the input signal.

l Offset: Indicates the difference between the standard rate and the rate of the input signal.

l Min (ppm): Indicates the difference between the standard rate and the minimum deviation detected

in the input signal.

l Max (ppm): Indicates the difference between the standard rate and the maximum deviation detec-

ted in the input signal.
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RFC 2544 Conformance Testing

Overview

RFC 2544 recommendations are well accepted in the test and measurement industry for network performance
testing. The RFC 2544 test suite consists of and performs a set of four automated tests (throughput, latency,
frame loss, and burst or back-to-back) to qualify the performance of a network link under test. The tests are
especially popular for the verification of network links with certain service level agreements (SLA).

The following settings must be configured prior to RFC 2544 testing:

l Test layer (Layer 2, 3, & 4)

l Frame header (PBB, MAC, VLAN, IP, UDP, and Data)

l Test frames selection

l Pass/fail thresholds (optional)

l Far-end unit loop control

l Throughput

l Latency

l Frame loss

l Burst (back-to-back)

RFC 2544 Setup - Layer 2 parameters
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Setup - Standard Mode

Unless otherwise noted, the Frame Header and related setups are identical to the setups described in "Header
Settings " on page 45.

Header Settings

With the exception of the Data tab, RFC 2544 Header setup options are identical to the setups described in the
BERT application.

See BERT "Header Settings " on page 45

RFC 2544 Setup

l Profile

l Encapsulation Type

l Test

l Frame Type

l MAC/IP

l VLAN

l MPLS

l MAC, VLAN, MPLS, IP, and Test Pattern Configurations

l MAC Header Tab

l Data Tab: No payload selection is possible. The payload area is populated with a VeEX signature

field and other proprietary data.

l RX Filter Tab

l VLAN Tab

l MPLS Tab

l IP Tab
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RFC 2544 Data tab

Frame Settings

Frames tab: User configures the following:

l Preset Frames: User selects from a list of recommended test frame sizes defined in RFC 2544:

o Test frames are 64, 128, 256, 512, 1024, 1280, and 1518 bytes.

o The default selected frames are 64 and 1518 bytes.

o To select/deselect any of the recommended test frames, check the box to the right of the

desired frame.

When VLAN tagging or MPLS tagging is enabled, the value in parentheses reflects the
actual frame size transmitted. For example one VLAN tag adds 4 bytes to the frame size, there-
fore a 64B frame becomes a 68 byte frame.

l Add frame: The user can add two additional user configurable test frames of any size ranging from

64 bytes to 10000 bytes.

o To add additional test frames, tap the Add Frame button.

o Enter the frame size using the numeric keypad and click apply.
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o Press the back button to return to the frames screen.

o The new custom frame size is displayed (it can be enabled or disabled as needed).

RFC 2544 Setup - Frame Settings

Threshold Settings

Threshold tab

l Enable or disable threshold settings for the throughput and latency tests.

o When enabled, threshold settings can be configured for all of the test frames selected in the

frame settings tab.

l A Pass/Fail criteria will be applied when the threshold settings are enabled. Select a rate type from

the drop-down menu that will be used to determine pass/fail criteria. Options are % of Max Rate, %

of Line Rate, Utlized Line Rate (Mbps).

o For example, if the throughput threshold value for a 64 byte frame is configured for 80%, then

a Pass criteria is assigned if the throughput rate is 80% or better.

o The threshold values for Throughput and Latency can be customized per user requirements.

Tap on the selected value to edit.
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RFC 2544 Setup - Threshold Settings

Throughput, Latency, Frame Loss, and Burst Settings

The RFC 2544 test suite allows the user to run all four tests, one of the four tests, or a combination of any of the
four tests. The user simply has to enable/disable which tests to perform by checking/unchecking the
Enable/Disable box in each test tab. By default all four tests are enabled.

The following parameters must be configured before running the RFC 2544 conformance test suite.

Throughput tab:

l Test Rate: Throughput Rate or Custom Rate per frame size.

l Throughput rate: Throughput test will be performed at the specified maximum rate.

l Maximum Rate: Up to 100% of the negotiated line rate. The default value is 100%.

o This is the maximum transmit rate to perform the throughput test for each test frame

size.

o This rate can be configured as a % of the total line rate or in Mbps. For example, if the

Max Rate to is configured to be 90% and the negotiated line rate of the link is 100Mbps,

then the maximum transmit rate will be 90Mbps or 90% of the line rate.
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l Custom Rate per frame size: Configure a custom rate in % or Mbps for each test frame. Tap

on Rate Table Config. to configure rates for each frame. After making edits tap Apply to con-

firm edits or Apply to All to apply rates to all tests.

l Resolution: Input any value between 0.001% and 1%. The default value is 1%. Resolution refers to

the resolution in searching for the throughput rate. If 1% is selected, the throughput rate will be

searched with ±1% accuracy.

l Duration: 5 to 999 seconds. The default value is 20 seconds.

The duration is the amount of time the throughput test is run for, for each frame size at a given rate.

l Frame Loss Limit (%): Configures the frame loss tolerance used in the throughput rate search

algorithm. If the frame loss count stays below the configured Frame Loss limit, the throughput rate

search will stop, otherwise the throughput rate search will continue to the next step.

RFC 2544 Setup - Throughput Settings

Latency tab:

l Test: Throughput Rate or Custom Rate. The default value is throughput.

o Throughput rate: Latency test will be performed at the throughput rate found for each of the

tested frame sizes.

o Custom rate: User configures a custom rate in % or Mbps.
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o Custom Rate per frame size: The user can configure a custom rate in % or Mbps for each

test frame. Tap on Rate Table Config. to configure rates for each frame. After making edits

tap Apply to confirm edits or Apply to All to apply rates to all tests.

l Rate: Only available if Custom Rate is selected. Enter up to 100% of the negotiated line rate or enter

the rate in Mbps.

l Duration: 5 to 999 seconds. The default value is 20 seconds.

This is the amount of time that the latency test will be performed for each test frame size.

l Repetitions: 1 to 100. The default value is 1.

This is the amount of times that the latency test will be repeated for each test frame size.

l Jitter Test: Coupled or Uncoupled. Coupled will run the jitter test at the same time as the latency

test.

RFC 2544 Setup - Latency Settings

Frame Loss tab:

l Max Rate: Up to 100% of the negotiated line rate. The default value is 100%. This is the maximum

transmit rate to perform the frame loss test for each test frame size. The user may configure this rate

as a % of the total line rate or in Mbps. For example, if the user configures the Max Rate to be 90%

and the negotiated line rate of the link is 100Mbps, then the maximum transmit rate will be 90Mbps

or 90% of the line rate.
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o Throughput rate: Latency test will be performed at the throughput rate found for each of the

tested frame sizes.

o Custom rate: User configures a custom rate in % or Mbps.

o Custom Rate per frame size: The user can configure a custom rate in % or Mbps for each

test frame. Tap on Rate Table Config. to configure rates for each frame. After making edits

tap Apply to confirm edits or Apply to All to apply rates to all tests.

l Rate: Only available if Custom Rate is selected. Enter up to 100% of the negotiated line rate or enter

the rate in Mbps.

l Step Size: 1 to 10%. The default value is 10%. The step size is the rate % that the frame loss test

will be reduced by in the event of any frame loss. For example if the Max Rate is 100Mbps (or 100%)

and frames are lost at this rate, then the transmit rate will be reduced to 90Mbps (or 90%). The frame

loss test will now be performed at the new rate until there is zero frame loss at two consecutive rate

settings. This means that the test will have to be performed at 80% (assuming that there was zero

frame loss at 90%).

l Duration: Selectable in the range 5 to 999 seconds. The default value is 20 seconds. The duration is

the amount of time the throughput test is run for, for each frame size at a given rate.

RFC 2544 Setup - Frame Loss Settings

Burst (Back-to-Back) tab:
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l Max Rate: Up to 100% of the negotiated line rate. The default value is 1000 ULR (Mbps). In the

burst test, frames are always transmitted at the maximum rate for a given minimum and maximum

burst duration. This rate may be configured as a % of the total line rate or in Mbps. For example, if

the Max Rate is configured to be 90% and the negotiated line rate of the link is 100Mbps, then the

maximum transmit rate will be 90Mbps or 90% of the line rate.

o Throughput rate: Latency test will be performed at the throughput rate found for each of the

tested frame sizes.

o Custom rate: User configured custom rate in % or Mbps.

o Custom Rate per frame size: A custom rate can be configured in % or Mbps for each test

frame. Tap on Rate Table Config. to configure rates for each frame. After making edits tap

Apply to confirm edits or Apply to All to apply rates to all tests.

l Rate: Only available if Custom Rate is selected. Enter up to 100% of the negotiated line rate or enter

the rate in Mbps.

l Minimum Duration: Selectable in the range 2 to 999 seconds. Default value is 2 seconds.

This is the duration of the first burst.

l Maximum Duration: Selectable up to 999 seconds.

The default value is 20 seconds. This is the duration of the second burst, which must be greater than

the minimum burst.

l Repetitions: Selectable in the range 1 to 100. The default value is 1.

This is the amount of times that the burst test will be repeated for each test frame size.
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RFC 2544 Setup - Burst Settings

Starting/Stopping a RFC 2544 Measurement

Once all configurations have been made, the user can start the RFC 2544 test (press the Start icon on the top
right section of the screen). The following are two scenarios of how to prepare and start the unit for RFC 2544
testing.

If testing on the fiber ports, make sure the LASER is turned On before starting the test.
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l Far End Unit in Manual Loopback Mode

l If the far-end unit (another MX) is already in a manual loopback mode, do not send a loop up

command since it is not necessary

l Once the correct control settings are configured, the user can start the test

The selected tests will run automatically. When all the tests are complete the test will stop automatically. If the
RFC 2544 test suite needs to be stopped before they are done, then simply press the Stop button, located in
the actions drop-down menu. The status of each selected test can be seen in the Results tab.

l Far End Unit Controlled with Loop Up/Down Commands

l If the far-end unit is not manually looped back, then it must first receive a loop up command

from the control unit before the RFC 2544 test suite can be started

l To loop up the far-end unit with the manual mode loop up/down commands, configure the con-

trol settings mode to manual

l Enter the MAC and/or IP address of the far-end unit

l Send the loop up command by pressing Loop Up

Once the far-end unit has been looped back, start the test by pressing the Start button. When the all of the
selected test are completed, the RFC 2544 test suite will stop automatically. Once all tests have been com-
pleted and there is no need to test again, go back to the Control tab, and press the Loop Down button. This will
send a loop down command to the far-end unit to remove the loopback that is in place.

If the unit is in Advanced SLA mode, the RFC 2544 test runs simultaneously with the background.
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Results - Standard Mode

The progress and current result of the RFC 2544 can be viewed as the test is in progress.

Results tab

Navigate the respective sub-tabs (throughput, latency, frame loss, or burst) to view the results for each test.
For the burst test, the results can be viewed in summary table format or test log format.

Status tab

The status of each test is displayed including a stamped log of each test.

RFC 2544 Results - Status

Summary tab

The following results including the Start (ST) and Elapsed (ET) times are displayed:

l Line Rate (Mbps): Negotiated rate of the interface (10M, 100M, 1000M or 10GE). This value is

always fixed since it depends on the maximum capacity of the link under test, hence the test inter-

face that is configured.

l Framed Rate: (Payload + MAC/IP Header + VLAN Tag + Type/Length + CRC) / (Payload + Total

Overhead) * Line Rate % (in Mbps).

l Data Rate: Payload / (Payload + Total Overhead) * Line Rate %.
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l Utilization:% of Line Rate. For example, if we transmit 100Mbps on a 1Gbps interface then the util-

ization value is 10% (or 100Mbps) of the total link capacity (or Line Rate).

l Total Frames

l Bad Frames

l Pause Frames: Total number of transmitted and received ethernet pause flow-control frames.

RFC 2544 Results - Summary

Signal tab

The Signal tab (fiber ports only) displays the optical level measured by the SFP transceiver. The RFC 2544 Sig-
nal tab is identical to the Signal tab for the BERT application. Refer to Lane BERT Signal for more information.

RFC 2544 Results - Signal (Page 1)

../../../../../Content/Procedures/Lane_BERT/Lane_BERT_Signal.htm
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Events tab

A time stamped log of each test is displayed.

RFC 2544 Results - Events

Throughput tab

The Throughput tab displays the maximum throughput rate of the link under test. Results are displayed in
graphical and table formats. Use the drop-down menu to change the display format.

l Graphical: Throughput results are displayed in a bar graph form

l Summary table and test log table display:

l Byte size

l Tx(%): Percentage of test frames transmitted by the unit

l Rx(%): Percentage of test frames received by the unit

l Thresholds: Pass/Fail test status determined by test criteria set in the Threshold tab
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RFC 2544 Results - Throughput (Tx Graphical)

RFC 2544 Results - Throughput (Test Log)

Latency and frame jitter measurements results are displayed in the following formats. Use the drop-down
menu to select the Latency format:

l Graphical: Latency results displayed in line graph form (Latency [us] vs Frame size [bytes]).

l Summary and Test log tables display:

o Byte size

o Latency (us): Round trip delay latency.
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o Rate (%): Percentage of frames transmitted. Data rate used for latency test.

o Pass/Fail test status.

RFC 2544 Results - Latency (Summary)

RFC 2544 Results - Latency (Graphical)
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RFC 2544 Results - Latency (Test Log)

RFC 2544 Results - Latency (Jitter Graphical)

RFC 2544 Results - Latency (Jitter Summary)
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RFC 2544 Results - Latency (Jitter Test log)

Frame Loss tab: Frame loss displays the percentage of frames not received. Use the drop-down menu to
select the Frame Loss format:

l Summary and Test log tables display test frame length, byte size, frame loss (%) from received

traffic, and rate (%) transmitted.

l Graphical: Frame Loss displayed in line graph form (Frame size [bytes] vs Rate [%]). Tap on the

Graphical Type drop-down menu on the right to view the graph legend.

RFC 2544 Results - Frame Loss (Summary)
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RFC 2544 Results - Frame Loss (Graphical)

RFC 2544 Results - Frame Loss (Test log)

Burst tab: Burstability (back-back) results are the number of frames successfully transmitted/received at the
line rate. It is displayed in the following formats:

l Summary table: Displays Average Frame Count received for each test frame length

l Test log table: Displays Average Frame Count and Duration (seconds) for each test frame length
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RFC 2544 Results - Burstability (Summary)

RFC 2544 Results - Burstability (Test Log)
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Saving RFC 2544 Results

Once the test has been stopped the results can be saved by pressing the Save key on the keypad. The results
will be saved and named automatically. Once the results are saved, view or rename the results file by going to
File Manager at Utilities > Files > Saved. Refer to "File Manager" on page 279 for more information.

Advanced SLA Mode

Using this test function, users are able to verify SLAs while end-to-end QoS is assessed properly. By con-
figuring one primary test stream and up to seven background streams each with independent frame size, band-
width, and more importantly QoS levels, simulating different service applications is now realized. The
Advanced RFC 2544 SLA mode provides detailed visibility of the test parameters for each of the traffic streams
being measured, providing an efficient in-depth qualification in a fast and automated way.

To change SLA modes, tap on the SLA button on the right side of the screen and tapOK after selecting an SLA
mode.

RFC 2544 SLA Mode

Setup

For Header, Frames, Thresholds, Throughput, Latency, Frame Loss, and Burst, refer to "Setup - Stand-
ard Mode " on page 70.

Background - General

l # of Back. Streams: From 1 to 7 streams.

l RFC 2544 Test Stream (%): This is the max rate set in frame loss.
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l Background Stream # (%): Allocated Bandwidth per Stream. The total bandwidth for all streams

cannot exceed 100%.

l Total (%): Sum of all stream rates in %.

Setup - Background - General Traffic

Background - Traffic

l Background Stream #: Select a stream number to configure.

l Traffic Flow: Select from Constant, Ramp, Burst, or Single Burst traffic flow.

l Frame Size (Type): Fixed or Uniform. If uniform is chosen, the user will have to input a minimum

and maximum frame size.

l Frame Size (bytes): If a fixed frame size is chosen, this option is enabled. Enter the frame size

when a Layer 2 or 3 is selected. Frame sizes can be from 64bytes to 1518bytes, in addition to jumbo

frames up to 10k bytes.

l BW (Transmit Bandwidth): Configure the transmit rate for the stream.

The bandwidth allocation per stream is already configured in the General Settings tab, but

can be modified in this screen as well.
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Setup - Background - Background Traffic

Starting/Stopping an Advanced SLA Mode

Once all configurations have been made, the user can start the RFC 2544 test (press the Start icon on the top
right section of the screen). The following are two scenarios of how to prepare and start the unit for RFC 2544
testing.

If testing on the fiber ports, make sure the LASER is turned On before starting the test.

l Far End Unit in Manual Loopback Mode

l If the far-end unit (another MX) is already in a manual loopback mode, do not send a loop up

command since it is not necessary
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l Once the correct control settings are configured, the user can start the test

The selected tests will run automatically. When all the tests are complete the test will stop automatically. If the
RFC 2544 test suite needs to be stopped before they are done, then simply press the Stop button, located in
the actions drop-down menu. The status of each selected test can be seen in the Results tab.

l Far End Unit Controlled with Loop Up/Down Commands

l If the far-end unit is not manually looped back, then it must first receive a loop up command

from the control unit before the RFC 2544 test suite can be started

l To loop up the far-end unit with the manual mode loop up/down commands, configure the con-

trol settings mode to manual

l Enter the MAC and/or IP address of the far-end unit

l Send the loop up command by pressing Loop Up

Once the far-end unit has been looped back, start the test by pressing the Start button. When the all of the
selected test are completed, the RFC 2544 test suite will stop automatically. Once all tests have been com-
pleted and there is no need to test again, go back to the Control tab, and press the Loop Down button. This will
send a loop down command to the far-end unit to remove the loopback that is in place.

If the unit is in Advanced SLA mode, the RFC 2544 test runs simultaneously with the background.

Background Results - Advanced SLA Mode

Background Results - Global
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Background Results - Per Stream
Read more aboutGlobal and "Per Stream Results" on page 141.

Peer-to-Peer and Asymmetric Testing

Remote Partner Control

When the local unit connects to the remote (peer) partner, it loads the same configuration profile (header,
traffic, and frame size) to the remote partner, with the MAC and IP addresses inverted. From the peer-to-peer
menu, asymmetric testing becomes available.

Asymmetrical links provide different line rates in the two directions. To verify the information for both the low
and the high rates of the link, the user needs to send a test signal from one instrument located at one end of the
link to an instrument at the other end of the link and vice versa to test traffic capacity. The two test instruments
have to be synchronized because the tests defined in RFC 2544 require the receiver to know the contents of
the test signal to be transmitted in detail.

The test set offers an automated RFC 2544 test application to perform throughput, frame loss, and burstability
tests in a local-remote unit setup. The user first configures the test setup in the local unit. Once initiated, the
local unit transfers the setup information to the remote unit via the line under test. Upon completion, the remote
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unit transfers the test results back to the local unit, enabling the user to read the results for both directions of
the link on the local unit.

Asymmetric Testing Setup

1. Tap the P2P Setup button on the right side of the screen to start the step-by-step setup process.

2. Set the Local unit as a Controller or Responder.

At any time during the process, tap on the right side navigation buttons to move to the NEXT screen, return to
the Previous screen, or Exit the setup guide.

Set the Local unit as Controller or Responder

Unit as Controller Setup Process

l Step 1: Select Controller.

l Mode: Select an asymmetric test configuration.

l Asymmetric Up: Tests traffic in the upstream direction (local to remote direction).

l Asymmetric Down: Tests traffic the downstream direction (remote to local direction).

l Asymmetric Up & Down: Test traffic in both upstream and downstream direction.

l Step 2-7: Make the following selections for the Controller and Remote units: Layer, IP Address, Sub-

net, Gateway, and VLAN tags. Tap on the white fields to edit options. Use the alphanumeric key-

board to input parameters and press Apply to save edits.
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Input screen

l Step 8: Tap on the check boxes to add local frames. Tap on the Add Frame button to add a cus-

tomized frame size.

Controller - Step 8

l Steps 9-12: Set up and enable/disable tests for the Local unit.

l Step 9: Local Throughput testing setup. See the Throughput section for a description of menu

options.

l Step 10: Local Frame Loss testing setup. See the Frame Loss section for a description of

menu options.

#RFC2544-Throughput
#RFC2544-FrameLoss
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l Step 11: Local Burst testing setup. See the Burst (Back-to-Back) section for a description of

menu options.

l Step 12: Local RX Thresholds setup. See the Thresholds section for a description of menu

options.

l Steps 13-16: Set up and enable/disable tests for the Remote unit. See Steps 8-11 for information on

setting up individual tests.

l Step 17: Review configuration selections on the summary screen. The option to Start testing or

Reconfigure test settings becomes available.

Controller Summary Screen

Unit as Responder Setup Process

l Step 0-2: Tap on the white fields to setup the Local unit's IP Address, Subnet, and Gateway. Tap on

Next to setup VLAN tags using the drop-down menu.

l Step 3: Review configuration selections. The option to Start testing or Reconfigure test settings

becomes available.

#RFC2544-Burst
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Responder Summary Screen

RFC 2544 Local and Remote Test Setup

RFC 2544 Test setup for the local and remote unit is available in the Setup tab. Refer to "Setup - Standard
Mode " on page 70 for more information.

Local Setup
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Test Results

P2P Test Results

While the test is running the options to Stop the test, Stop and Save results, and view result Details appear.
After testing finishes, the option to test More IPs, Restart, or Save test results become available as right side
buttons.
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V-SAM

V-SAM (VeEX Service Activation Methodology) is an automated Ethernet service activation test feature con-
forming to the ITU-T Y.1564 standard, created to address and solve the deficiencies of RFC 2544:

l RFC 2544 was limited to test at the maximum throughput line rate for a single service. SAM is able to

run multiple services on a single 10/100/1000 or 10G Ethernet line at a bandwidth ranging from 0 to

the line rate, allowing for more realistic stream testing.

l The Frame Delay Variation, also known as (packet) jitter was not included in RFC 2544. Jitter is a

critical parameter for real time voice and video services. It is now part of the SAM test suite.

l RFC 2544 validates the service parameters like frame loss, throughput and latency, one after the

other, while SAM allows testing all the service critical parameters simultaneously. This results in sig-

nificant time saving compared to RFC 2544.

Comparison of RFC 2544 and Y.1564

Test Methodology

The purpose of the SAM test suite is to verify that the service is compliant to its Bandwidth Profile and Service
Acceptance Criteria. The test is broken down into two phases:

l Phase 1: Service Configuration test: The services running on the same line are tested one by one

to verify the correct service profile provisioning.
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l Phase 2: Service Performance test: The services running on the same line are tested sim-

ultaneously over an extended period of time, to verify network robustness.

Test Application

Phase 1: Service Configuration Test

The service configuration test is broken down into three steps. The steps are tested individually for all the ser-
vices delivered on the same line.

Step 1: Committed Information Rate (CIR) Test:
Traffic is transmitted at the CIR for a short period of time and the received traffic is evaluated against the Ser-
vice Acceptance Criteria (FLR, FTD, FDV) measured simultaneously. The CIR test passes if the meas-
urements on the received traffic stay below the performance objectives.

Step 2: Excess Information Rate (EIR) Test:
Traffic is transmitted at the CIR+EIR rate for a short period of time; the EIR test passes if the received traffic
rate is between the CIR (minus the margin allowed by the FLR) and CIR+EIR.

Step 3: Traffic Policing (Overshoot Test):
The purpose of the Traffic Policing Test is to ensure that when transmitting at a rate higher than the allowed
CIR+EIR, the excess traffic will be appropriately blocked to avoid interference with other services. For this test,
traffic is transmitted at 25% higher than the CIR+EIR for a short period of time. The test passes if the received
traffic rate is at least at the CIR (minus the margin allowed by the FLR) but does not exceed the allowed
CIR+EIR.

At this time, the Committed Burst Size (CBS) and Excess Burst Size (EBS) tests are considered
experimental and not an integral part of the standard.
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Service Bandwidth Profile

Phase 2: Service Performance Test

Services running on the same line are tested simultaneously over an extended period of time, to verify network
robustness. Service Acceptance Criteria (SAC) including Frame Transfer Delay (FTD), Frame Delay Variation
(FDV), Frame Loss Ratio (FLR) and Availability (AVAIL) are verified for each service.

V-SAM Setup

General (Page 1 and 2)

l V-SAM Profile: Delete, Save, Save as..., Default, or Last Configuration.

l # of Services: Select the number of services to run. Up to 8 services can be chosen for a 1 GE inter-

face and up to 10 services can be chosen for a 10 GE interface.

l Display: ULR or IR. See the "Service Attributes " on page 106section for more information.

l Service Configuration Test: Enable or Disable the configuration test.

l Service Performance Test: Enable or Disable the performance test.

l Service Configuration and Performance Tests can be enabled independently.
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l CIR Test Config: Tap on the box to configure the Committed Information Rate Test on another

screen.

l Duration: Select the Service Performance Test duration. Options are 15min, 30min, 1hr, 2hr, 24hr

or user defined. If user-defined is selected, input a duration between 1-10000 min.

Enabling/Disabling Tests
A check next to the Service number in the Service Summary table indicates that the test for the corresponding
service is set to run. Tap on the box to remove the check and cancel the test for that service.

V-SAM - Setup - General (Page 1)

V-SAM - Setup - General (Page 2)

CIR Test Configuration
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Select Simple Test, Step Load Test, or Simple and Step.

l Simple Test: Starts the tests at the CIR.

l Step Load Test: Starts the test below the CIR and continues in steps until it reaches the CIR.

l Simple and Step Load Test: Step Load Test performs only if the Simple Validation test fails.

Tap the Test Duration box to input a test duration (test duration must be less than 999 sec).
Tap the table to modify the CIR value percentage for each step.

CIR Test Config

Header Settings

l Service #: Select a service to configure

l Service Name: Assign a name to the service if desired.

l Frame Size Type: Fixed or EMIX (1GE only). A fixed frame size is chosen as default

l Frame Size:

o For Fixed Traffic Flow: Input a fixed frame size within the range of 64-10000 bytes by tap-

ping the value box.

o For EMIX (1GE only): The default value is abceg. Tap the zoom (magnifying glass) icon to

define other values. Select the values from the drop down lists on the next screen.

Any EMIX configuration of 5 frames is allowed.
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l Encapsulation Type: None, Provider Backbone Bridge (PBB-TE), or Multiprotocol Label Switching

(MPLS-TP). MPLS-TP is a simplified version of MPLS. Provider Backbone Bridge MAC-in-MAC

(IEEE 802.1ah) encapsulation are configured trunks that add resiliency and configurable per-

formance levels in the provider backbone network. Both options are available for 1GE Copper/Fiber

and 10GE port for all Ethernet tests (Layer 2,3 and 4) - BERT, RFC2544, Throughput, V-SAM.

Tap the PBB orMPLS-TP block to configure the settings. All fields are configurable.

PBB:
o Backbone MAC Source

o Backbone MAC Destination

o Ethernet Type

o I-SID

o VLAN ID, Priority, Type

MPLS-TP:

o MPLS-TP MAC Source

o MPLS-TP MAC Destination

o Ethernet Type

o VLAN ID, Priority, Type

o LSP, PW, CW

After making changes, tap Apply to All, for MPLS-TP configuration.

Unless otherwise noted, the Frame Header and related setups are identical to the setups described in "Header
Settings " on page 45.
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V-SAM Setup - Services - Header Settings

V-SAM Setup - Services - EMIX Frame Size Settings

V-SAM Setup - Services - MPLS-TP Settings
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Service Attributes

Bandwidth Profile Parameters

The Bandwidth Profile specifies how much traffic the customer is authorized to transmit and how the frames
are prioritized within the network. In the Bandwidth table, the user specifies the following bandwidth criteria:

l CIR: Committed Information Rate. This is the guaranteed maximum rate at which the customer can

send frames that are assured to be forwarded through the network without being dropped. Tap on

the box to enter a rate and choose between IR Mbps or ULR Mbps. Allowed values range from

0.01Mbps to the line bandwidth.

o Information Rate (IR): Measures the average Ethernet frame rate starting at the MAC

address field and ending at the CRC.

o Utilized Line Rate (ULR): Measures the average Ethernet frame rate starting with the over-

head and ending at the CRC.

V-SAM Services - Header

l Excess Information Rate (EIR): Maximum rate above the CIR at which the customer can send

frames that will be forwarded on a best effort basis, but may be dropped in the event of congestion

within the network. The combined CIR and EIR must not exceed the line bandwidth. Traffic beyond

CIR + EIR will be dropped when it enters the carrier's network. Tap on the box to enter a rate. EIR is
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expressed in terms IR Mbps or ULR Mbps. Select a term to express EIR or select Disable to dis-

able the test.

l Traf. Policing: Enable or Disable the traffic policing test. For this test, traffic is transmitted at 25%

higher than the CIR+EIR. The Policing test fails if the higher traffic rate is allowed through the net-

work.

l Color Aware: Enable, Disable. When Color Aware is enabled, the Drop Eligible parameter in the

VLAN header configuration screen is not available for configuration. If no VLAN is configured for the

service traffic, the Color Aware parameter is ignored.

l CBS and EBS: Committed Burst Size (CBS) and Excess Burst Size (EBS).

o CBS can be enabled without enabling EBS

o If EBS is enabled, then CBS is automatically enabled too

o Values between 4 KBytes and 100 KBytes can be input for both CBS and EBS

V-SAM Setup - Services - Service Attributes

Enabling/Disabling Tests
A check next to the parameters in the Service Attributes table indicates that the test for the corresponding ser-
vice is set to run. Tap on the box to remove the check and cancel the test for that service.

Service Acceptance Parameters

The user establishes Pass/Fail test criteria for the following Service Acceptance Criteria. Values define the min-
imum requirements to ensure that the service meets the Service Level Agreement (SLA):
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l FLR: Maximum ratio of lost frames to the total transmitted frames allowed to still be compliant with

the SLA. FLR is only guaranteed for traffic conforming to the CIR. Enter a percentage from 0-100.

l FTD: Maximum transfer time that the frames can take to travel from source to destination, and still

be compliant with the SLA. FTD is only guaranteed for traffic conforming to the CIR. Values are

measured in us, ms, or sec. Input a value within the digital range of .001-999 and 1 us-999sec. The

user can also choose to Disable the FTD threshold evaluation. FTD will be measured anyway but

the value will not contribute toward passing or failing the service.

l IFDV: Maximum frame jitter allowed to still be compliant with the SLA. FDV is only guaranteed for

traffic conforming to the CIR. Values are measured in us, ms, or sec. Input a value within the digital

range of .001-999 and 1 us-999sec. The user can also choose to Disable the IFDV threshold eval-

uation. IFDV will be measured anyway but the value will not contribute toward passing or failing the

service.

l AVAIL: Minimum percentage of service availability allowed to still be compliant with the SLA. The

service becomes unavailable if more than 50% of the frames are errored or missing in a one second

interval. Availability is only guaranteed for traffic conforming to the CIR. Enter a percentage from 0-

100. The user can also choose to Disable the AVAIL threshold evaluation. AVAIL will be measured

anyway but the value will not contribute toward passing or failing the service.

Copying Services

Copying Services
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Tap on the Copy button on the bottom of the Header or Service Attributes tabs to copy frame parameters spe-
cific to that tab to other services. For example, pressing Copy on the Header tab will only transfer header para-
meters to other services.

MX Discover and Control Settings

The Control button offers additional loopback control settings including User Defined and OAM Discover.

For instructions on how to loop up/down the test set with another test set or device, please refer to "MX Dis-
cover and Control Settings" on page 128.

Peer-to-Peer Setup

Peer-to-Peer and asymmetric testing via the P2P Setup button is also available.

Remote Partner Control

When the local unit connects to the remote (peer) partner, it loads the same configuration profile (header,
traffic, and frame size) to the remote partner, with the MAC and IP addresses inverted. From the peer-to-peer
menu, asymmetric testing becomes available.

Asymmetrical links provide different line rates in the two directions. To verify the information for both the low
and the high rates of the link, the user needs to send a test signal from one instrument located at one end of the
link to an instrument at the other end of the link and vice versa to test traffic capacity. The two test instruments
have to be synchronized because the tests defined in RFC 2544 require the receiver to know the contents of
the test signal to be transmitted in detail.

The test set offers an automated RFC 2544 test application to perform throughput, frame loss, and burstability
tests in a local-remote unit setup. The user first configures the test setup in the local unit. Once initiated, the
local unit transfers the setup information to the remote unit via the line under test. Upon completion, the remote
unit transfers the test results back to the local unit, enabling the user to read the results for both directions of
the link on the local unit.
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Asymmetric Testing Setup

1. Tap the P2P Setup button on the right side of the screen to start the step-by-step setup process.

2. Set the Local unit as a Controller or Responder.

At any time during the process, tap on the right side navigation buttons to move to the NEXT screen, return to
the Previous screen, or Exit the setup guide.

Set the Local unit as Controller or Responder

Unit as Controller Setup Process

l Step 1: Select Controller.

l Mode: Select an asymmetric test configuration.

l Asymmetric Up: Tests traffic in the upstream direction (local to remote direction).

l Asymmetric Down: Tests traffic the downstream direction (remote to local direction).

l Asymmetric Up & Down: Test traffic in both upstream and downstream direction.

l Step 2-7: Make the following selections for the Controller and Remote units: Layer, IP Address, Sub-

net, Gateway, and VLAN tags. Tap on the white fields to edit options. Use the alphanumeric key-

board to input parameters and press Apply to save edits.
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Input screen

l Step 8: Tap on the check boxes to add local frames. Tap on the Add Frame button to add a cus-

tomized frame size.

Controller - Step 8

l Steps 9-12: Set up and enable/disable tests for the Local unit.

l Step 9: Local Throughput testing setup. See the Throughput section for a description of menu

options.

l Step 10: Local Frame Loss testing setup. See the Frame Loss section for a description of

menu options.

#RFC2544-Throughput
#RFC2544-FrameLoss
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l Step 11: Local Burst testing setup. See the Burst (Back-to-Back) section for a description of

menu options.

l Step 12: Local RX Thresholds setup. See the Thresholds section for a description of menu

options.

l Steps 13-16: Set up and enable/disable tests for the Remote unit. See Steps 8-11 for information on

setting up individual tests.

l Step 17: Review configuration selections on the summary screen. The option to Start testing or

Reconfigure test settings becomes available.

Controller Summary Screen

Unit as Responder Setup Process

l Step 0-2: Tap on the white fields to setup the Local unit's IP Address, Subnet, and Gateway. Tap on

Next to setup VLAN tags using the drop-down menu.

l Step 3: Review configuration selections. The option to Start testing or Reconfigure test settings

becomes available.

#RFC2544-Burst
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Responder Summary Screen

RFC 2544 Local and Remote Test Setup

RFC 2544 Test setup for the local and remote unit is available in the Setup tab. Refer to "Setup - Standard
Mode " on page 70 for more information.

Local Setup
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Test Results

P2P Test Results

Packet Capture

To capture packets, tap PCAP. Tapping PCAP again will stop packet capture and automatically name and
save results in pcap format. A message displays the name of the saved file located in Files > Saved section of
the test set. The file and can be exported to a PC and analyzed using Wireshark.

See "File Manager" on page 279 for information on viewing saved files.

Results

Results - Config. Tests - Service 1

To run the test, make sure that traffic is being looped back at the far-end of the network under test.
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Configuration Test
The Config. Tests tab lists the Pass/Fail status of each service and test. Tapping on the table brings up a
screen with CIR and enabled tests including CIR/EIR, CBS, EBS, and Policing Test results for the chosen
Service. The test tabs display min, mean, and max values for IR Mbps, FTD, FDV, Frame Loss Count, and
Frame Loss Ratio (%). If Step Load was selected for the CIR Test, these values will be displayed for each
step. If any measured values do not meet the service test parameters set in the Bandwidth and Threshold tabs,
the test fails.

l IR Mbps: Information Rate. Measures the average Ethernet frame rate starting at the MAC address

field and ending at the CRC.

l FTD: Measures the time that the frames can take to travel from source to destination.

l FDV: Measures the frame jitter.

l Frame Loss Count: Counts the number of lost frames.

l Frame Loss Ratio: Ratio of lost frames to the total transmitted frames.

Tap the Table to View Test Details such as CIR Test

CIR test: The test passes if all measured values are below the thresholds configured. If a threshold is disabled,
it will not be evaluated towards pass/fail criteria.
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Tap the Table to View Test Details such as CIR/EIR Test

CIR/EIR test: The test passes if the received IR value is between the CIR (minus the margin allowed by the
FLR) and CIR+EIR.

Policing Test - Service 1

Policing test: The test passes if the received traffic rate is at least at the CIR (minus the margin allowed by the
FLR) but does not exceed the allowed CIR+EIR.
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Results - Config. Tests - Summary

Summary: The Summary tab displays the status of each service and test as Pass, Failed, Pending, or Dis-
abled.

Perf. Test - Service 1

Performance Test

The Service # tabs display min, mean, and max values for IR Mbps, FTD, FDV, Frame Loss Count, Frame
Loss Ratio (%), Availability, and Errored Frame Count. Pass/Fail/Pending status of each test is displayed
on the top of each table.

l IR Mbps, FTD, FDV, Frame Loss Count, Frame Loss Ratio (%) definitions are listed in the Con-

figuration Test section.
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l Availability: Minimum percentage of service availability allowed to still be compliant with the SLA.

The service becomes unavailable if more than 50% of the frames are errored or missing in a one

second interval. Availability is only guaranteed for traffic conforming to the CIR.

l Total RX Frames: Total number of frames received

l Errored Frame Count: Number of frames with CRC or IP Checksum errors

Measured values that do not meet the service test parameters set in the Bandwidth and Threshold tabs cause
the test to fail.

The Summary tab displays the status of each service and test as Pass, Failed, Pending, or Disabled.

Perf. Tests - Summary

Signal tab: The Signal tab (fiber ports only) displays the optical level measured by the SFP transceiver. The
RFC 2544 Signal tab is identical to the Signal tab for the BERT application. Refer to "Signal" on page 66 from
the BERT section for more information.
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Perf. Tests - Summary

Event Log
A time stamped record or log of test types and test statuses (start/stop).

Event Log
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Throughput Testing (Multiple Streams)

Overview

The throughput application (or the multiple streams application) performs the following measurements: through-
put performance, frame loss analysis, delay analysis, frame/packet arrival analysis, received traffic type ana-
lysis, and received traffic frame size analysis. On the transmit side, the throughput application allows for the
configuration of up to 8 traffic streams with their own MAC and IP addresses, VLAN tags (up to 3 per stream),
bandwidth/rate, frame size, and L2 and/or L3 quality of service (QoS) parameters. On the receiver end the
traffic is analyzed on a per stream (up to 8 streams) basis as well as a global or aggregate measurement.

This application is very useful in verifying the transport of traffic with different prioritization settings across a net-
work link. The test helps verify that the network can handle high priority traffic and low priority traffic accord-
ingly.

Setup

Unless otherwise noted, Frame Header, Traffic, and Error Injection setups are identical to the ones described
in the "BERT" on page 44 section. The following parameters must be configured prior to performing a Through-
put test:

l Number of streams (See General Settings below)

l Bandwidth per stream (See General Settings below)

l Test layer

l Frame Type

l VLAN tag(s)

l MPLS tag(s)

l Frame header per stream (if applicable)

l Traffic profile per stream (if applicable)

l Error injection per stream (if applicable)

l Control settings of the far-end device(s) (if applicable)
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Setup Header

The IP header features additional Ping and ARP features which can be applied to selected streams or all
streams by Gateway or IP Destination.

Ping Testing

Ping is a popular computer network tool used to test whether a particular host is reachable across an IP net-
work. A ping is performed by sending an echo request or ICMP (Internet Control Message Protocol) to the echo
response replies.
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Ping Setup

Ping Setup

l Profile: Delete, Save, Save as..., or Default

l Destination: Press the drop -down menu and enter the destination IP address or URL to ping.

l Number of Pings: Enter the number of ping attempts (up to 10000) that will be performed to reach

the network device.

If Continuous Ping is selected, the user is not required to enter the number of pings. The test
set will continuously ping the target host until the user presses Stop.

l Length: Enter the length of the ICMP echo request packet transmitted.

l Ping/Sec: Enter the Ping repetition rate (Ping/second).

l Time Out: Time-to-Live (TTL) in milliseconds. Enter the maximum time allowed (in ms, up to 99999

ms) between an ICMP ping and echo response.

Once the parameters are configured, press Start to begin the test.

Ping Results

Pressing Ping will take you to the Result tab and start the Ping test.
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Ping Result

l Destination: Destination IP address

l Ping status: In Progress, PASS, or FAIL

l Sent, Received, Unreach, Missing: Number of pings sent, received, unreached or missing. A Ping

is counted missing if no response is received before timeout. A Ping is counted unreached if an echo

response is received with host unreachable set.

l PING also estimates the Round-Trip time in milliseconds.

l Current: Current time for a Ping request to be answered

l Average: Average time recorded for a Ping request to be answered

l Max: Maximum time recorded for a Ping request to be answered

l Min: Minimum time recorded for a Ping request to be answered.

ARPWiz uses the Address Resolution Protocol (ARP) to verify the status of each IP address in a user-select-
able IP range. ARP is the standard method for finding a host's hardware address when only its network layer
address is known. In other words, ARP is used primarily to translate IP addresses to Ethernet MAC addresses.
ARP is defined in RFC826.

ARP Setup

Configure the following parameters and press Start. The test will continue to run until Stop is pressed. A fin-
ished status indication will display when the test finishes.

https://tools.ietf.org/html/rfc826
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l Profile: Default, Delete, Save, or Save As...

l Start IP: Starting IP Address

l End IP: Ending IP Address

l Time Out(s): Range from 1-99 seconds. Input using the numeric keypad.

ARP Wiz Setup
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ARP Result

The MAC addresses associated with active IP addresses in the range are displayed. If no MAC address is
associated with the IP address, a FAILED status is displayed.

ARPWiz uses the ARP protocol and can only work within the same subnet as the IP address provided to
the test set in IP Status.

ARP Wiz Result

Throughput Header - IP - Ping Settings

Multiple Streams - MAC/IP Address Setup
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If all of the streams are going to the same far-end unit, then the MAC/IP destination addresses must be the
same on all of the streams.

If any of the traffic streams are going to more than one far-end unit then ensure the correct MAC/IP destination
addresses are configured for the respective streams.

General Throughput Settings (Global Configuration)

Page 1:

l # of Streams: From 1 to 10 streams.

l Stream #: Allocated Bandwidth per Stream: The total bandwidth for all streams cannot exceed

100%.

l Total (%): Sum of all stream rates in %.

l Stream TX Start: Coupled or Separated. Configures how the measurements are started for multiple

streams.

l Separated: Independent control (Start/Stop) of the transmitter is enabled. At the start of the

test only the receiver is turned on -- the user must start the transmitter manually.

l Coupled: Transmitter and receiver are turned on at the same time, and the Tx and Rx meas-

urements start at the same time at the start of the test.

Throughput Setup - General Settings

Page 2:
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l #of Streams: From 1 to 8 streams.

# of Streams can be specified either on Page 1 or Page 2. It will be reflected on both pages.

l Delay Measurement Mode: Disable, Round Trip Delay. Local One way delay measurement, Atomic

one way delay, or GPS one way delay are also available depending on the Glock Synchronization

device selected in the Setup (home menu) > Measurement menu. Refer to Measurement Settings

for more information. Round Trip Delay should only be enabled when running the test to a remote

loopback.

l Histogram: Enable / Disable

l Sampling Period: 1sec, 10secs, 30secs, 1min, 10min, 30min, 1hr. Defines how often the RTD

(round trip delay) measurement is evaluated against the RTD threshold.

l Threshold (Max RTD allowed): Input the value in us, ms or sec. Defines the maximum allowed

round trip delay value. If the RTD value exceeds the threshold, an event is logged with cor-

responding time stamp.

l SDT Measurement: Enable/Disable. The Service Disruption Test is triggered based on user estab-

lished thresholds.

o SDT Measurement Trigger (>us): Any inter-frame gap that is equivalent or greater than the

configured threshold will trigger the SDT measurement. This is useful if a known threshold is

expected from a given network under test. For example, if the known switchover time is 50ms,

the trigger can be set to a value slightly below 50ms to assure that the SDT is measured.

o SDT Violation Threshold (us): Triggers an SDT Violation event in the event log. This is help-

ful for historical purposes during any given test. If the measured SDT is equivalent or greater

than the configured threshold an SDT Violation event is counted.

l Traffic Loss Trigger: If the receiver does not detect incoming traffic within the configured threshold

time, a traffic loss trigger is recorded in the event log.

l RTD Unit Auto Scale: On/OFF

Ethernet Measurement Settings.htm
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Throughput Setup - General Settings(Page 2).

Multiple Streams
All streams are configured for the same test layer - if Layer 2 is selected, all streams will be Layer 2 traffic.

MX Discover and Control Settings

Before proceeding with MX Discover or Control, be sure to assign an IP address to each test port. To assign an
IP address, proceed to the home menu and select the IP icon. Refer to IP Connection for additional instruc-
tions.

If using OAM Discover, it is unnecessary to assign an IP address to the local or remote unit.

Using MX Discover

MX Discover enables the test set to discover other VeEX VePal test sets and devices with an assigned IP
address on the same subnet.

To discover other devices usingMX Discover:

1. Tap on the MX Discover button and then press Discover.

2. A list of discovered devices on the same IP subnet will appear. Select a unit to connect to from the

list of devices.

3. Tap Close to exit the window.
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MX Discover Tool

MX Discover Remote Partner

Loop Control

The Loop Control button becomes available on the right side menu when any Ethernet application (V-SAM,
RFC 2544, Throughput, BERT) is selected. Press the Loop Control button to configure loop up and loop down
commands necessary to control a far-end unit. The loop up command contains information about the test layer.
Looping back test traffic is possible as follows:

l MX Discovered: Lists MX discovered devices. Select from the list of discovered devices to loop up/-

down
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l User Defined: Input the destination IP address of the far-end device

l X-Loop: Loops non-VeEX networking equipment.

Remote Partner Control

The Peer-to-Peer option is available only for RFC2544.

Per Stream Configurations

Frame Header, Traffic, and Error Injection setup is identical to the configuration for BERT testing. Refer to the
corresponding BERT section for setup information on the following:

l "Header Settings " on page 45

l "MAC, VLAN, MPLS, IP, and Test Pattern Configurations " on page 47

l Traffic Settings (Per Stream Configuration)

l Error Injection Setting (Per Stream Configuration)

Settings for each stream can be setup by selecting the Stream # from the drop-down menu.

../../../../../Content/Procedures/Ethernet/Throughput_Testing_Multiple-Streams/ThroughputTesting_Traffic_Settings_Per_Stream_Configuration.htm
../../../../../Content/Procedures/Ethernet/Throughput_Testing_Multiple-Streams/Throughput_Testing_Error_Injection_Setting_Per_stream_Config.htm
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MAC Setup

Throughput Setup - Traffic Setup - Constant Traffic Flow

Throughput Test - Error Injection Settings per Stream
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Summary

The summary screen lists the source, destination and VLAN information of each stream. Tap on the appro-
priate box of each tab to reconfigure the source, destination, or VLAN information if desired.

Throughput Test - Summary (MAC List)

Starting/Stopping a Throughput (Multiple Streams) Test

Once all configurations have been made, the user can start the Throughput test (press the Start icon on the top
right section of the screen). The following are three scenarios of how to prepare and start the unit for Through-
put testing.

If testing on the fiber ports, make sure the LASER is turned On before starting the test.

l End-to-End Testing

l Connect the test set to another unit that supports BERT testing.

l After configuring test settings on both units, start the tests.

l Far-End Unit in Manual Loopback Mode

l If the far-end unit (another MX) is already in a manual loopback mode, do not send a loop up
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command since it is not necessary.

l Once the correct control settings are configured, the user can start the test.

The selected tests will run automatically. When all the tests are complete the test will stop automatically. If the
Throughput test suite needs to be stopped before they are done, then simply press the Stop button, located in
the actions drop-down menu. The status of each selected test can be seen in the Results tab.

l Far-End Unit Controlled with Loop Up/Down Commands

l If the far-end unit is not manually looped back, then it must first receive a loop up command

from the control unit before the Throughput test suite can be started.

l To loop up the far-end unit with the manual mode loop up/down commands, configure the con-

trol settings mode to manual.

l Enter the MAC and/or IP address of the far-end unit.

l Send the loop up command by tapping on the Loop Control button and pressing Loop Up.

Once the far-end unit has been looped back, start the test by pressing the Start button. When the all of the
selected test are completed, the Throughput test suite will stop automatically. Once all tests have been com-
pleted and there is no need to test again, go back to the Control tab, and press the Loop Down button. This will
send a loop down command to the far-end unit to remove the loopback that is in place.
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Throughput Results

Viewing Throughput (Multiple Streams) Test Results

When the test is first started, the screen automatically changes to the Global/Aggregate results screen.

Global/Aggregate Results

The Global results pages displays measurements for all traffic streams as well as non test traffic.

The Stream Summary screen displays:

l Stream number (#)

l Total received bandwidth per stream

l Errors/alarms associated with the stream

l Quality of Service (QoS) performance verification associated with each stream

Throughput Results - Global Stream Summary

QoS
QoS values are based on packet statistic thresholds for roundtrip delay, jitter, frame loss, and IP checksum
from the ITU-T Y.1541 standard. Below is a list of IP network QoS class definitions and network performance
objectives from Y.1541.

"U" denotes "unspecified" or "unbounded" and signifies that no objective was established for this parameter
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and default Y.1541 objectives do not apply. Parameters designated with "U" are occasionally inconsistent and
poor.

IP Network QoS Class Definitions and Network Performance Objectives
(Classes 0-3)

Network Per-
formance
Parameter

QoS Classes

Class 0 Class 1 Class 2 Class 3

IPTD ≤ 200 ms/2
(100 ms
one-way)

≤ 800 ms/2 (400
ms one-way) AND
> 200 ms/2

≤ 200 ms/2
(100 ms
one-way)

≤ 800 ms/2 (400
ms one-way) AND
> 200 ms/2

IPDV ≤ 50ms ≤ 50ms U U
IPLR > 1/100,000

AND ≤
1/1000

> 1/100,000 AND ≤
1/1000

> 1/100,000
AND ≤
1/1000

> 1/100,000 AND ≤
1/1000

IPER >
1/1,000,000
AND ≤
1/10,000

> 1/1,000,000 AND
≤ 1/10,000

>
1/1,000,000
AND ≤
1/10,000

> 1/1,000,000 AND
≤ 1/10,000

IP Network QoS Class Definitions and Network Performance Objectives
(Classes 4-7)

Network Per-
formance Para-

meter

QoS Classes
Class 4 Class

5
Class 6 Class 7

IPTD ≤ 2 s /2 (1 s one-
way) AND > 800
ms/2

U ≤ 200 ms/2
(100 ms one-
way)

≤ 800 ms/2 (400 ms
one-way) AND > 200
ms/2

IPDV U U ≤ 50ms ≤ 50ms
IPLR > 1/100,000 AND

≤ 1/1000
U ≤ 1/100,000 ≤ 1/100,000

IPER > 1/1,000,000
AND ≤ 1/10,000

U ≤ 1/1,000,000 ≤ 1/1,000,000

The Aggregate screen displays these parameters:

l Line Rate (Mbps): Negotiated rate of the interface (10M, 100M, or 1000M). This value is always

fixed since it depends on the maximum capacity of the link under test, hence the test interface that is

configured.
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l Utilization:% of Line Rate. For example, if we transmit 100Mbps on a 1Gbps interface then the util-

ization value is 10% (or 100Mbps) of the total link capacity (or Line Rate).

l Framed Rate: (Payload + MAC/IP Header + VLAN Tag + Type/Length + CRC) / (Payload + Total

Overhead) * Line Rate % (in Mbps).

l Data Rate: Payload / (Payload + Total Overhead) * Line Rate %.

l Total # of frames, bad frames, and pause frames.

Throughput Results - Global Aggregate

TheGlobal Signal screen (fiber ports only) displays the optical level measured by the SFP transceiver. Page 1
displays the level measurement in dBm for the optical signal.

Loss of Signal (LOS) and the Saturation level for optical signals are shown graphically including the level meas-
urement in dBm.
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Throughput Results - Global Signal (Page 1)
Signal (Page 2)
Page 2 displays the Optical module (SFP) information which includes Vendor name, Part Number and Optical
Wavelength. Tap on the Decode button to view additional information on SFP optics.

Signal (Page 3)
The received signal frequency and offset is measured and performed on the optical interface (SFP).

l Current: Indicates the frequency of the input signal.

l Offset: Indicates the difference between the standard rate and the rate of the input signal.

l Min (ppm): Indicates the difference between the standard rate and the minimum deviation detected

in the input signal.

l Max (ppm): Indicates the difference between the standard rate and the maximum deviation detec-

ted in the input signal.

TheGlobal Errors screen displays the Current and Total error count of all streams:

l Sync Header Error 

l Block Type Error

l FCS/CRC: Number of received frames with an invalid Frame Check Sequence (FCS)

l IP Checksum: Invalid IP Frame Check sequence

l TCP/UDP Checksum (Layer 4 only)
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l Jabber frames: Number of received frames larger than 1518 bytes containing an invalid FCS

l Runt frames: Number of received frames smaller than 64 bytes containing an invalid FCS

l Giant frames (Advanced Monitoring - Pass Through Results only): Number of received frames lar-

ger than 1518 bytes

Throughput Results - Global Errors

TheGlobal Alarms screen displays the Current and Total alarm count of all streams:

l LOS: Loss of Signal

l LOSync: Loss synchronization

l Service disruption associated with loss of signal:

l Current: Duration of the current service disruption

l Total: Total accumulated duration of the service disruptions

l Min/Max: Minimum and maximum duration of the service disruption events

l No. of Occurrences: Counter of service disruption events

l Local/Remote Fault

l PCS-HI-BER: PCS High BER

l PCS-LOBL: PCS Loss of Block Lock
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Throughput Results - Global Alarms

TheGlobal Events screen displays the Time, Event Type, Number of Events, and Test Type.

Throughput Results - Global Events
TheGlobal Traffic screen displays:

l Frame Type of all streams

l Traffic Type of all streams

l Frame size of all streams
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Throughput Results - Global Traffic Summary

Tap on the bar graph for frame and traffic distribution statistics.

Frames tab: The following Frame distribution statistics are displayed in Count (#) and Percentage (%):

l Received (RX) frames:

l Total frames

l Test frames

l VLAN tagged frames

l Q-in-Q VLAN stacked frames

l Non-test frames

l Transmitted (TX) frames:

l Total frame - Total # frames transmitted

l Pause frames: Total number of transmitted and received Ethernet pause flow-control frames
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Throughput Results - Frames Type

Traffic Type tab: The following Traffic distribution statistics are displayed in Count (#) and Percentage (%):

l Layer 2/3 Unicast frames: Number of Unicast frames received without FCS errors.

l Layer 2/3 Broadcast frames: Number of Broadcast frames received without FCS errors. Broadcast

frames have a MAC address equal to FF-FF-FF-FF-FF-FF.

l Layer 2/3 Multicast frames: Number of Multicast frames received without FCS errors.

Frame Size tab: The following Frame distribution statistics are displayed in Count (#) and Percentage (%):

l < 64 bytes frames

l 64-127 byte frames

l 128-255 byte frames

l 256-511 byte frames

l 512-1023 byte frames

l 1024-1279 byte frames

l 1280-1518 byte frames

l > 1518 byte frames - Jumbo frames

Per Stream Results
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The Per Stream tab displays the same type of statistics as seen in Global Results.

For descriptions of the parameters in each tab, with the exception of Rates, please refer back to "Glob-
al/Aggregate Results" on page 134.

l Summary: Framed rate, data rate, # of bytes, total # of frames associated with each stream.

l Errors: Errors associated with each stream.

l Service Disruption Test results for each stream.

l Events: Events associated with each stream.

l Traffic: Traffic statistics associated with each stream.

l Delay: Delay associated with each stream.

Round trip delay measurements are only available in the per-stream results screen and

requires a traffic loop at the far-end.

l Rates: Rate information associated with each stream.

Throughput Results - Summary per Stream

The Per Stream Errors screen displays the Current and Total error count of each stream.

l Bit: Indicates errors related to test pattern (Bit Error or LSS [Pattern Loss])

l BER: Bit Error Ratio
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l FCS/CRC: Number of received frames with an invalid Frame Check Sequence (FCS)

l IP Checksum: Invalid IP Frame Check sequence

l TCP/UDP Checksum (Layer 4 only)

l Jabber frames: Number of received frames larger than 1518 bytes containing an invalid FCS

l Runt frames: Number of received frames smaller than 64 bytes containing an invalid FCS

l Frame Loss

l Frame Loss %

l OOS

Throughput Results - Errors per Stream

Service Disruption Test (SDT)

l Total: Total cumulative service disruption for the duration of the test.

l Last: Last SDT measured during the test.

l Min/Max: Minimum and maximum SDT measured during the test.

l No. of Occurrences: Number of service disruption events (SDTs).

l No. of SDT Violations: Number of instances the SDT threshold was met or exceeded.
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SDT Per Stream Results

The Per Stream Events screen displays a Date and Time stamped record of bit errors, alarms and other anom-
alies pertaining to each stream.

The Per Stream Traffic screen displays the frame type and frame size distribution pertaining to each stream.

Throughput Results - Traffic per Stream

The Per Stream Delay screen displays the frame delay information pertaining to each stream. The Histogram
shows the sampling points for the delay.

Round Trip Delay Results and Histogram
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Round Trip Delay Results per Stream - Summary

Round Trip Delay Histogram

One Way Delay Results and Histogram (Table and Graph)
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Per Stream Delay Table

The Per Stream Rate screen displays the frame rate and data rate pertaining to each stream. Tap on either
dial to see rate details.

Throughput Results - Rates per Stream
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Throughput Results - Rates per Stream (Rate Details)

Saving Throughput (Multiple Streams) Results

Once the test has been stopped the results can be saved by pressing the Save key on the VePAL’s keypad.
The results will be saved and named automatically. Once the results are saved, the user may view or rename
the results file by going to File Manager at Utilities > Files > Saved. Refer to File Manager

V300_FileManager_SavedResults_Profile_Images.htm
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Layer 4+ Applications

Layer4+ refers to the Internet layers 4 and above (transport and application layers), which are more closely
related to the customers/subscribers’ applications and the way they use Ethernet, the Internet, and how they
perceive performance (quality).

Stateful TCP testing refers to the validation of TCP connections used for the TCP/IP Protocol Stack. A V-Perf
test will validate that the TCP parameters in the network were set up correctly. The optional V-PROBE is used
as remote server to establish TCP connections and validate that the network is configured correctly for seam-
less passing of TCP traffic. It will also verify the maximum throughput for TCP traffic. Typically in the field, after
running layer 2 & layer 3 tests successfully, a customer may still complain that their connection is slow to
deliver their applications. Running a stateful TCP test will help verify maximum throughput rates in the down-
load and upload direction. If throughput performance is poor, the test can help identify what the issue could be.

TCP Protocol and Overview

Fundamental TCP parameters are the ideal TCPWindow Size and Throughput. The complete list of relevant
measurements include:

l TCP Window Size

l TCP Throughput

l Number of Connections Established

l Download Time

l File Transfer Size

l Retransmits

Transmission Control protocol is the most widely used transport layer protocol. TCP is used by most applic-
ation protocols: HTTP, FTP, Telnet. It provides the following services:
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l End-to-end connection

l Multiplexing/Demultiplexing of separate sessions

l Flow control

TCP is a connection-oriented protocol. A Connection is established prior to data transmission between the two
end devices (client and server). A 3-way handshake procedure is used to establish connection.
When a connection is established, the data transfer can start. TCP uses sequence numbers to reassemble
data and verify that no data has been lost. 

TCP uses the Window mechanism for Flow Control:

1. The Sender indicates in the Window size the data it is prepared to receive.

2. TheWindow size is the amount of outstanding data that can be sent before acknowledgment is

received.

3. If data is lost, the window size is decreased and less data is sent prior to acknowledgment.
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l Step 1: Client sends a SYN message with SYN flag set in the TCP header. The Sequence number

specifies the number assigned to the first segment.

l Step 2: Server receives SYN packet and sends SYN + ACK packet SYN flag set, ACK flag set

Sequence number specifies the server’s starting sequence number. Acknowledgment number

means that the server has received X and expects X+1.

l Step 3: Client receives SYN + ACK and send ACK back. ACK number means that server has

received Y and expects Y+1.

RFC 6349 Testing Methodology
RFC 6349 is a practical testing methodology consisting of 4 different steps for measuring end-to-end TCP
Throughput and Performance in a managed IP network.

l Step 1 Max MTU Search:

Search for the maximum packet length that can be sent through the network without segmentation.

The Path MTU search follows RFC4821 (Packetization Layer Path MTU Discovery).

l Step 2 Round Trip Time (RTT) Search:

Measure of the round trip time between the TCP segment sent and the acknowledgment received,

the test has to be done in a network that is not congested to obtain the real round trip delay (not

accounting for network buffer delay).

l Step 3 Bottleneck Bandwidth (BB) Search:

For this step, a Layer2/3 test can be done (RFC2544 or Y.1564) to determine the maximum through-

put rate supported by the network.
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l Step 4 Bandwidth Delay Product Calculation:

Based on RTT and BB results, the BDP is computed to estimate the optimal window size that should

be used for testing (Auto mode). Fixed window size can also be specified.

Key Metrics:

l TCP Bandwidth Delay Product

l Transfer Time Ratio

l TCP Efficiency

l Buffer Delay

TCP Bandwidth Delay Product is the theoretical maximum of data that can be transmitted based on network
delay and throughput rate.

BDP (Bytes) =
Link Bandwidth (bps) x RTT (s)/8

To completely occupy the available bandwidth the Window size must be set to the BDP value.

The ideal TCP transfer time is based on the Maximum achievable TCP transfer rate, calculated based on the
Bottleneck Bandwidth (BB) and the layer 1-2-3-4 overheads associated with the network path. The actual TCP
transfer time measures the time it takes to transfer data.

Transfer Time Ratio =
Actual TCP Transfer Time / Ideal TCP Transfer Time

Example of an ideal TCP transfer time based on a 1500 Bytes size MTU and 100MB file download
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TCP retransmission is done when TCP segments are lost during transmission or an acknowledgment is
missing.  Segments can be retransmitted more than once. 

There is no direct correlation between the number of Ethernet frames lost at the physical layer and the
number of TCP retransmission, since a single lost acknowledgment could trigger many retransmission.

TCP Efficiency =
Transmitted Bytes + Retransmitted Bytes/Transmitted Bytes x 100

The Buffer Delay represents the increase (or decrease) in Round Trip Time (RTT) during a TCP throughput
test compared to the baseline RTT.

A large RTT Buffer delay indicates that the network is experiencing congestion and that segments are
being delayed.

Buffer Delay =
Average RTT – Baseline RTT/Average RTT x 100



Ethernet © VeEX Inc. All Rights Reserved. 153

Configuration

Before launching V-Perf, V-Test, or V-FTP tests, it's necessary establish an IP connection. For V-Perf testing,
repeat these steps for both the far end and near end test sets.

1. Select a Layer 4 test application to launch from the Test Mode menu.

2. For testing on SFP ports, turn the laser on.

3. Tap the IP icon. Configure a static IP address for testing. If the environment supports DHCP, select

DHCP from the IP Address menu, then tap Connect.
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4. Once the proper IP information is entered, press Connect. An IP: PASS status indicates proper con-

nection.

5. Go to Layer 4+ Applications. The test application will load.

For more information about IP Connections, refer to IP .

Saving Test Results
Test results can be saved to the File Server using the Save hard key. Results can be retrieved via USB drive or
remotely using the Web UI. Refer to "File Manager" on page 279.

../../../../../Content/Procedures/Ethernet/IP/IP.htm
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V-PERF

TCP/UDP-based business Internet speed performance test based on RFC6349 and compatible with RTU-300
hardware-based centralized test heads as well as iPerf and iPerf3 servers.

A common source of customer complaints come from file transfer speeds not matching the throughput rates
guaranteed in the SLA. While many factors affect TCP applications performance, including customer’s oper-
ating system hardware performance and settings (TCP window size), carriers need to prove SLA with a test
tool that can show TCP performance independent of Operating System or Server limitations and present
repeatable reliable results. The test set V-PERF feature uses RFC6349 test methodology and metrics for qual-
ifying network TCP or UDP performance. It offers a full line rate stateful TCP test with configurable window
sizes, client and server modes as well as compatibility with iPerf servers.

The V-PERF test suite consists of the full TCP Throughput test Compliant with RFC6349 (Test Set to Test Set
only) and also the original stateful TCP testing to iPerf/iPerf3 server or to our V-Probe.

l Stateful TCP Test up to 10GE line rate

l TCP Client/Server and Bi-Directional modes

l Compatible with iPerf Client/Server

l MTU search per RFC4821

l Round Trip Time Measurement

l Configurable TCP Window

l Multi-Window size tests

l Measurements: TCP Throughput rate (min, max, average), Transfer file size and duration, Transfer

time ratio, TCP Efficiency %, Buffer Delay %

TCP Throughput Test Diagram
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Server/Client - Unidirectional Configuration and Results

1. After loading the Layer 4+ Application, set one test set as a Server from TCP Mode. Press Start.

Test Set #1 - V-PERF Setup - Server

Test Set #1 After Pressing Start - Server Mode

2. Set the other test set as a Client for FTP Mode. On the bottom of the screen, go to Page 2 to con-

figure the Throughput Test Mode type. MTU Search, Round Trip Time Search, Bottleneck

Bandwidth, and Window Size options are also on Page
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Test Set #2 - V-PERF Setup - Client

3. Connect the two test sets to the Near End (NE). Press Start on the Client unit.

Status: Global

Client - Results - Status

The Status tab displays test progress and pass/fail results for MTU Search, RTT Search, and TCP Test.
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Summary: Global

Client - Results - Summary

The Summary tab displays test progress and pass/fail results for RFC 6349 measurements.

Graphs: Per Stream

Client - Results - Per Stream TCP Graphs

Graphs compare the Expected TCP Upload Rate with the measured TCP rate for all tested window sizes.

Graph display options can be modified in the following ways:

l Change the Mbps range with the - and + buttons.

l Display all window sizes on one graph or individual window sizes using the drop-down menu.
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l View the legend for each color-code line measurement with Lines Color.

MTU and RTT: Global

MTU and RTTmeasurements are displayed in their respective tabs.

Client - Results - MTU

Event: Global

The Event tab displays the time and date for each event that occurs during testing.

Per Stream

Per Stream results display the TCP results for each stream.

TCP Status displays test progress and pass/fail results for RFC 6349 measurements identical to the Summary
(Global Results) tab.

TCP Graphs displays per stream graphs identical to the Graphs (Global Results) tab.

Server Results

The Status tab displays the Client IP and current test event.
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Server - Results - Status

Summary Results

The Summary tab displays information on the current session and the RFC-6349 key performance indicators.
Summary results per stream are viewable in the Per Stream tab.

Server Results - Summary
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Bi-Directional Configuration and Results (VeEX Enhanced Testing Methodology Implementation)

The Bi-Directional TCP testing methodology is unique as it allows two separate tests to run simultaneously on
the same link in different directions. Both Test Sets are actually configured as Client & Server at the same time,
saving the time of having to run each direction separately.

To simplify the configuration for this example, one test set is configured as a Client and the other as a
Server. In reality however, as mentioned previously, both tests will be running simultaneously.

1. Select Bi-Directional from the V-PERF Mode drop-down menu on both test sets. Select the Bi-Dir-

ectional Mode as Client on the Local End and Server on the Remote end. 

Local End Tester - Bi-Directional Server Setup

2. Press Start test at the Near End. The entire test flow is automated.  Results will show up as the tests

run – a total of 4 sessions.

l Current test progress is shown in Event.

l Summary (Page 1) provides information on the current session running and the RFC-6349

key performance indicators. Tap on Client Results to verify the metrics.

l Final results of the completed test will show under Status.



162 © VeEX Inc. All Rights Reserved. Ethernet

V-TEST

The V-TEST feature qualifies network TCP/HTTP protocol performance by testing Internet speeds up to a full
line rate against a server to verify the maximum download and upload data rates attainable by subscribers'
high-speed or Gigabit Internet services.

Run a Speed Test

ISP & Sponsored Server Selection Modes

V-TEST or Speedtest® verify/certify the Internet Access data rates which are the rates advertised by the Inter-
net (access) Service Provider (ISP), from the customer's premises to the point of entry to the Internet. For that
reason, the selection of the centralized speed test server is very important.

Before starting the Download and Upload throughput tests, the test set pings nearby servers, then it generally
selects the one that has the fastest ping response. However, all the nearby Ookla® servers would be a com-
bination of ISP-owned or sponsored servers, and some other servers that are hosted by independent com-
panies, which may reside outside of the footprint of the ISP providing the service. Testing to a server that is not
owned/sponsored by the ISP may not guarantee reliable test results, since the server has not been vetted by
the ISP providing the service.

Turning the ISP/Sponsor Match settingON, instructs the test set to prioritize the server search for servers that
are sponsored by the ISP and select one of these servers for testing. If no ISP-sponsored servers are found,
then the test set would carry out its normal search for the fastest ping-response server.

Managed Server Tests

Server Named FREMONT Can Be Added to server1

Creating New Server Profiles and Server Lists
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1. From the Setup tab, select Manual from Server Selection Mode.

2. The different tabs provide access to detailed test Results (Summary, Status, Graphs), Setup

(manual configuration), and offers buttons for direct access to other related troubleshooting test

tools.

More about Advanced V-TEST Modes

Server Selection Modes

l Ookla® Speedtest®

Speed Test Modes

Auto Mode: This is the default and recommended mode, and it is

also known as "Speedtest Powered" mode. It automatically selects

the best speedtest.net server from lists maintained by Ookla. It will

scan nearby servers in the local market and test to the server with

the fastest (lowest latency) response.

Manual Mode: Manually select a specific Server ID from a list of

public Ookla servers. A list of all nearby servers is displayed auto-

matically. The corresponding server ID and server information

(URL/IP, location, and ISP) are also provided.

l VeEX Managed – Perform internet speed tests by manually selecting servers from

lists created and maintained by VeEX. These non-public lists are created for specific

customers. The Update button is used to update the servers' list. Internet access is

required to receive the server lists maintained by VeEX.

l User Managed – Advanced users can perform internet speed tests by manually

selecting servers from pre-configured lists, using the Manual mode. In User Man-

aged mode, enter the server IP/URL and save it to a server list that can be main-
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tained and managed on its own. Options to modify or delete server lists are available

under Server List Manage.

l Manual – Advanced users, with detailed knowledge of their Speedtest servers, can

manually add their own servers, test files and maintain their own server lists. Enter

the IP/URL of the server to test. If TCP port number 8080 is used, there is no need to

enter a Path and File name. Port 8080 is used by Ookla netgauge servers, therefore

the proper Speedtest handshaking will take place between the test set (client) and

Ookla server. If TCP port number 80 is used, the correct Path and Filename need to

be entered.

3. Tap Update and select a file to transfer. The File Name and Path will populate into the field. After

setting up the new server profile, tap the Add To Server List drop-down menu. Save as new cre-

ates a new server list and adds the current server profile to that list. The option to add the profile to

an existing server list is also available.

Server Named FREMONT Can Be Added to server1

4. Server profiles and server lists created from here are available in Server Selection Mode > User

Managed.



Ethernet © VeEX Inc. All Rights Reserved. 165

FREMONT and server1 appearing in User Managed

Starting a V-TEST
Select a server from User Managed or VeEX Managed. Enabling Ping mode simultaneously runs a Ping test.
Ping Response results will appear under the Results tab. TapGO to initiate testing. The download test starts
first, followed by the upload test. 

V-TEST - Results - Status
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V-TEST - Results - Http Graphs

More about Link Statuses

Link Status Indicator Labels
A yellow status box will be displayed when the link has been properly established with the port
under test and it is considered active.

10GE: 10 Gbit/s, 10GBASE-T copper interface (RJ45 UTP) or 10GBASE-
X optical interface (LC-UPC duplex)

5GE: 5 Gbit/s, 5GBASE-T copper interface (RJ45 UTP) or 5GBASE-X
optical interface (LC-UPC duplex)

2.5GE: 2.5 Gbit/s, 2.5GBASE-T copper interface (RJ45 UTP) or
2.5GBASE-X optical interface (LC-UPC duplex)

1GE: 1 Gbit/s, 1GBASE-T copper interface (RJ45 UTP) or 1GBASE-
optical interface (LC-UPC duplex)

1000T: 1 Gbit/s, 1000BASE-T copper interface (RJ45 UTP)
100T: 100 Mbit/s, 100BASE-T copper interface (RJ45 UTP)
10T: 10 Mbit/s, 10BASE-T copper interface (RJ45 UTP)
FDX: Full Duplex
HDX: Half Duplex
UTP: Unshielded Twisted (copper) Pairs cable
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V-FTP

V-FTP is an internet speed performance test based on uploading and downloading large test files to an FTP
server. The V-FTP Throughput feature allows users to test up to full line rate FTP protocol performance to any
FTP Server by uploading and downloading files.

Run a FTP Speed Test

1. Tap the V-FTP tab.

2. On the Setup subtab, select Download or Upload from FTP Mode. 

3. Enter the FTP server IP Address,File/Path, User Name, and Password information.

4. A. If setting up for a Download Test, select the TCP Window Size.

B. If setting up for an Upload Test, select the MTU Size and enter the Size and Bottleneck Band-

width.

5. Tap Files to open up the FTP file selection window and view all the files on the server. Select a file to

transfer and tap Start to run the test.

V-FTP - Setup - Download
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V-FTP - Setup - Upload

V-FTP - Download - Results
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SyncE

SyncE Setup

Port (Test Port selection)

Prior to starting the SyncE operation, the selected test port must be connected to a network that supports
SyncE timing synchronization. Port selections include 100/1000T and 100/1000BaseX. After setting up the
port, IP connection is not required for SyncE tests. Please see section Port Setup for port configuration instruc-
tions.

Port Status

../../../../../Content/Procedures/Ethernet/Ethernet Port Setup.htm
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Port Page 2 - Mode Selection

Master and Slave Mode
Master Mode emulates a SyncE Master clock device and slave mode emulates a SyncE Slave clock device.
Both modes operate out of the Ethernet test port (100/1000BaseT, 100/1000BaseX, or 10GE) and can use an
internal or external reference clock.

SyncE Master-Emulation Mode

l Synchronous Ethernet: Enabled or Disabled.

l Emulation Mode: Select Master or Slave emulation mode. In Master mode, the unit uses the TX

Clock Source reference clock to provide SyncE clock on the Ethernet interface (10/100/1000T and

100/1000BaseX or 10GE port). In Slave mode, the unit recovers SyncE clock from the Ethernet inter-

face (10/100/1000T and 100/1000BaseX or 10GE port).

l TX Clock Source (Master Mode): Select between an internal or external clock source. This clock is

used as a reference clock for SyncE Master operation.

l Measurement Clock Reference (Slave Mode): Select between an internal or external clock source.

This clock is used as a reference clock for SyncE Master and for SyncE Slave Wander Meas-

urement.

Possible Internal Clock sources: Internal Clock (+/-3.5ppm accuracy), Internal GPS 1 PPS

(Requires GPS option and Antenna), Internal Atomic 1 PPS (Requires High Precision Atomic Clock

option).



Ethernet © VeEX Inc. All Rights Reserved. 171

l Possible external clock sources: 1.5444MHz,1.544Mbps, 2 MHz, 2Mbps (E1 signal), 10MHz,

25MHz, 125MHz or External1 pps. The external clock source is connected to the SMA port on each

Test Module. This port is marked CLK on the connector panel.

Avoid using rigid BNC-to-SMA adapters to prevent any stress on the test set’s connector. Flex-

ible adapters or cables are recommended.

l Recovered Clock Output: The reference clock used by the SyncE master or slave can be regen-

erated out of the PDH TX port (marked Tx on the connector panel) with a different clock format in

order to synchronize other network elements. In Slave mode the Reference Clock Output is the

regenerated clock recovered by the SyncE slave.

The clock can be formatted to: 2Mbps (E1 signal), 2MHz, 10MHz, 25MHz, 125MHz, 1PPS and

None.

l If 2Mbps clock is selected from Recovered Clock Output, then the following parameters need to be

set:

l Line Code: HDB3 or AMI

l Framing: Unframed, PCM31, PCM31C, PCM30, or PCM30C

l PRBS Pattern

l Invert

l Offset(ns) (only for 1 PPS Recovered Clock Output)

Press Apply once all the parameters are set.

Status
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Status

Indicator Symbols
An M or S indicates that the test set is in Master or Slave Mode. A green icon indicates a successful Slave to
Master connection. If the icon is solid red, there may be an issue with setup and the test will not work.

Symbol Description

Test set is in Master mode.

Test set is in Slave mode.

Master and Slave Clock IDs get populated once the test is started.

SyncE Wander Measurements (Slave Mode only, Optional)

SyncE slave precision timing protocol may be available on the test set with purchase of an optional wander
measurement license, adding verification of stability (wander) and accuracy.

Besides measuring time interval error (TIE) on datalink interfaces, other complementary wander measurement
and analysis applications may also be offered by the test set (all optional), along with an off-line MTIE/TDEV
analysis software for Windows® PC. The last three are required for post-analysis and standard masks fitting
(Pass/Fail) evaluations.

l Clock Wander & Phase Measurements for physical clock interfaces (1.544, 2.048, 10 MHz and

1PPS)

l Wander TIE logging and real-time export to USB
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l Built-in MTIE/TDEV Wander Analysis

l VeEX MTIE/TDEV Wander Analysis PC software

Recovered Clock Wander Measurements

In 1GE/10GE test mode, the Wander Measurement function may be found under the Advanced Tools menu,
provided that SyncE slave mode is enabled.

Wander Measurements Setup

SyncE Wander Measurements Setup

l Measurement Clock Reference reflects the selection chosen from the Port setup. Refer to "Ports"

on page 27.

l Test Mode: Select between Manual start/stop and Timed measurements. If Timed is selected, users

can set the length of the test in seconds, minutes, hours or days. Once the selected time has

elapsed the test automatically stops.

l Save TIE can be turned ON to write all wander measurements to a FAT32 USB Memory stick in real

time, to be analyzed later on.

l Sampling Rate (samples per second) can be set to 1/s, 5/s, 10/s or 30/s, depending on the applic-

ation. 30/s is recommended.
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The File Name identifies the new folder in which all configuration and measurement data will be stored.
This folder will be created in the root of the memory stick.

Tap Start to initiate the measurements and data logging.
Tap Stop to force the measurement and data logging to stop. This will also stop a Timed test, even if the total
time has not finished yet. After stopping the test, and if the built-in MTIE/TDEV option is enabled, tap Analysis
to view the TIE graph and perform the MTIE/TDE analysis on the recorded TIE data. Refer to the following sec-
tions for more details.

A run-time MTIE/TDEV analysis can also be performed with all the data collected up to that point, without hav-
ing to stop an ongoing long-term wander test.

Do not remove the USBmemory stick while the wander test is running.

The wander tests will stop automatically if either of the signals used as reference clock or recovered
clock (test signal) have significant levels of impairments, are lost, or disconnected.

Tap Stop to terminate the test. If Save TIE to USB is set to ON, then remove the USB memory stick from the
test set, bring it to a computer, and open it with the VeEXWander Analysis PC software.

For further MTIE, TDEV, and masks analysis, see "Built-in MTIE & TDEV Analysis (Optional)" on the facing
page.

Wander Analysis and MTIE / TDEV Post Analysis are optional features.

Results

SyncE Wander Measurement Results
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Numerical counters are provided to show the status of the test, with a basic summary of the TIE information.

l Current TIE: Shows the current time interval error measurement.

l Max TIE: Maximum positive TIE value that has been recorded since the beginning of the test.

l Min TIE: lowest or negative TIE value that has been recorded since the beginning of the test. Since

wander measurements always start with a TIE=0, then the minimum value can only be zero or neg-

ative.

l MTIE: Denotes the maximum span of TIE values recorded since the beginning of the test. In this

summary, MTIE = MaxTIE – MinTIE. This gives an idea of how much the signal under test is wan-

dering.

A real-time TIE monitor graphmay also be included in the summary screen for users to see the TIE for
the last 7 or 10 minutes of the ongoing test.

Built-in MTIE & TDEV Analysis (Optional)

Wander Analysis and MTIE / TDEV Post Analysis are optional features.

This option enables the test set to analyze up to 72 hours’ worth of wander measurement data and compare it
against standard masks for a PASS/FAIL assessment, without the need for a PC. The test set may allow the
analysis to be performed while the test is still running for run-time verification. Longer test take a lot longer to be
analyzed, so the VeEXWander Analysis PC Software is recommended for tests longer than 24 hours. Tap on
TIE to view TIE, MTIE and TDEV Analysis.

Features:

l Provides further post-processing of clock stability data, such as MTIE and TDEV

l Frequency offset calculation and removal for relative TIE analysis

l Standard MTIE and TDEV masks can be selected

l MTIE and TDEV results and mask export to CSV for further report generation using spreadsheets

l Direct PDF report generation to USB
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TIE Results

TIE Results

1. Date and Time stamp indicating when the test was started

2. Total of seconds recorded during the test

3. Beginning and end of the data set to be analyzed and displayed in the graph (5) below. Tap in the

Start and/or End field and enter the desired time limits, then press the Set Range button to apply

these changes.

4. Based on all the TIE measurements captured, the test set automatically calculates any small dif-

ference in frequency between the signal under test and the reference clock. Once the frequency dif-

ference is known, remove it to perform Relative TIE measurements. The offset removal tool is

important for field tests when the local reference clock used is highly accurate and stable but not

traceable to the PRC in the network core (e.g. a portable frequency reference). Even if the frequency

of the local reference is a few ppb (parts per billion) different than the PRC, it can still be used for

wander measurements, as long as it is highly stable, because the Offset Removal feature can math-

ematically remove the know difference and make it as if a traceable reference had been used. Once

removed, perform a relative MTIE (or MRTIE) and TDEV analysis.

5. Auto-scale TIE graph, based on the limits set.

6. Press the Measurement button to return to the current wander measurements
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7. Fine cursor controls. Use the stylus to tap on the screen to position the cursor and then use these

arrow buttons to position the cursor and read specific TIE values. The rubber cursor keys can also

be used to move the cursor.

Save and Convert to PDF options may not be available on all software versions.

MTIE & TDEV Pass/Fail Analysis

MTIE Results

1. Standard MTIE & TDEV masks selection

2. Pass or Fail indicator, evaluated depending on selected masks

3. MTIE line color indicator and Enable/Disable check box

4. TDEV line color indicator and Enable/Disable check box

5. MTIE & TDEV logarithmic graphs and standard masks

6. Press this button to return to the wander measurements screen

7. Once the mask has been selected, press Analysis to run the MTIE and/or TDEV calculations.

Depending on the number of samples collected, this calculation could take a few minutes.

8. Save the MTIE, TDEV and mask calculations in CSV format to a USB Memory stick. The graph can

be recreated using a spreadsheet program like Microsoft® Excel, printed as a report or shared via
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email or any other electronic media

9. Generates a MTIE and TDEV report in PDF format to a USB Memory stick.

MTIE & TDEV Results Exported to CSV

VeEX MTIE/TDEV Wander Analysis PC Software

l Provides further post-processing of clock stability data, such as MTIE and TDEV for long-term tests

l Frequency offset calculation and removal for relative TIE analysis

l Standard and user-programmable masks

l PDF report generation

l Conversion of TIE data file, fro VeEX’s proprietary format to an open CSV format

l Fully resizable window, to accommodate any screen size and provide detailed zoom levels

l Compact stand-alone Windows® software. It can be carried in the same USB memory as the TIE

data. No installation is necessary.

l For added convenience, the software doesn’t need installation and can be stored on and run from

the same USB stick where the wander log files are being stored.

The VeEXWander Analysis PC software can be downloaded from the VeEX Inc.website from the product
page.

https://download1.veexinc.com/RXT-1200/Release-Notes/2162/VeEX_Wander_Analysis_Release_Notes_2-2-0_20210702.pdf
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TIE Measurement Results

ClickOpen to load the desired MTIE of Phase file and see the TIE behavior on the screen. Use the Compare
button to load a secondary trace for comparison purposes. Up to two traces can be displayed and analyzed sim-
ultaneously.

ClickMTIE/TDEV Analysis to go to the wander analysis function.

MTIE & TDEV Analysis

Select the desired tolerance masks from the pull-down list, then click Analyze to perform the MTIE and/or
TDEV analysis.
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MTIE & TDEV Analysis Report in PDF

Click Report to generate a copy of the measurement and analysis in PDF format.
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ESMC SSM
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Ethernet Synchronization Message Channel (ESMC) Synchronization Status Messages (SSM) are supported
by both SDH and Ethernet networks. SDH is supported by the transport overhead channel and is uni-
directional; Ethernet is defined as Organization Specific Slow Protocol (OSSP).

SSM represents the quality level of the system clocks located in the network. Background (or heartbeat) is sent
once per second as keep alive. ESMC information PDU- event message is sent immediately in case the clock
quality level has changed. ESMC event PDU- failure condition is declared if no message is received in 5
seconds.

ESMC PDU Format
Octet number Size Field
1-6 6 octets Destination address = 01-80-C2-00-00-02
7-12 6 octets Source address
13-14 2 octets Slow protocol Ethertype = 88-09
15 1 octet Slow protocol subtype =0x0A
16-18 3 octets ITU-OUI = 00-19-A7
19-20 2 octets ITU-T subtype
21 4 bits Version

1 bit Event flag
3 bits Reserved

22-24 3 octets Reserved
25-1514 36-1490 octets Data and padding (see point j)
Last 4 4 octets Frame check sequence

Event flag: This bit distinguishes the critical time-sensitive behavior of the ESMC event PDU from the ESMC
information PDU. A value of 1 indicates an event PDU and a value of 0 indicates an information PDU.

IEEE Assigned OUI and Slow Protocol Subtype
8 bits Type: 0x01
16 bits Length: 00-04
4 bits 0x0 (unused)
4 bits SSM code

QL TLV Format
Quality Level Highest

QL-PRC Highest
QL-SSU-A |
QL-SSU-B |
QL-SEC |
QL-DNU |



Ethernet © VeEX Inc. All Rights Reserved. 183

QL-INVx, QL-FAILED, QL-UNC, QL-NSUPP Lowest

TLV: Type Length Field

QL: Quality Level

Hierarchy of Quality Levels in Option I of Synchronization Networks
Quality Level Order

QL-PRC Highest
QL-SSU-A |
QL-SSU-B |
QL-SEC |
QL-DNU |
QL-INVx, QL-FAILED, QL-UNC, QL-
NSUPP Lowest

Hierarchy of Quality Levels in Option II of Synchronization Networks
Quality Level Order

QL-PRS Highest
QL-STU |
QL-ST2 |
QL-TNC (Note) |
QL-ST3E (Note) |
QL-ST3 |
QL-SMC |
QL-ST4 |
QL-PROV (default position) |
QL-DUS |
QL-INVx, QL-FAILED, QL-UNC,
QL-NSUPP Lowest

NOTE - QL-TNC and QL-ST3E are not defined for first generation
synchronization networking (refer to clause 5.4.1.2) and QL-PROV
was identified as QL-RES

The SyncE ESMC SSM option has the following features:

l Generates “information” at a programmable interval, IPG, (default 1 sec)

l Generates “event” upon changing the QL-TLV followed by “information”

l Count message types
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l Monitor and decode messages on screen

l Capture ESMC/SSM messages and output in pcap file for further off-line protocol analysis

Setup

l IPG(s): Value can be entered by clicking in the box next to it.

l SSM Code: Quality Levels

Once the parameters are set, press Start to start the test.

ESMC SSM

Results

The Results screen shows Messages, Protocol Monitor, and Capture.

Message: A list of all the SSM quality levels with the results of the QL selected in Setup next to it.
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SyncE ESMC SSM Results- Message

Monitor

The Tracer shows the messages as they are sent or received. The test set stores up to 2000 messages. Tap
on the desired message to view decoded message details.

SyncE ESMC SSM Results- Protocol Monitor

Message Details

Capture

Press Start to Capture Packets. The number of captured packet results is displayed.
To store these results packets, press Stop, then press Save as. Enter a name for the results file. Press Apply
to save the file. The file is saved under the Files folder on the unit in pcap format. The file can be later exported
to a PC and analyzed using Wireshark. Refer to File Management
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SyncE ESMC SSM Results- Capture

SyncE ESMC SSM Capture Save
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Phy Mode

Phy Mode puts the Phy chip in a special mode to transmit a specified wave form. Exiting the menu auto-
matically returns the PHY chip to normal operation.

Phy Mode Menu
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Net Wiz

The Net Wiz function tests the Ethernet cable and associated network environment. A typical application is
shown below.

Typical Net Wiz Application
Net Wiz tests include:

l Cable Analysis with distance (Ethernet RJ45 Test port only, not available on Ethernet RJ45 Man-

agement port)

o to switch with MDI mode (Straight or Crossover)

o to fault, type of fault (Open, Short, Impedance Mismatch)

l Analyze the network and automatically report

o Stations

o Routers/Gateway

o Printers

l Provide MAC and IP addresses of each device

l PING each device and verify the device is active

l Provide detected networks (NetBiOS, IPX, etc.)

Before proceeding with any Net Wiz tests, make sure that an IP connection has been
established. Refer to "IP Connection" on page 35 for more information.
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Cable Test

Cable Test

Press Start to begin the test. The test set will return the connection type (Straight or Cross Over) if connected
to an end device. If fault is detected (Open or Short) the fault will be indicated as well as the distance to the
fault.

Discovery Setup

Discovery Setup
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l Profile: Drop-down selections are Default, Delete, Save, Save As...

l Begin IP: Set the start address for the desired IP range using the numeric keypad

l End IP: Set the end address for the desired IP range using the numeric keypad

Select by placing a check mark in the corresponding box of any of the following: ARP, SNMP, NetBios, Ping,
Net .

Discovery Results

Discovery Results - Summary

Summary indicates the test status and reports:

l TX/RX Frames: Total number of TX (transmitted) and RX (received) frames

l RX Errors: Received frames in error

l Speed Advert: Speed advertised

l Duplex Advert: Duplex mode advertised

l Devise Found:Total number of Devices and Networks found
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The Devices tab reports global and detailed device information.

Discovery Results - Devices - Global

Global reports:

l Total number of devices found

l Number of devices (Routers, Servers, Hosts)

Discovery Results - Devices - Detail

Detail displays the Attribute, MAC and IP Addresses, Group and Machine Names and Ping test results of each
device discovered.
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Discovery Results - Networks

Networks reports the number of IP Subnets, Hosts, Domain, and Named Hosts found.
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Autoscripting

Autoscripting runs BERT1 and Throughput2 test profiles in succession.
Profiles are configured from the test application or ReVeal software.

Autoscripting - BERT Setup

Setup

l File Prefix: Prefix added to name of test results. The default prefix is "Autoscript."

l If Alarm/Error detected: Choose to Continue or Exit testing if an alarm/error is detected.

l Profile: Select Default, Last Configuration, or None.

l Testing duration can be set for seconds, minutes, hours, or days.

l Tap View Setup to view test setup parameters. Setup cannot be configured from this menu.

Tap the green Start button to begin Autoscripting. The soft LED light indicates the status of finished tests:

Green: No error or alarm was detected.

Red: An error or alarm was detected.

1BERT or bit error rate test is a testing test method for digital communication circuits that uses predetermined
stress patterns consisting of a sequence of logical ones and zeros generated by a test pattern generator.
2Throughput is one of the key metrics in performance testing. It's used to check how many requests a software
will be able to process per second, per minute or hour. As a rule, every test plan has a throughput goal.
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Results

Starting the test brings up the BERT/Throughput Results tab. Test status is displayed in green on the bottom of
the screen. When testing finishes, results are automatically saved.

Use the File Manager to access saved results.

Autoscripting - BERT Results

Autoscripting - Saving Results

Autoscripting - Saving Results

File Manager - Saved Results

V300_FileManager_SavedResults_Profile_Images.htm
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L2 Control Protocol Transparency Test (L2CP)

L2CP tests network transparency to Layer 2 Control Protocols by transmitting a number of preselected L2 con-
trol protocol frames from Test set A and making sure that they are received on Test set B through the network
under test.

L2CP Transmit/Receive Mode

L2CP Loopback Mode

Setup

Press the green Start button to start the test with previous settings or NEXT to continue with the step-by-step
setup process.

L2CP Transparency Test - Step 1
Step 1
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l Transmit: Unit is setup to transmit and Receive L2CP frames. If the unit is selected as a transmitter,

the option to Automatically Loop Up/Down becomes available.

l Receive: Unit is setup to only Receive L2CP frames.

l Loopback: Unit loops incoming L2CP frames at Layer 1.

L2CP Transparency Test - Transmitter - Step 2

Step 2
Step 2 confirms the test mode selection. If the unit is set to Receiver mode, setup is complete.

L2CP Transparency Test - Transmitter - Step 3
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Step 3

l If the unit is set to Receiver mode, setup for the receiver is complete.

l For Transmit mode, configure the MAC address that will be used as MAC Source for all the test

frames or press the “MAC Source” function key to overwrite with the MAC address of the test set.

L2CP Transparency Test - Transmitter - Step 4

Step 4
Configure the VLAN Tag(s) that will be used for the test frames. VLAN can be disabled or enabled with up to 3
tags

L2CP Transparency Test - Transmitter - Step 5

Step 5
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Select the number of test frames that will be transmitted for each L2CP. Configurable from 1 to 100. Configure
Test Frame Rate: From 1 to 10 frames per second.

L2CP Transparency Test - Transmitter - Step 6

Step 6
Select the type of frames that will transmitted during the test. Please see the List of Protcols section for more
information. Add a check mark to each L2CP to test or select all.

When the test starts, the screen displays L2CP frames transmitted and received for each protocol. The field dis-
plays N/A if a protocol type has not been selected for the test. Packet capture (green PCAP Start button) can
run simultaneously with the test. Refer to Packet Capture for information on using packet capture and retriev-
ing saved files. 

L2CP Transparency Test Running
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List of Protocols

Layer 2 Control Protocol Protocol Identifier L2CP Destin-

ation Address

Spanning Tree

(STP, MSTP, RSTP)

LLC=0x82 01-80-C2-00-

00-00

Link Aggregation (LACP) Ethertype: 0x8809

Subtypes: 0x01

01-80-C2-00-

00-02

E-LMI Ethertype: 0x88EE 01-80-C2-00-

00-07

Link OAM Ethertype: 0x8809

Subtypes: 0x03

01-80-C2-00-

00-02

Ethernet ESMC Ethertype: 0x8809

Subtypes: 0x0A

01-80-C2-00-

00-02

PTP Ethertype: 0x88F7 01-80-C2-00-

00-0E

Link Layer Discovery Protocol

(LLDP)

Ethertype: 0x88CC 01-80-C2-00-

00-0E

Virtual Station Interface Dis-

covery and Configuration Pro-

tocol (VDP)

Ethertype: 0x8940

Subtypes: 0x0001
01-80-C2-00-

00-00

Port Extender Control and

Status Protocol (PE-CSP)

Ethertype: 0x8940

Subtypes: 0x0002

01-80-C2-00-

00-03

Port Based Network Access

Protocol (PNAC 802.1X)

Ethertype: 0x888E 01-80-C2-00-

00-00

Shortest Path Bridging (SPB) LLC address = 0xFE 01-80-C2-00-

00-2E

Multiple MAC registration Pro-

tocol (MMRP)

Ethertype: 0x88F6 01-80-C2-00-

00-20
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Multiple VLAN registration

Protocol (MVRP)

Ethertype: 0x88F5 01-80-C2-00-

00-21

Multiple Stream Registration

Protocol (MSRP)

Ethertype: 0x22EA 01-80-C2-00-

00-0E

Multiple ISID Registration Pro-

tocol (MIRP)

Ethertype: 0x8929 01-80-C2-00-

00-00

Port Aggregation Control Pro-

tocol (PAgP)

Protocol type code 0x0104 01-00-0C-CC-

CC-CC

Cisco Discovery Protocol

(CDP)

OUI of 0x00000C and a protocol

ID of 0x2000

01-00-0C-CC-

CC-CC

Cisco Unidirectional Link

Detection (UDLD)

SNAP format: LLC value

0xAAAA03 Org Id 0x00000C pro-

tocol type 0x0111

01-00-0C-CC-

CC-CC

Cisco VLAN Trunking Pro-

tocol (VTP)

SNAP format: LLC value

0xAAAA03 Org Id 0x00000C pro-

tocol type 0x2003

01-00-0C-CC-

CC-CC

Cisco Dynamic Trunking Pro-

tocol (DTP)

SNAP format: LLC value

0xAAAA03 Org Id 0x00000C pro-

tocol type 0x2004

01-00-0C-CD-

CD-CD

Cisco Inter Switch Link (ISL) SNAP format: LLC value

0xAAAA03 Org Id 0x00000C

01-00-0C-00-

00-00

Per VLAN Spanning Tree

(PVST/PVST+/RPVST)

SNAP format: LLC value

0xAAAA03 Org Id 0x00000C pro-

tocol type 0x010

01-00-0C-CD-

CD-CD

Custom Frame #1 Configurable Configurable

Custom Frame #2 Configurable Configurable
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Fiber Channel

Fiber Channel Applications
Enterprises worldwide rely on complex IT infrastructures to store and maintain critical data and applications.
Storage Area Networks (SANs) have evolved to improve availability, resiliency, performance, modularity and
geographical distribution of data storage systems and Fiber Channel is an important technology for linking
SANs together.

Fiber Channel over IP
Often, IP-centric networks are used to connect SAN islands over Local Area Networks (LAN), Metropolitan
Area Networks (MAN), or Wide Area Networks (WAN). An operational IP backbone (Layer 2 or Layer 3 topo-
logy) capable of delivering the required bandwidth for Fiber Channel applications is an absolute prerequisite.
The test set equipped with Ethernet and Fiber Channel features is able to verify FCIP connections in a variety
of network configurations.

Fiber Channel over SDH/SONET
Service providers have made huge investments in SDH/SONET infrastructure over many decades, hence stor-
age over SONET/SDH networks are considered an essential part of any operator's SAN extension solution.
DWDM networks are perfect for transporting high-density, high-bandwidth SAN applications over short dis-
tances while SDH/SONET/OTN networks are often used for longer distance applications. The test set is
equipped with a strong set of features needed to verify the strategic components and network interconnects.
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Key Test Applications

Transport layer - Most customers or providers transporting Fibre Channel are not necessarily trained or con-
cerned with testing the higher protocol layers -- instead the transport groups tasked with transporting this data
across a point-to-point or ring type DWDM network are more likely to ask: Did data arrive error free or were any
bit errors encountered? Was the CRC corrupted or were any code violations experienced? Testing the trans-
port layer is crucial and normally includes the FC-0 Layer, FC-1 Layer, and parts of the FC-2 Layer where:

l FC-0 addresses the physical layer: the optical fiber, connectors, and associated optical signal para-

meters.

l FC-1 addresses the transmission protocol encoding/decoding, and special characters used for pro-

tocol management.

l FC-2 addresses the signaling protocol layer, which comprises the framing protocol and the flow con-

trol process.

The Fibre Channel option addresses all the transport layers by measuring the optical power level and sup-
porting the generation/analysis of bit errors, order sets, frame delimiters, frame transmission, and the gen-
eration of primitive sequences. User defined bytes, fixed test patterns or industry-standard PRBS patterns can
be selected and inserted into the payload field depending on the test layer. Bit error, CRC error and Code viol-
ation insertion are useful features to verify Mux/Demux equipment for error monitoring and detection.

Buffer-to-Buffer Credit Estimation - To avoid loss of frames during transmission, the Fibre Channel protocol
uses a buffer-to-buffer flow control mechanism between link partners. During the login process, the remote
node informs the local nodes as to the number of receive buffers it has available. For each frame received, the
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remote port returns a R_RDY frame to indicate that one of the receive buffers is now free - the local port in turn
increments its available credit counter by one for each R_RDY acknowledgment frame it receives. However,
as the distance between nodes or link partners increases, so does the time it takes for the transmitting node to
receive the R_RDY frame because of signal propagation delay. The standard practice for a 1Gbps Fibre Chan-
nel link is to allow 1 buffer credit for each 2km of distance.
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Setup

FC-1 BERT - Test Frame Setup

l Profile: User Defined Profile or Default setting can be used for testing.

l Test layer: FC-1 or FC-2 only. Testing at other layers is not supported.

l FC-1:Information is transmitted using an adaptive code (8B/10B or 64/66B) depending on test rate

and the encoding process results in the generation of transmission characters.

l The two types of Transmission Characters defined are data and special. Certain com-

binations of Transmission Characters, referred to as Ordered Sets, are designated by

this standard to have special meaning.

l Ordered Sets are used to identify frame boundaries, transmit primitive function

requests, and maintain proper link transmission characteristics during periods of inactiv-

ity.

FC-1 Frame Structure
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FC-2 BERT - Header Setup

l FC-2: Only FC-2 frames have a header, so these fields are not available for FC-1 frames.

l  Defines the framing rules and mechanisms for controlling the different service classes. The fol-

lowing building blocks are defined by the standard:

l Ordered Set

l Frame

l Sequence

l Exchange

l Protocol

FC-2 Frame Structure

FC-2 Header
The FC-2 header is only 24 bytes long. Header settings do not affect the transmission or reception of the FC-2
frame.

Understanding the Basic Test Channel Frame Structure
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The Fibre Channel standard defines a variable frame length consisting of 36 bytes of overhead and up to 2112
bytes of payload for a total maximum size of 2148 bytes.

l SOF and EOF

l A Start of Frame (SOF) delimiter and End of Frame (EOF) delimiter mark the beginning and

end of each Fibre Channel frame

l Available for both FC-1 and FC-2 frame formats

l Frame Header

l Is the first field of the frame content and immediately follows the SOF delimiter and is trans-

mitted on a word boundary

l Is used to control link operations and device protocol transfers as well as detect missing or out

of order frames

l Available in FC-2 frame format only

l CRC - The Cyclic Redundancy Check (CRC)

l Is a four byte field that follows the Data Field and is used to verify the data integrity of the

Frame Header and Data Field.

l SOF and EOF delimiters are not included in the CRC verification

l The CRC field is calculated on the Frame Header and Data Field prior to encoding for trans-

mission and after decoding upon reception

Frame Delimiters
A frame delimiter is an Ordered Set that immediately precedes or follows the contents of a frame. Separate
and distinct delimiters shall identify the start of a frame and the end of a frame and shall be recognized when a
single Ordered Set is detected. An Ordered set is described below.

Ordered Set
An Ordered Set is a four-character combination of data and special Transmission Characters. Ordered Sets
provide the ability to obtain bit and word synchronization that also establishes word boundary alignment. The
three types of Ordered Sets are:
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l Frame Delimiters

l (SOF) Start-of-Frame

l (EOF) End-of-Frame

l Primitive Signals

A Primitive Signal is an Ordered Set designated to have special meaning. All FC_Ports shall at a

minimum recognize R_RDY and IDLE Primitive Signals. All Primitive Signals not recognized by the

FC_Port shall be treated as an IDLE.

l Idle: Idle is a Primitive Signal transmitted on the link to indicate that link initialization is com-

plete and to maintain link synchronization

l (R_RDY) Receiver Ready

l Primitive Sequence

l (OLS) Off-line

l (NOS) Not Operational

l (LR) Link Reset

l (LRR) Link Reset Response

Start of Frame (SOF) and End of Frame (EOF) Delimiter setup
The Start-of-Frame (SOF) delimiter is an Ordered Set that immediately precedes the frame content. There are
multiple SOF delimiters defined for Sequence control. SOF indicates that a Frame will immediately follow and
indicates which class of service the Frame will use.

The value of the SOF field determines the class of service associated with the FC frame. Several Classes of
service are specified in Fiber Channel but only Classes 1,2,3 & 4 are described below. Classes 1, 2, and 3 are
topology independent, however, Classes 4 and 6 require a Fabric. If the Fabric is not present, the service is
provided as a special case of point-to-point. FC_Ports are not required to support all classes of service.
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l Class 1: Dedicated physical connection with delivery confirmation. This class of service has three

phases:

l Setting up the connection

l Transferring the information

l Closing down the connection

l Class 2: Frame multiplexed service with delivery confirmation. No dedicated connection between

the two communication parties is established. This class of service allows a stream of frames to be

sent to different destinations quickly. Class 2 also requires frame confirmations by the recipient.

l Class 3: Is sometimes called "datagram". It is "connectionless" service with the Fabric multiplexing

frames at frame boundaries, if a Fabric is present. If a Fabric is not present, this service becomes a

special case of point-to point.

l Class 4: Is a service that uses a virtual circuit established within a Fabric and between two com-

municating Nx_Ports to transmit frames to each other using a fabric-managed fractional bandwidth

allocation protocol. This service requires a Fabric.

The following SOF Service Class selections are available:

l SOF Initiate (SOFix)

A Sequence shall be initiated and identified by using SOFi1, SOFi2, SOFi3, or SOFi4 in the first

frame. SOFix is used to represent these four SOF delimiters.

l SOF_i3: Contains a code value of 0x2E indicating SOF Initiate Class 3. A SOFi3 should be

used on the first frame of a Sequence for Class 3 Service.

l SOF Normal (SOFnx)

The following delimiters identify the start of all frames other than the first frame of a Sequence based

on class of service. SOFnx is used to indicate SOFn1, SOFn2, SOFn3 and SOFn4.

l SOF_n3: Contains a code value of 0x36 indicating SOF Normal Class 3. The SOFn3 shall be

used for all frames except the first frame of a Sequence for Class 3 Service.
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l SOF Fabric (SOFf)

l SOF_f: Contains a code value of 0x28 indicating SOF Fabric. If an Nx_Port or Fx_Port

receives a Class F frame, indicated by an SOFf delimiter, it shall be discarded by the Nx_Port

or Fx_Port. The receiving Nx_Port or Fx_Port may send an R_RDY

FC-2 BERT - SOF Setup

End of Frame (EOF)
The End-of-Frame (EOF) delimiter is an Ordered Set that immediately follows the CRC and is transmitted on a
word boundary. The EOF delimiter designates the end of the frame content and is followed by Idles. There are
three categories of EOF delimiters found in the Fiber Channel standard, however the test set only supports the
first category that indicates that the frame is valid from the sender's perspective and potentially valid from the
receiver's perspective.

The following selections are available:

l EOF_t: Contains a code value of 0x42 indicating EOF Terminate. The EOFt indicates that the

Sequence associated with this SEQ_ID is complete. EOFt is used to properly close a Sequence

without error.

l EOF_n: Contains a code value of 0x41 indicating EOF Normal. The EOFn identifies the end of frame

when one of the other EOF delimiters indicating valid frame content is not required.
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FC-2 BERT - EOF Setup

Payload
The test set implements and observes "Methodologies for Jitter and Signal Quality Specification (MJSQ)". A
major goal of MJSQ is to improve the relationship between measurements on signals and receiver per-
formance in terms of bit errors. The unit transmits a "compliant pattern" which consists of a valid Fiber Channel
protocol frame (SOF, payload, CRC, EOF) containing a test pattern as the payload. Different payload selec-
tions are available depending on the Fiber Channel layer to be tested. The payload consists of 0 to 2112 bytes,
and is sent in 4 byte increments, otherwise it is considered to be a misaligned frame.

FC-1 Payload (test pattern)
Layer 1 test patterns are formatted using the 8B/10B symbol format and include the PCS layer as part of the
BER pattern.

CRPAT, CSPAT, and CJTPAT test patterns according to NCITS-TR-25-1999 and MJSQ, are designed to eval-
uate frequency fluctuations, transceiver noise and phase jumps caused by jitter and other anomalies. These
test patterns are described briefly as follows:

l CSPAT: Compliant Supply Noise Pattern

l Represents worst case power supply noise

l CRPAT: Compliant Random Pattern

l Provides broad spectral content and minimal peaking for the measurement of jitter at com-

ponent or system level

l CJTPAT: Compliant Jitter Test Pattern

l Jitter Tolerance Pattern that stresses a receiver by exposing it to extreme phase jumps

thereby stressing the clock data recovery (CDR) circuitry
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l The pattern alternates between repeating low transition density patterns and repeating high

transition density patterns

FC-2 BERT - Payload Setup

BERT Testing Tips
A BERT samples every incoming bit and looks for something that doesn't occur often. This traditional method
typically used in SONET/SDHmeasurements, can however take a very long time. For example, in a 1Gbps
Fiber Channel system, errors occur on average once every 1000 s (about 17 Min) for 1x10–12 BER, so you
would need to detect at least 10 to 100 errors before you can have confidence in your measurement. Bear in
mind that for a quick measurement, you need a test pattern that repeats frequently. A PRBS-11 sequence
(2047 bits) repeats many times a second at a 1-Gbps rate, however a PRBS-31 pattern, with 2 billion bits,
repeats only every 2 s at 1 Gbps.

A general rule of thumb is to choose a PRBS that is closest to the nature of the data you will be passing through
your network. Patterns between 211–1 and 231–1 (such as 215–1 and 223–1) offer good gradual steps in dif-
ficulty that allow you to see where networks fail, or how much margin you have beyond pass/fail thresholds.

Bit errors can affect the data frames - these frames will be re-transmitted at the request of the upper-layer pro-
tocols. If the FC link suffers a lot of bit errors, you may experience a slight performance loss. These bit errors
can also affect the Receiver Ready (R_RDY) messages. A R_RDY is never repeated, so the buffer credit is
one BB_Credit short until the link is reset.

The Fiber Channel standard allows a 1 x 10E-12 maximum error rate.

Header Setup (FC-2 only)
The FC-2 Frame Header is subdivided into the fields as shown in the diagram below.
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FC-2 Header Format

The Frame Header is the first field of the frame content and immediately follows the SOF delimiter. The Frame
Header is used to control link operations and device protocol transfers as well as detect missing or out of order
frames. The values of each field can be edited depending on network setup and test scenario. A brief descrip-
tion of each parameters is provided below.



Fiber Channel © VeEX Inc. All Rights Reserved. 213

FC-2 Header Setup

l Routing Control (R_CTL):

l The R_CTL field is a one-byte field in Word 0 Bits 31-24 that contains routing bits and inform-

ation bits to categorize the frame function.

l When used in combination with the TYPE field (Word 2, bits 31-24), it provides an FC_Port

with assistance in frame routing, data routing, or addressing.

l The R_CTL field is further subdivided into the ROUTING field (bits 31-28) and the

INFORMATION field (bits 27-24).

l D_ID Address Identifier:

l Destination Identifier is a three-byte field (Word 0, Bits 23-0) that contains the address iden-

tifier of the destination Nx_Port.

l Each Nx_Port has a native N_Port_ID that is unique within the address domain of a Fabric. It

may also represent hunt groups, domain controllers, and other servers.

l Class Specific Control (CS_CTL)/Priority:

l When bit 17 of F_CTL is set to zero, Word 1, bits 31-24 of the Frame_Header is defined as the

CS_CTL field.

l Contains management information for the class of service identified by the SOF. The meaning

of the CS_CTL field is dependent on the class of service.
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l When supported by FC_Ports, the Priority field shall be used to resolve resource contention or

to determine the order to deliver frames. The definition and use of the Priority field is class

dependent.

l S_ID Address Identifier:

l The S_ID is a three-byte field (Word 1, Bits 23-0) that contains the address identifier of the

source Nx_Port.

l Type (Data Structure Type):

l The data structure type (TYPE) is a one-byte field (Word 2, Bits 31-24) that identifies the pro-

tocol of the frame content for Data frames.

l Frame Control (F_CTL):

l The Frame Control (F_CTL) field (Word 2, Bits 23-0) is a three-byte field that contains control

information relating to the frame content such as exchange, retransmission, or sequence con-

trol. It is also used to identify the function of the

CS_CTL/P field.

l Sequence Identifier (SEQ_ID):

l The SEQ_ID is a one-byte field (Word 3, Bits 31-24) assigned by the Sequence Initiator that is

unique for a specific D_ID and S_ID pair while the Sequence is open.

l Both the Sequence Initiator and the Sequence Recipient track the status of frames within the

Sequence using fields within the Sequence_Qualifier.

l Data Field Control (DF_CTL):

l Data Field Control (DF_CTL) is a one-byte field (Word 3, Bits 23-16) that specifies the pres-

ence of optional headers at the beginning of the Data_Field for Device_Data or Video_Data

frames.

l DF_CTL bits are not meaningful on Link_Control or Basic Link Service frames.
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l Sequence count (SEQ_CNT):

l The sequence count (SEQ_CNT) is a two-byte field (Word 3, Bits 15-0) that indicates the

sequential order of Data frame transmission within a single Sequence or multiple consecutive

Sequences for the same Exchange.

l Originator Exchange_ID (OX_ID):

l The Originator Exchange_ID is a two-byte field (Word 4, Bits 31-16) that identifies the

Exchange_ID assigned by the Originator of the Exchange.

l Each Exchange is assigned an identifier unique to the Originator or Originator - Responder

pair.

l Responder Exchange_ID (RX_ID):

l The Responder Exchange_ID is a two byte field (Word 4, Bits 15-0) assigned by the Respon-

der that provides a unique, locally meaningful identifier at the Responder for an Exchange

established by an Originator and identified by an OX_ID.

l Parameter:

l The Parameter field (Word 5, Bits 31-0) has meanings based on frame type.

l For Link_Control frames, the Parameter field is used to carry information specific to the indi-

vidual Link_Control frame.

l For Data frames with the relative offset present bit set to 1, the Parameter field specifies rel-

ative offset, a four-byte field that contains the relative displacement of the first byte of the Pay-

load of the frame from the base address as specified by the ULP.

For detailed information, please visit http://www.incits.org/ and download the Fiber Channel FRAMING AND
SIGNALING-2 (FC-FS-2) standard.

http://www.incits.org/
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Test Applications

After selecting the Fiber Channel test mode, the Fiber Channel main menu appears.

Fiber Channel Main Menu

The Fiber Channel Main Menu provides shortcut application buttons for FC BERT, FC RFC 2544, FC Through-
put, and FC Loopback.

Some test capabilities or test rates may be specific to the product configuration or may require the purchase of
a software option in order to be displayed or be enabled.

To configure ports and measurements, press Setup on the main menu.



Fiber Channel © VeEX Inc. All Rights Reserved. 217

Port Configuration

Fiber Channel - Port Setup

On the Port tab, select from the following options to configure your FC port:

l Speed

o 1G (1.0625 Gbps)

o 2G (2.125 Gbps)

o 4G (4.25 Gbps)

o 8G (8.50 Gbps)

o 10G (10.52 Gbps)

l Link Protocol: Enables or Disables the PSP.

PSP is an Ordered Set transmitted repeatedly which is used to establish and maintain a link.

o Enabling the Primitive Sequence Protocol (PSP) allows link management

o Disabling the Primitive Sequence Protocol (PSP) forces the port into an Active state with no

link management
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l When a Primitive Sequence is received and recognized, a corresponding Primitive

Sequence or Idle is transmitted in response. Recognition of a Primitive Sequence

requires consecutive detection of 3 instances of the same Ordered Set. The Primitive

Sequences supported by the standard are:

l Offline (OLS)

l Not Operational (NOS)

l Link Reset (LR)

l Link Reset Response (LRR)

l Topology:Point-to-Point (P-to-P) mode is supported.

In Point-to-Point mode, only two ports are used, connected by a fiber optic link. The transmitter of

each port is connected directly to the receiver of the opposite port. There is no ambiguity in address-

ing, and there is no question of availability.

: Fibre Channel defines three topologies: 1) Point-to-Point, 2) Arbitrated Loop, and 3) Fabric;
however, Point-to-Point topology is the least complex.

l Link Management: Only available when PSP is enabled.

Initializes the Fibre Channel link and manages various states, including link failure, loss of syn-

chronization, loss of signal, or protocol violations

l B-to-B (Tx): Buffer to Buffer: Valid settings are in the range from 1 to 65535.

o Number of local port frame buffers are available to receive frames from another port.

o Determines how many frames can be sent before receiving R_RDY acknowledgments.

o “Credits”, or the number of frames, are negotiated between the n_ports and f_ports at the time

of login.

o Both ports on the link exchange values of how many frames they are willing to receive at a

time from the other port. This value becomes the other port's BB_Credit value and remains

constant as long as the ports are logged in.



Fiber Channel © VeEX Inc. All Rights Reserved. 219

o Each port also keeps track of BB_Credit_CNT.

l Transmitter: For each frame transmitted, BB_Credit_CNT is incremented by 1.

l Receiver: The value is decremented by 1 for each R_RDY Primitive Signal received

from the other port.

Fiber Channel - Measurement Setup

On the Measurement tab, select from the following options to setup your FC measurements:

l Mode: Manual or Timed

l Manual: Measurement is started (by the User) by pressing the Start button and ended when

pressing the Stop button.

l Timed: Measurement duration can be programmed in seconds, minutes, hours or days.

l Event Log: Circular or Blocked. When set to Circular, log events may be overwritten with the latest

events if the circular buffer fills up. The oldest event will be deleted so that the new event can be

added. When set to Blocked, the log will not be overwritten when buffer is full and the latest events

will not be logged.

l TX Start: Separated or Coupled. Configures how the measurements are started when in BERT and

Multiple Streams test modes.

l Separate: Independent control (Start/Stop) of the transmitter is enabled. At the start of the test

only the receiver is turned on -- the user must start the transmitter manually.
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l Coupled: Transmitter and receiver are turned on at the same time, and the Tx and Rx meas-

urements start at the same time at the start of the test.
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BERT/Throughput

Overview
The test set complies with ANSI NCITS FC-FS recommendations and has the ability to test 1, 2, 4, 8 and 10
Gigabit Fibre Channel.

l 1/2/4/8G Fiber Channel: The unit verifies the 8B/10B PCS Layer with a basic primitive set at FC-1 or

FC-2 lower layers.

l 10G Fiber Channel: The unit verifies the 64B/66B PCS Layer with a basic primitive set at FC-1 or

FC-2 lower layers.

l FC-1 Layer addresses the transmission protocol encoding, decoding, and special characters

used for protocol management

l FC-2 is the signaling protocol layer, which is made up of a framing protocol and a flow control

process +

The unit supports the generation and monitoring of: bit errors, order sets, frame delimiters, frame transmission,
and generation of primitive sequences. BERT diagnostics perform a bit-by-bit comparison to find bit errors in
the received data pattern. Error Count and Error Rate for the latest sample are displayed and maintained, as
well as totals for all samples from the test start.

The user can use a default frame header or define a custom frame header - the unit takes care of the frame/-
header setup, creates the user defined SOF and EOF delimiters and calculates the CRC error checking bytes,
which are placed within the frame. User defined bytes, fixed patterns or industry standard PRBS patterns can
be selected from drop-down menus and radio buttons and inserted into the payload field.

Testing is supplemented with the capability to perform Bit and CRC error insertion. These tests allow users to
test their own Mux demux equipment for error monitoring and detection. The test set displays the BERT test
results continuously and any anomaly is recorded in an event log which is date and time stamped. All results
can be saved and exported into ReVeal MX for analysis or customer test report generation.

Fiber Channel Layers
The Open Systems Interconnect (OSI) model breaks communications into seven layers namely, Physical,
Data Link, Network, Transport, Session, Presentation, and Application. Fibre Channel does not follow the ISO
model - instead, the protocol has been broken into five layers: FC-0, FC-1, FC-2, FC-3, and FC-4.
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OSI layers versus FC layers

l FC-0 defines the physical portions of Fibre Channel, including the media types, connectors, and the

electrical and optical characteristics needed to connect ports. This level is in the FC-PH standard.

l Signaling

l Media specifications

l Receiver/Transmitter specifications

l FC-1 defines the transmission protocol, encoding, order of word transmission, and error detection.

This level is in the FC-PH standard.

l 8B/10B character encoding (1/2/4/8G FC) or 64/66B character encoding (10G FC)

l Link maintenance
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l FC-2 defines the signaling and framing protocol, including frame layout, frame header content, and

rules for use. It also contains independent protocols such as login. This is the bulk of the FC-PH

standard.

l Frame format

l Sequence management

l Exchange management

l Flow Control

l Classes of Service

l Login/Logout

l Topologies

l Segmentation and Reassembly

Fiber Channel layers and functionality

OSI
Model

Fiber
Channel Description

Layer 2:
Data link FC-2 Similar to the MAC functionality - Fiber Channel frames are defined, addressed and

CRC are added.

Layer 1:
Physical

FC-1

FC-0
Similar to the physical layer of the OSI model - Fiber Channel adds basic flow control
functionality and ordered sets.

l FC-3 defines common services that may be available across multiple ports in a node. This level has

no standard now.

l Services for multiple ports on one node

l FC-4 defines the mapping between the lower levels of Fibre Channel, and the command sets that

use Fibre Channel.
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l Upper Layer Protocol (ULP) mapping

l Small Computer System Interface (SCSI)

l Internet Protocol (IP)

l High Performance Parallel Interface (HIPPI)

l Asynchronous Transfer Mode - Adaption Layer 5 (ATM-AAL5)

l Intelligent Peripheral Interface - 3 (IPI-3) (disk and tape)

l Single Byte Command Code Sets (SBCCS)

Setup

"Fibre Channel" versus "Fiber Channel"
Confusing naming and spelling conventions have stuck with Fibre Channel during its development. The word
“channel” in no way indicates a preference for channel protocols or environments.Even though “fibre” and
“fiber” are semantically equivalent (“fibre” is the international English spelling), “Fibre Channel” is the official
spelling for the technology.

“Fiber” has come to mean more specifically the optical (glass) media used for long-distance (up to 10 km) con-
nections.

Traffic Generation and Error Injection

Traffic Setup

l Traffic Flow: Select from Constant, Ramp, or Burst traffic flow - available selections depend on FC-

1 or FC-2

l Constant: Continuous traffic (no traffic shaping)

l Burst: Two burst bandwidths are configured with variable burst time in seconds

l Ramp: Start and stop bandwidths are configured along with the bandwidth step size and dur-

ation
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l Frame Size: Set the frame size in bytes.

l Available in FC-2 mode only

l Valid settings are 56 bytes to 2148 bytes.

l The frame length includes the SOF and EOF overhead bytes.

l Constant Bandwidth: Configure the transmit rate or bandwidth in %

l Valid settings are 1% to 100% in 0.01% increments

FC-BERT/FC-Throughput Traffic Setup

Error Injection Setup
Error injection can be performed during a test. The type of errors and error injection rate or flow are configured
in the Error Injection tab.

l Error type: Select from Bit and CRC.

l Injection Flow: Determines how the selected errors will be injected. The user can select a single

error injection, a specific count, or error rate.

l Count:When Count is selected, configure the error count via the numeric pop-up keypad.
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FC-BERT/FC-Throughput Error Injection Setup

Once the test is running, error injection can be enabled by selecting the Error Injection icon from the action
drop-down menu at the top of the screen. Press the Error Inject button to start injecting errors.

FC-1/2 Throughput - General

General tab (Throughput only)

l RTD Measurement: Enable or Disable Round Trip Delay Measurement

l SDT Measurement Trigger (>µs): Any inter-frame gap that is equivalent or greater than the con-

figured threshold will trigger the SDT measurement. This is useful if a known threshold is expected

from a given network under test. For example, if the known switchover time is 50ms, the trigger can

be set to a value slightly below 50ms to assure that the SDT is measured.
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l SDT Violation Threshold (µs): Triggers an SDT Violation event in the event log. This is helpful for

historical purposes during any given test. If the measured SDT is equivalent or greater than the con-

figured threshold an SDT Violation event is counted.

Starting Measurements

l Start: Starts the measurement.

l Laser : Can be turned On or Off to make adjustments to the fiber patch cord.

l TX ON/OFF: Activates the Transmitter to initiate the BER measurement.

Results

Summary

l Line Rate: Indicates the transmitted and received bit rate

l 1.0625 Gbps, 2.125 Gbps, 4.25 Gbps, 8.50Gbps, or 10.52 Gbps, 14.025G, 16G displayed in

Mbps

l Framed Rate: Total number of frames including overhead of any type per second (Mbytes)

l Data rate: Total count of frames with payload data per second (Mbytes)

l Utilization: Bandwidth utilization in %

l # of Bytes: Number of bytes transmitted versus bytes received.

l BB Credits Used: Number of Buffer Credits used.

Summary (Throughput only)

l Total Frames: Total number of frames transmitted versus frames received

l Bad Frames: Number of frames transmitted but not received.
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FC - BERT - Summary

FC - Throughput - Summary

Errors

Current and Total values for:

l Bits: Number of bits received

l BER: Bit error ratio based on PRBS received or ratio of payload bit errors to total received payload

bits

l Symbol: Symbol error or Code Violation is a bit error or disparity error occurring in a primitive

sequence or Ordered Set
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l FCS/CRC: Number of frames with either a bad or missing CRC or Frame Check Sequence

l Oversize: Number of Oversize frames received (> 2112 bytes)

l Undersize: Number of Undersize frames received (< 28 bytes)

Errors (Throughput only)

l Frame Loss: Number of frames lost

l Frame Loss (%): Percentage of frames lost

l OOS: Number of out-of-sequence frames received

BERT - Errors

Throughput - Errors (Page 1)
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Alarms
Current and Total values for:

l LOS:Number of times the Link has transitioned to a Loss of Signal state in the measurement interval. Generally loss of

optical signal.

l LOSync: Number of times the Link has transitioned to a Loss of Sync state in the measurement period

l Pattern Loss: Number of times test pattern or test sequence was lost

l Service Disruption

l Current: Current disruption in ms

l Total: Total measurement period

l Last: Last disruption measurement time

l Min/Max: Minimum and Maximum disruption time

l No. of Occurrences: A count of the disruption events over the measurement period

FC-BERT/FC-Throughput - Alarms

Service Disruption Test (SDT) (Throughput only)
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l Total: Total cumulative service disruption for the duration of the test.

l Last: Last SDT measured during the test.

l Min/Max: Minimum and maximum SDT measured during the test.

l No. of Occurrences: Number of service disruption events (SDTs).

l No. of SDT Violations: Number of instances the SDT threshold was met or exceeded.

FC-Throughput Results - SDT

Events
Time stamped event table:

l Time: Indicates when the test was started, an anomaly occurred or a test was stopped

l Event/Event Type: Indicates type of anomaly

l # of Events: Indicates the number of times the event occurred

l Test: Indicates the test mode
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Throughput - Events

Traffic Distribution Overview
Graphical representation of:

l Frame type: Test frames in BER mode

l Traffic type: Class of service set by the SOF delimiter

l Frame size:

l FC-1 mode - the frame size is determined by the test sequence being used

l FC-2 mode - the frame size corresponds to the frame size configured in the traffic menu

FC-BERT/FC-Throughput - Traffic Summary
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Traffic Distribution Details - Frames

l RX (Received) Frames

l Total: Total number of frames received

l Test: Number of test frames received

l Non-Test: Number of non-test frames received

l TX (Transmitted) Frames

l Total: Number of test frames transmitted

l Flow Control: Flow control is the FC-2 control process to pace the flow of frames between Nx_

Ports, an Nx_Port and the Fabric and within the Fabric to prevent overrun at the receiver.

l Flow control is managed between Nx_Ports (end-to-end) and between FC_Ports (buffer-to-buf-

fer). Flow control management has variations dependent upon the service class, however

Class 3 uses only buffer-to-buffer flow control.

l RR-RDY: For Class 3 frames transmitted and received, a R_RDY is issued when a receive buffer is

available.

Memory or “buffers” to temporarily store frames as they arrive and until they are assembled in
sequence, and delivered to the upper layer protocol. Buffer Credits are the number of frames a
port can store. To track the number of frames transmitted for which R_RDY responses are out-
standing, the transmitting FC_Port uses the BB_Credit_CNT.

l BB Credits Used: The number of unacknowledged or outstanding frames awaiting R_RDY

responses from the directly attached FC_Port.

l BB Credits Available: The number of frames transmitted and received R_RDY responses from the

directly attached FC_Port.
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FC-BERT/FC-Throughput - Frame Distribution

Traffic Distribution - Traffic Type
Fibre Channel supports three classes of services, and a fourth which is a combination of classes 1 and 2.

Similar to ATM, different classes allow Fibre Channel to support a variety of communication needs.

l Class 1: Provides a circuit-emulation service for time-sensitive applications such as video tele-

conferencing.

l Designed for dedicated, non-bursty links between supercomputers. Class 1 traffic is circuit-

switched.

l Class 2: Provides guaranteed delivery for connectionless traffic.

l Class 2 traffic is switched on each frame rather than on a connection. An acknowledgment

from the destination provides an end-to-end guarantee of delivery.

l Class 3: Offers a best-effort connectionless service.

l Class 3 is similar to Class 2, except that no guarantee is given for delivery.



Fiber Channel © VeEX Inc. All Rights Reserved. 235

FC-BERT/FC-Throughput - Traffic Type Distribution

Frame Size Distribution
Indicates the number and percentage of different frame sizes received during the test period.

FC-BERT/FC-Throughput - Frame Size Distribution

Delay
Frame Arrival Delay or Latency is the round-trip delay experienced by a frame as it traverses the fiber link or
network. The difference between the transmitted time and received time is the measured delay.

Indicates the Current, Minimum, Maximum, and Average frame arrival delay during the test period. 

Delay (Throughput only)

Current, Minimum, Maximum, and Average Round-Trip Delay during the test period is also displayed.
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FC - Throughput - Delay

Frame Rate Summary
Graphical representation of the Frame rates and Data rates.

FC-BERT/FC-Throughput - Frame Rate Summary

Frame Rate Details
Tabular representation of the Transmitted and Received frames and the corresponding Data Rates in Mbps.
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FC-BERT/FC-Throughput - Frame Rate Details

Signal
Level (Page 1)
The Signal tab displays the Level and Frequency screen. Page 1 displays the level measurement Loss of Sig-
nal (LOS), and the Saturation level for optical signals is shown graphically, including the level measurement in
dBm.

FC-BERT/FC-Throughput Signal - Level (Page 1)

Optical Information (Page 2)
Page 2 displays the Optical module XFP information which includes Vendor name, Part number, and Optical
Wavelength.
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FC-BERT/FC-Throughput Signal - Optical Information (Page 2)

Frequency (Page 3)
Page 3 displays the Frequency information which includes:

l Current [bps]: Indicates current frequency level.

l Offset [ppm]: Indicates the frequency offset.

l Min [ppm]: Indicates the minimum frequency detected.

l Max [ppm]: Indicates the maximum frequency detected.
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RFC 2544

The RFC 2544 Ethernet test suite is adapted to Fiber Channel circuits to verify 1Gbps, 2Gbps, 4Gbps, 8Gbps
and 10Gbps SAN networks. The automated RFC 2544 test routine/analysis ensures repeatable installations:

l Check buffer parameters needed to achieve desired Service Level Agreement (SLA)

l Determine optimum buffer size - Capacity versus link speed

l Determine minimum buffer credits for selected throughput for each frame length

l Measuring throughput at various buffer credit sizes to check link quality

The test methodology is the same as for Ethernet testing. Refer to the "RFC 2544 Conformance Testing" on
page 69 section for details.
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Loopback
The Loopback function can be found on the Fiber Channel Home menu.

FC-1/2 Manual Loopback Setup

Modes of operation: Manual and Responder (future)
Mode (FC layer): FC-1 or FC-2 Layer loopbacks are supported. In FC-2 mode, the destination and source IDs
(D_ID and S_ID) are swapped including any other relevant Header fields (e.g., OX_ID, RX_ID, etc.).

To enable the loopback, press Start. Once the loopback is enabled, a message appears indicating that the
loopback is active.
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Platform Functions

Tools tab

Depending on the test set, it may be necessary to tap the Test Application icon to access the Platform Set-

tings menu. Tap to reveal the following functions common to all VeEX test sets:

l Utilities (" Utilities Overview" on the facing page)

l Files ("File Manager" on page 279)

l Tools ("Fiber Tools Overview" on page 286)
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Utilities

Utilities Overview

The Utilities tab provides settings for the global parameters of the test set or platform (system settings).

Utilities/Settings Menu
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About/Software Options

This section provides information about the software platform version, serial number, and as well other inform-
ation relevant to the test set, which may be required when contacting Customer Support. The tab provides a list
of software licenses (optional test features) currently loaded in the test set.

Activating New Licenses: Features and options marked as ‘Expired’ or "Disabled" (not currently loaded into
the test set) can be purchased at any time and activated via VeExpress using an internet connection. Upon
order confirmation, connect the test set to the internet via LAN or Wi-Fi, go to >Utilities >VeExpress and press
the Check button. The test set will download all newly added features and options from VeExpress servers and
install them automatically.

If company policy doesn’t allow access to the public internet or the test sets are used within a secured network,
request License Keys for manual activation. License keys must be requested at the time new options are pur-
chased. To activate new features, tap on the expired item and enter the Activation Code received from VeEX,
VeEX partner or manager. Press Activate to complete the licensing process. Each activation code is specific
to a test set and a feature. If multiple features are ordered, individual activation codes will be sent for each of
them. Manually activated features are specific to a test set and can’t be shared with other test sets.
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Touch Screen Calibration

Screen calibration can be accessed from Utilities > Settings > Touch Screen Calibration.

Press the Save and Home buttons simultaneously, until you hear a tone (beep), quickly press the
LeftSideButton+ + combination to confirm. Then the touch screen calibration procedure starts.

Once the touch screen calibration sequence has been started, it must be completed. Accur-
ately touch the calibration points with the tip of the stylus.
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If the above procedures do not fix the touch screen issues, go to the VeEX website's Contact
Us page, select [√] Customer Service/Tech Support, then provide the Product Type, Serial Number
and a brief description of the behavior being experienced. If it is related to colder ambient tem-
peratures, please state the approximate temperatures.

https://www.veexinc.com/company/contactus
https://www.veexinc.com/company/contactus
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Standby Mode

Standby Mode Message

Standby Mode puts the unit to sleep, so that it wakes up faster than pressing Power to turn on the unit. To
enter standby mode, press and hold the Home key for 3 seconds until the unit beeps, then tap YES. The
screen will be off, but the power LED will blink. Press Home to view battery life and standby mode run time.
Pressing and holding Home for 3 seconds again will return the unit to normal operation.
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Bluetooth/WiFi Wiz

Bluetooth

Built-in Bluetooth support offers wireless connectivity up to 10 meters (30 feet), providing an untethered con-
nection between the tester and other Bluetooth compatible devices such as a PCs and smart phones, enabling
users to transfer test results and other files.

A Bluetooth icon displayed on screen indicates the Bluetooth connectivity status. A grey icon indicates no
Bluetooth connectivity, while a green icon indicates a successful Bluetooth connection.

Bluetooth Adaptors - Compatibility Not all Bluetooth adaptors on the market are supported. Please
use adaptors that have been tested and supplied by VeEX only to ensure compatibility and correct operation.

Devices
Bluetooth details will be displayed including the MAC address of the device and the last 4 digits of the test set
serial #. The last 4 digits of the test set will be the pairing code between the unit and the external device.

Bluetooth Devices
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Bluetooth - Scan

Bluetooth - Connection - Passcode

Bluetooth Setup

1. Press Scan to check for available Bluetooth devices. Once scanning is complete, a list of discovered

Bluetooth devices will be listed. Please ensure the peripheral device is set to Discoverable during

Scanning and Pairing operation.

2. Press Pair BT to begin the pairing process. During the pairing operation, you will be prompted to

enter a code on the peripheral device (PC or Mobile Phone) in order to pair successfully. Enter the

last 4 digits of the test set's serial number as shown in the Connection tab.

Bluetooth_Scan.png
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3. Once paired, click the Services button at the bottom of the screen to check the service attributes. To

upload test results via Bluetooth, full data upload service will be required.
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WiFi Wiz

Built-in web browser remote control is available whenWiFi is enabled.

Passwords are case sensitive. If the wrong network key is entered, the test set will still connect to the
Access Point but will not be able to connect to the web or perform the Ping test.

TheWiFi Wiz function can be used to provide WiFi connectivity to the unit. Depending on the unit’s model, it
supports 802.11 b/g/n (2.4 GHz frequency band) connectivity or 802.11 a/b/g/n/ac (2.4 GHz and 5 GHz fre-
quency bands) connectivity. Refer to the unit’s specification sheet for details.

The WiFi Wiz function supports:

l WEP, WPA, WPA2 Encryption

l Scanning

l SSID broadcasting and report

l Signal Strength

l IP Connection and Ping Test
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WiFi Procedure

1. To access the WiFi option, tap Tools, and then tap Bluetooth/WiFi.

2. Select theWiFi Wiz tab.

3. Tap Scan to scan the list of available WiFi APs.

AP List

The following information is displayed for each AP:

l SSID name of the AP

l BSSID (MAC address) of the AP

l AP's radio channel number

l Lock symbol indicates if security is set on the AP (WEP, WPA or WPA2).

When the AP is unsecured, no lock symbol is displayed.

l Signal strength of the AP

4. Select one of the Access Points (AP) to start a connection. If the AP is locked, a network key is

required to complete the connection. The key can either be 10 characters or 26 characters. Once

selected, an Edit Settings function key appears.

If the wrong network key is entered, the test set will still connect to the Access Point, but will not

be able to connect to the web or perform the Ping test.

5. Tap Edit Settings or Connect AP to change the Encryption Type and enter the WiFi Key.

l Encryption Type: Supported encryption types include WEP, WPA, and WPA2.

l Password/Key: Security phrase or password necessary to access SSID and network. Tap the

Password field to enter the AP password on the pop-up keypad.
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l ASCII formatting supported

l The password/phrase can be hidden (Global Settings > Show Password > Yes/No).

Passwords are case sensitive.

6. Tap Apply after selecting the Encryption Type and entering the key/password. The Connect AP but-

ton will change to Disc. AP upon successful connection and the Connect Net key will appear.

WiFi Wiz - AP Encryption Settings

Connect
The Setup tab displays the Profile, ESSID, Encryption Type and Password.

WiFi Wiz Connection Setup



254 © VeEX Inc. All Rights Reserved. Platform Functions

Status
The Status Tab displays the following information on the connection:

l Connection Status

l ESSiD: Name connected to

l BSSiD: MAC address of wireless router/device connected to

l Channel:WiFi Channel # connected to

l Encryption: Encryption type

l Mode

l Signal:

l Radio signal level (dBm)

l Link quality score

WiFi Wiz Connection Status

After a successful connection to the Access Point, tap Connect IP to obtain an IP address and access the addi-
tional IP tests like Ping, Trace Route etc.



Platform Functions © VeEX Inc. All Rights Reserved. 255

WiFi Wiz Connect IP

AP Mode

In AP Mode, the unit emulates a WiFi access point/DHCP server and allowsWiFi Clients (PC/Phone/Tablet) to
connect to the unit.

l Mode: Auto, Manual

l Auto mode uses the default SSID and IP range

l In Manual mode, the user can configure AP SSIDs and the IP range used by the DHCP server

l SSID: Displays the default SSID or the manually configured SSID used by the AP

l IP Address: Displays the default or manually configured IP address range used by the AP

Press Enable to enable AP Mode. After pressing enable, the test set will broadcast its SSID, which any WiFi cli-
ent device can connect to.
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LAN (USB OTG Adapter)

The LAN port, also known as Management Port, is used by the test platform functions, to communicate with
remote clients, Internet, cloud applications and run some basic connectivity tests. Network parameters must be
configured prior to performing any connection dependent measurements. An IP connection needs to be estab-
lished in order to perform a Ping or Trace Route test. An (optional) external USB OTG to 10/100BASE-T
adapter is required for LAN connection.

You can access the management port configuration on the Tools > LAN (USB adapt)menu.

Setup

Network configuration settings are available in the Setup menu.

Setup



Platform Functions © VeEX Inc. All Rights Reserved. 257

By default, the IP configuration is set to DHCP and the unit will automatically attempt to connect. Additional
fields will vary depending on Static or DHCP connection:

l Profile: Default, Delete, Save, Save as..., Default, or Last configuration

l IP Address: Select from Static or DHCP

l Static: If Static is selected, enter the Local IP, Gateway address (if Gateway and DNS are set

to Enable), and Subnet. All Static fields can be filled by tapping on the section to access an

alphanumeric keypad.

l DHCP: If DHCP is selected, the unit will obtain IP address parameters from the DHCP server

l Local IP: IP address of the test set

l Subnet: Enter the subnet mask

l Gateway and DNS: ON or OFF

l ON: If enabled, enter the IP address of the Gateway and DNS server in Static mode, or use

the IP address provided by the DHCP server in DHCP mode

If DNS is set to Primary or Primary & Secondary, a DNS IP is required in order to use the

URL as a destination.

l OFF: If disabled, no Gateway or DNS server will be used for the tests

Enter all parameters then press Connect to start the test.

IP Connection Status

Ensure the Status is PASS before continuing with any IP tests. If the connection fails, go back to the setup
screen to verify that the parameters are entered correctly. Verify that the Ethernet cable is properly connected
on the management port on the left hand side of the unit.
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Status

l DHCP: PASS indicates that an IP address has successfully been assigned.

l IP: PASS indicates that the IP address assigned has been verified to be unique in the network.

l Gateway: PASS indicates that the gateway IP address is valid.

l DNS: PASS indicates that the DNS IP address is valid.

Ping Testing

The Ping Result provides the number of Sent, Received, Unreach, Missing, and the Round Trip delay.

Ping is a popular computer network tool used to test whether a particular host is reachable across an IP net-
work. A ping is performed by sending an echo request or ICMP (Internet Control Message Protocol) to the echo
response replies.

Ping Setup
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Ping Setup

l Profile: Delete, Save, Save as..., or Default.

l Destination: Press the drop -down menu and enter the destination IP address or URL to ping.

l Number of Pings: Enter the number of ping attempts (up to 10000) that will be performed to reach

the network device.

If Continuous Ping is selected, the user is not required to enter the number of pings. The test

set will continuously ping the target host until the user presses Stop.

l Length: Enter the length of the ICMP echo request packet transmitted.

l Ping/Sec: Enter the Ping repetition rate (Ping/second).

l Time Out: Time-to-Live (TTL) in milliseconds. Enter the maximum time allowed (in ms, up to 99999

ms) between an ICMP ping and echo response.

Once the parameters are configured, press Start to begin the test.

Ping Results

Pressing Ping will take you to the Result tab and start the Ping test.

Ping Result

l Destination: Indicates the destination IP address.

l Ping status: In Progress, PASS, or FAIL.
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l Sent, Received, Unreach, Missing: Number of pings sent, received, unreached or missing. A Ping

is counted missing if no response is received before timeout. A Ping is counted unreached if an echo

response is received with host unreachable set.

l  PING also estimates the round-trip time in milliseconds.

l Current: The current time for a Ping request to be answered.

l Average: The average time recorded for a Ping request to be answered.

l Max: The maximum time recorded for a Ping request to be answered.

l Min: The minimum time recorded for a Ping request to be answered.

Trace Route

Trace Route is a common method used to find the route to the destination IP address or URL. It is often used to
identify routing problems and unreachable destinations. All the remote IP addresses and their response times
are displayed indicating possible network congestion points.

Trace Route - Setup

Trace Route Setup

The following setup selections are available:

l Profile: Delete, Save, Save as..., Default. Select Default to recall a trace route file or create a new

test

l Destination: Enter the IP address or URL of the network device to be detected
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l Time Out: Enter the maximum time allowed between an ICMP echo and response at each hop

l Max Hop: Enter the maximum number of network devices the packet is allowed to transit

Once the parameters are configured, press Start to begin the test.

Trace Route - Results

Results

l Hop: Order of the routers on the route

l TTL: Time to reach each router on the route

l Address: Address of each router on the route

If there is no response from a particular hop, an asterisk will be displayed.
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Backlight

This section provides backlight control of the unit. There are two intensity settings:

1. Battery power and

2. AC power.

On Battery Power

l Select a timer to turn off the backlight if the unit is not in use. This function helps improve the battery

autonomy and preserve LCD life.

l To enable the timer, check "Turn off backlight if device is not used for" and with the drop-down menu,

adjust the duration of the idle time before the backlight is turned off.

l Once the timer is active and the backlight turned off, any action on the test set (touch screen,

keypad) will turn on the backlight again.

Backlight - Battery Power

Similar settings can be applied for when the test set is operating on AC Power.
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Brightness

Select the brightness level for Battery and AC operation modes.

Backlight - Brightness
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Global Settings

Utility Settings - General Setting
General Setting

l Language: An alternative language for the user interface (if available). The device must be rebooted

to fully activate the new language.

l Show Password: Hides/unhides username and password information associated with FTP and

related IP functions.

l User Interface: The USA user interface version presents SONET/DSn application-oriented menus,

while the International setting is more open to all settings.

l WiFi Auto Connect: After successfully connecting to a WiFi access point, the unit will attempt to

automatically connect to the same AP after the unit is turned off and turned back on.

l Auto Color Scheme:Sets the color scheme for the GUI.

l OTG Port Mode: Configures how the micro-B USB port will appear to any USB device connected to

it via an USB on-the-go (OTG) cable. Later models may detect and configure the OTG port to host or

device mode automatically.

l Host: Enables the micro-B USB port to connect with USB devices, dongles, or accessories,

such as a USB memory stick or Fiberscope. USB devices (dongles) will not be recognized if

the OTG port is not set to Host mode.
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l Device:Enables the test set's micro-B USB port to connect directly with a Windows® PC and

act as a storage device (like a memory stick), for the Share Results function.

l Telnet/SSH: Allow or disallow telnet connection to the unit (e.g., remote terminals, Customer Sup-

port troubleshooting, CLI or automation via scripts).

l Share Results:Enables direct transfer of saved results from a unit to a Windows PC. To directly

transfer files, connect the unit to a PC via an OTG cable, set the OTG port to Device mode and turn

Shared Results ON. In this mode, all new saved test results are copied to a shared partition that the

PC can see as a drive.

If Share Results is turned OFF, results are saved to the internal partition of the unit and can only
be transferred to a USB memory stick using the "USB Memory Browser" on page 283 in the File
Manager . To directly transfer saved files to a PC, refer to the Share Results function.

l NTP Time Service: Turn ON to allow the test unit periodically to obtain the current time from a pub-

lic time server. Whenever the test set is connected to the Internet, the time will be updated.

If R-Server is used, the time service option can be made unavailable by the R-Server administrator. This
ensures that all test sets have the same time, which is set by the R-Server.

Storage Setting

Storage Settings are not currently supported for OTDR, OPM, and Fiberscope results.

l File Name Prefix: Tap on the box to enter the file name prefix using the pop up alphanumeric

keypad. Not used for OTDR filenaming.

l Profile Deleting: Auto Delete or Prompt before deleting profile.

l Profile Saving: Auto Overwrite or Prompt before saving profile.

l Result Saving: Manual or Prompt before saving results.

l Advanced Saving: Turn ON to add extra information to the results file to be uploaded to a cent-

ralized R-Server. Requires Advanced Management Option..
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Date and Time

This screen allows the date, time and time zone to be set. Daylight Daylight Savings Time (DST) is enabled
automatically.

Date Setup

Using NTP Server
For automatic time of day (ToD) synchronization, go to System Tools >Utilities >Settings >Global >Gen-
eral Settings, and enable the NTP Time Services field by selecting a synchronization period (e.g., 1 hour).
Click here for a list of local, regional and global public NTP servers.

An internet connection (WiFi or LAN) is required to reach the selected public or private NTP server.

https://kb.veexinc.com/en/knowledge/where-can-i-get-ntp-sever-url-addresses
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Go to System Tools >Utilities >Settings >Date & Time, to manually set the date, time and time zone. Then,
tap Apply.

To enable daylight saving time (DST), manually select a neighboring time zone with a +1:00 relative to
the standard time zone of the current location. Set it back to the standard time zone offset when DST ends.
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Power

This section provides information about current power source and information about the battery's charge level
and estimated autonomy (under current load conditions) . Tap the battery icon on the top bar to bring battery
charge and estimated autonomy information.

Utility Settings - Battery Power
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Remote Access

There are different ways to control or access the test set and the information it contains, from a local (LAN) or
remote (WAN) connected PC.

The EZ Remote service provides public registration servers to help users and test sets establish remote
sessions, without having to get IT departments involved. It is considered a convenient on-demand service, for
quick/temporary collaboration tasks. It should not be used for long-term applications (VeEX offers other remote
tools for long-term applications). Refer to "EZ Remote" on page 272 for more information.

After accessing the test set remotely, a tab will open up for each selection made, allowing for quick access to
each function.

Profiles

Test Profiles are configurations saved by the user that can be retrieved and reapplied to the test set. For
example, commonly used configurations and test limits/threshold can be saved as test profiles, for different
types of services.

Manual

The feature provides access to the user manual that is built into the test set. In this application, the use of a
local copy of the PDF file is recommended as the PDF client in the local computer is most likely faster than
accessing the remote one and may offer better tools and function, including search capabilities. User manuals
can be downloaded from the products’ page at www.veexinc.com.

Results

Results list all the test results files currently stored in the remote test set. Users can View, Rename and Delete
files stored in the remote test set, as well as Download selected files to the local computer or convert them to
PDF and download.

To open a test results file, select it from the list and tap on View.

https://www.veexinc.com/en-us/
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Files can be downloaded by clicking on Download (original file format) or PDF.

Screen Shots

Pictures (PNG) taken of the screen can be accessed from this link and sub-tab. Pictures can be viewed or
downloaded to the local computer.

Screen captures can be made using the Lock button (Ï) on the test set or from the remote computer, using the
links provided or the respective F-key on the computer’s keyboard. The screen capture function can be
enabled in >Utilities >Settings >Global >Save Settings.

Remote Control (Screen Mirroring)

It is similar to using VNC, but in this case no VNC client installation is required. It uses standard Java-based
web browser as a client. It mirrors the screen, mouse inputs and the rubber buttons available in the front panel
of the test set.

1. On the test set, select the Remote Access option and enter the following information:

l VNC Service: Enable or disable the remote access through remote web-browser clients run-

ning on PCs, Macs or certain tablets. The web browser must support Java (tm)
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l Web Super User Password: Defines the password for users allowed to control the test set

via standard web browser clients

l Web Regular User Password: Defines the password given to users who are only allowed to

view the test set current screen via standard web browser clients, but not make any changes

to test or test set.

2. In a web browser, enter the test set IP address. To locate the test set local IP address, refer to "WiFi

Wiz" on page 251.

3. Click vnc-home.html and enter the Super/Regular password when prompted for a password. Use

the buttons and icons on the right to navigate the test set remotely.
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EZ Remote

The EZ Remote functionality allows users to quickly and securely connect to VeEX test sets all over the world,
without the need for VPN, port forwarding or public IP addresses. This VeEX hosted service and user interface
take care of all the complex tasks required, and present users with a simple application. Connect online any-
time anywhere with any computer, tablet or smartphone, using standard web browser clients for screen-shar-
ing, remote control and access to test results. Use it for remote control, collaboration, technical support or
training purposes.

The basic EZ Remote service is offered by VeEX free of charge. It provides public registration servers to help
users and test sets establish remote sessions, without having to get IT departments involved. All you need is
internet access for the test set and a remote user. Feature location and functionality may vary from product to
product.

VeEX’s EZ Remote provides:

l Remote Control functionality to give users full control of remote test sets (screen mirroring and con-

trol).

l Remote Access functionality allows users to View, Download, Rename, Delete, Export and Convert

results (PDF).

EZ Remote is considered a convenient on-demand service, for quick/temporary collaboration tasks. It
should not be used for long-term applications (VeEX offers other remote tools for long-term applications).

Initiate an EZ Remote Session from the Test Set

1. Use the IP Tool to connect the test set to a LAN using the RJ45 Ethernet management port (or

using the micro-B USB OTG to 100BASE-T adapter), located on the side of the unit (recommended),

or useWiFi Wiz to connect to a WLAN (using built-in Wi-Fi or a compatible external USB dongle).

Make sure the test set gets a local IP address and that the LAN/WLAN provides access to the public

internet (web).
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2. Go to >Utilities >Settings >More >EZ Remote.

3. On the EZ Remote screen, set EZ Remote to Enable, confirm the URL is ezremote.veexinc.net

(without www.), and tap on Apply to connect and establish a session with the EZ Remote server.
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4. Provide the resulting URL and Session ID to the intended remote user.

5. You may continue to use the test set until a remote user logs in, then both will share control over the

unit. Make sure the test set remains connected to the LAN/WLAN/Internet and that the EZ remote

session indicator at the bottom of the screen stays green.

6. When finished, use the Stop button to terminate the EZ Remote session and disconnect from the

server.
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Connect to the Remote Test Set from a Computer, Tablet or Phone

Establish a Remote Access Connection
EZ Remote provides two types of services:

l Remote Control (screen and mouse/touch mirroring) to operate a test set from a different location.

l Remote Platform Access to access information stored in the remote test set, such as Test Results,

Profiles, User Manual, Screen Captures (screen shots), information about the test set (Home) and

its local IP address.

Although multiple users could simultaneously log-in to the same test set, they would be sharing the same
mirrored GUI image and mouse control. This is not recommended since it is equivalent to having multiple users
trying to operate one test set at the same time (also known as “mouse fight”).  Nonetheless, it may be effective
for training purposes with one or two extra users.

1. From a PC, Mac, Tablet or Smartphone launch an industry-standard Web Browser application and

enter the URL http://ezremote.veexinc.net (without the www.). Enable pop-ups for your browser and

be sure to authorize access to the site, if confirmation is requested by the browser or OS.

2. Enter the Session ID provided, making sure not to confuse zeroes (0) with Os. Click Search to find

the target test set and stablish a peer-to-peer connection.

3. Once verified and connected, wait for the remote user interface to refresh. This may take a few

seconds.

http://ezremote.veexinc.net/#/
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4. Depending on the type of test set used, shortcut buttons may be provided below the mirrored screen,

allowing access to functions provided by physical buttons on the instrument, such as Settings,

Home, Save Test results. Click or tap on the shortcut to activate it.

5. Once the remote GUI appears, you can use the Remote Control tab to operate the test set in the

same way you would control a local unit from its touch screen.
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Save Test Results

To save the results of a test, from the remote computer, press the Save button below the screen image. Then
use the pop-up keypad and/or the PC keyboard to enter the file name and add any extra details (if Advanced
Save is enabled).

Access Remote Test Result Files

The Remote Platform Access tab provides links to access test results, test profiles, screen shots, the user
manual and other information stored in the test set.

After accessing the test set remotely, a tab will open up for each selection made, allowing for quick access to
each function.

Profiles

Test Profiles are configurations saved by the user that can be retrieved and reapplied to the test set. For
example, commonly used configurations and test limits/threshold can be saved as test profiles, for different
types of services.

Manual

The feature provides access to the user manual that is built into the test set. In this application, the use of a
local copy of the PDF file is recommended as the PDF client in the local computer is most likely faster than
accessing the remote one and may offer better tools and function, including search capabilities. User manuals
can be downloaded from the products’ page at www.veexinc.com.

Results

Results list all the test results files currently stored in the remote test set. Users can View, Rename and Delete
files stored in the remote test set, as well as Download selected files to the local computer or convert them to
PDF and download.

To open a test results file, select it from the list and tap on View.

https://www.veexinc.com/en-us/
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Files can be downloaded by clicking on Download (original file format) or PDF.

Screen Shots

Pictures (PNG) taken of the screen can be accessed from this link and sub-tab. Pictures can be viewed or
downloaded to the local computer.

Screen captures can be made using the Lock button (Ï) on the test set or from the remote computer, using the
links provided or the respective F-key on the computer’s keyboard. The screen capture function can be
enabled in >Utilities >Settings >Global >Save Settings.
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Files

File Manager

File Manager, Advanced

The File Manager (Utilities > Files > Saved) displays files stored in the test set, including profiles, test results,
and screen shots. When managing files, use the check box to select the desired file(s). The File Man-
agement system offers backup To USB and restore From USB functions to preserve user data.

Tests Results/Reports

To access the test results stored in the test set:

1. Press , then press on the top left of the screen.

2. Select Files > Saved . The File Management screen is displayed.

3. Select the desired results file, then press to open the test report.

To navigate the test results report, use the links in its Table of Contents and the right rocker switch to scroll Up
and Down.

Working with Saved Results, Profiles, Images

Access the File Manager by selecting Files> Saved in the left panel of the platform menu. Files can be viewed,
edited, or exported to a USB dongle, Windows PC, SD card, or a PDF file (using a FAT32 USBMemory stick).

Use the check box to select the desired file(s) or choose all files by selecting the check box in the top
header row.
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Table Sorting
Tap a column header to sort the table in ascending or descending order by the column selected.

Tap the filter icon in the column header row to filter for specific test results stored on the unit.

At the top of the screen, tap the green buttons for view options.

Displays full filename.
Select columns to make visible.

Displays all records.

Search for specific file(s) using advanced search terms.

Selecting columns to make visible

Viewing and Managing Files

Use the options at the bottom of the screen to manage selected file(s).

Opens the selected test report (one).

Closes the current test report and returns to File Manager.

Exits the File Manager.

Deletes all unlocked test reports that are selected with checkmarks.

Renames the selected test report (one).

Unlocks or Locks test reports. Locked reports are identified by a red padlock icon.
Locked test reports cannot be deleted or renamed.
Generates a PDF copy of the test report and stores it in an attached USBmemory
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stick (required) for distribution (e.g., via email).
Imports (restores) all test results, test profiles and screenshots stored in an attached
USBMemory Stick. The included On-The-Go (OTG) micro-B USB to USB-A
adapter cable is required for the USB memory stick.
Exports (backup) all selected test results, test profiles and screenshots stored to an
attached USBMemory Stick. The included On-The-Go (OTG) micro-B USB to USB-
A adapter cable is required for the USB memory stick.
Transfers selected test results, test profiles and screenshot files to a paired
Bluetooth® smartphone, tablet or PC.
Loads the selected test profile, if supported.

Loads the selected test profile and runs the test, if supported.

Enabling To USB and From USB Functions

1. Insert a USB Memory stick (FAT32 file format) into a USB port on the side of the unit.

2. Wait for the USB memory to be detected (the folder icon at the top-right corner will change to a green

USB memory icon ). After the unit detects the USB memory stick, files can be downloaded to or

restored from USB. See "USB Memory Browser" on page 283 for details about using a USB memory

stick with the test set.

Downloading Files To USB

1. Select the test results, test profiles, screen capture files to be saved. For a full backup, tap the check

box in the top header row to select all files.

2.
At the bottom of the screen, tap the To USB button to initiate the file transfer procedure

and wait for the progress bar to finish. Original files won’t be deleted from the test set. Each file is

saved into it's own folder using the "MyVeEX" tree directory format.

3. When all files have been copied to the USB, tap the folder icon (top-right corner) and or tap

to make sure all cached data is transferred to the USB drive, especially when transferring

small files.  
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Exporting Files to Mobile Devices via Bluetooth

Applies to test sets with optional built-in Bluetooth or compatible Bluetooth USB dongle attached.

1. Select the test results, test profiles, screen capture files to be exported. For a full backup, tap the

check box in the top header row to select all files.

2.
At the bottom of the screen, tap BT . The test set scans for Bluetooth devices automatically.

3. After pairing the device, tap Send to export the selected files. Original files won’t be deleted from the

test set. Each file is saved into it's own folder using the "MyVeEX" tree directory format.

Exporting Results to PDF

1. Select the test result files to be exported.

2.
At the bottom of the screen, tap PDF . A "PDF file will be generated to USB disk" message

appears.

3. Tap Yes.
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USB Memory Browser

Use an USB-A OTG cable (optional with purchase) to connect a USB to the micro-B USB port.
The port supports memory drives and USB add-on devices such as fiberscopes.

The File Manager (Files > USB) provides basic USB memory stick management tools to browse and manage
files without the need of a PC. If needed, use the micro-B USB to USB-A adapter to connect to the USB
memory stick.

When an OTDRmodule is used, OTDR test results (SOR files) can be imported.

Refreshes the USB stick info.

Erases the selected files or folders.
Exits the current folder and moves up to a higher folder in the file tree hierarchy. The current
folder structure is shown in the top bar.
Opens certain file types.

l HTML: Launches the browser to display its content (test results and OPM results)

l TXT: Launches a basic text viewer to display its content (test results and OPM results)

l PCAP: Launches the built-in Wireshark® protocol analyzer

l MTIE: Launches the optional built-in Wander Analysis tool
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l SOR: Supported with OTDR module or built-in test set only.

l PNG: Screenshots (Fiberscope images)
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Manage Internal SD Card

Internal SD Card Format

The SD card tool (Files >Manage) provides Internal SD card’s partition capacity information.

All saved files, such as profiles, test results, and screen shots, are stored in the Data partition 3(data).

If the data partition is nearly full, use the File Manager to backup files to USB, then delete selected files.

The Format function is exclusively a maintenance tool. UseONLY when instructed by a VeEX
Customer Care representative. It erases all the information stored in the test set!

l The internal SD Card contains the System OS, all the Test Applications (Apps) and user’s data.

l Only the Data partition is accessible to users, through the test set’s functions.

l Do not remove or reformat the SD Card outside of the test set.

l The SD card can only be accessed by opening the test set.
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Tools

Fiber Tools Overview

Fiber Tools Home Menu (FX150 reference)

Available Tool applications depend on the product model.

Fiber Scope

l "DI-1000 Digital Fiber Inspection Microscope" on page 290

l "DI-1000MPO Digital Fiber Inspection Microscope for Single and Multi-Fiber Connectors" on

page 291

l "DI-3000 Auto-Focus Digital Fiber Inspection Microscope" on page 295

The VeEX digital fiber inspection scopes evaluate fiber optic connectors for dirt and end face quality. The hand-
held probe design enables easy inspection of patch cords and connector panels. Extended tips are available
for hard to reach bulkhead or patch panel connectors. Clear images are displayed on the test sets for imme-
diate analysis and can be saved for record keeping.

The Fiberscope test application can be used in conjunction with any VeEX Digital Fiber Inspection Microscope.

All DI series fiberscopes can auto freeze image when focus is achieved to capture the image and qualify the
connector endface for cleanliness and damage per IEC 61300-3-35. For more information about available con-
nector tips, see the DI-1000/DI-1000MPO/DI-3000 Digital Fiber Inspection Microscope Adapter Tips Guide.

All wired fiber inspection scopes are powered via a USB Type-A connection with a host device or the VeEX
Power Bank/WiFi Bridge. For host devices that have Micro-B or Micro-C input ports, USB Type A to Micro-B or
Micro-C OTG dongle adapters are available as an add-on order from VeEX.

More about Fiber Scope functions

https://download1.veexinc.com/DI-3000/Specification-Sheet/7555/D05-00-144P_DI-1000_Adaptor_Guide.pdf
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OTDR Viewer

This built-in application allows the test platform to view previously saved .sor trace results and edit events, as
needed. IF an OPX-BOXe is connected to the platform via direct USB connection, WiFi or Bluetooth®., this
built-in application can also be used to control all OTDR test functions.

More about OTDR Viewer functions

OPM

The VeEX Inc Optical Power meters are made with fast and accurate testing in mind. They are used to meas-
ure the power running through a cable at a given wavelength, and interface with phone, PC, or other VeEX
devices to save and generate reports on the findings. This information is used to verify that the cable span is
working correctly and to find the source of the problem when it's not. When paired with a VeEX Optical Light
Source (OLS) or as part of a VeEX Optical Loss Test Set (OLTS), which includes both, WaveID can be used to
quickly test several wavelengths without having to adjust the OPM settings.

More about OPM functions

Browser

The built-in web browser uses the management port IP connection. An active IP connection can be established
either through Ethernet or WiFi. The web browser defaults to VeEX's test website. Use the Web browser's nav-
igation bar to enter the name of the website you wish to reach. Navigation capabilities may be limited.

More about Browser functions
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OTDR Viewer

This built-in application allows the test platform to view previously saved .sor trace results and edit events, as
needed. IF an OPX-BOXe is connected to the platform via direct USB connection, WiFi or Bluetooth®., this
built-in application can also be used to control all OTDR test functions.

To access the OTDR Viewer from the Platform Screen, select Tools >OTDR Viewer.

Once paired or connected to the micro OTDR, the test set displays a virtual OTDR user interface that is used to
control the OPX-BOXe and perform measurements.

l Traces and Events table view

l Loss calculations

l V-Scout Link Mapper option

l Compatible with Fiberizer Cloud (upload and download)

l Controls external OPX-BOXe OTDR

Since fibers are commonly placed in access, metro, and transport networks, having a companion add-on
OTDR to inspect drop fiber reduces dependence on specialized fiber construction crews troubleshooting fiber
related problems.

Refer to the OPX-BOXe User Manual for further details about OTDR operations.

https://download1.veexinc.com/OPX-BOXe/User-Manual/6794/OPX-BOXe User Manual.pdf
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Fiber Scope

l "DI-1000 Digital Fiber Inspection Microscope" on the next page

l "DI-1000MPO Digital Fiber Inspection Microscope for Single and Multi-Fiber Connectors" on

page 291

l "DI-3000 Auto-Focus Digital Fiber Inspection Microscope" on page 295

The VeEX digital fiber inspection scopes evaluate fiber optic connectors for dirt and end face quality. The hand-
held probe design enables easy inspection of patch cords and connector panels. Extended tips are available
for hard to reach bulkhead or patch panel connectors. Clear images are displayed on the test sets for imme-
diate analysis and can be saved for record keeping.

The Fiberscope test application can be used in conjunction with any VeEX Digital Fiber Inspection Microscope.

All DI series fiberscopes can auto freeze image when focus is achieved to capture the image and qualify the
connector endface for cleanliness and damage per IEC 61300-3-35. For more information about available con-
nector tips, see the DI-1000/DI-1000MPO/DI-3000 Digital Fiber Inspection Microscope Adapter Tips Guide.

All wired fiber inspection scopes are powered via a USB Type-A connection with a host device or the VeEX
Power Bank/WiFi Bridge. For host devices that have Micro-B or Micro-C input ports, USB Type A to Micro-B or
Micro-C OTG dongle adapters are available as an add-on order from VeEX.

The Importance of Fiber Connector Inspection

Dirty or scratched connectors introduce loss, increase ORL and/or damage other connectors (Loss and Return
Loss becomes more critical at higher data rates). End-face contamination is a leading cause of fiber link fail-
ures in data centers, corporate networks, MSOs and Telecom environments.

Fiber Inspection Scopes provide a magnified image of the fiber optic connector’s end face, focusing on the con-
tact areas (most likely to impact network performance or permanent damage by mating of contaminated con-
nectors). Images, visual inspection, and automated tools are often used to grade the health and cleanliness of
connectors, after polishing or cleaning and before being used.

To achieve maximum power and prevent false readings, clean the optical fiber connector interfaces before
inserting them into the test port.

Please ensure the correct fiber connector type is used before inserting it into the test
port or connector. Mismatched connector types will damage the optical end faces and the
test set.

https://download1.veexinc.com/DI-3000/Specification-Sheet/7555/D05-00-144P_DI-1000_Adaptor_Guide.pdf
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DI-1000 Digital Fiber Inspection Microscope

DI-1000 Digital Fiber Inspection Microscope

l Locknut: a threaded fastener that secures the tips in place.

l Inspection Tip: a front-end component inserted to view the connector endface

l Capture Button: a button that starts and stops (play or pauses) the video stream of the fiber end-

face to save an image at the current frame.

l Focus Knob: a rotating dial that can be turned clockwise or counterclockwise to view clearer image.

Make sure connector is properly seated in the adapter tip.

l USB Type A output: USB connector to plug into host power source to enable operation.

Single and Multi-fiber (MPO/MTP®) connector tips supported. For more information on using the DI-
1000, see the DI-1000 Quick Guide on www.veexinc.com.

http://www.veexinc.com/
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DI-1000MPO Digital Fiber Inspection Microscope for Single and Multi-Fiber Connectors

DI-1000MPO Digital Fiber Inspection Microscope for Single and Multi-Fiber Connectors

l WiFi support requires VeEX Power Bank/WiFi Bridge accessory and host

device/test set has built-in WiFi capability. See the test set's data sheet on

www.veexinc.com or contact VeEX Customer Care for more information.

l To work with single fiber tips, the front end tip should be replaced with the collar

provided with the scope. For more information adapter tips, see the DI-1000 Digital

Fiber Inspection Microscope Adapter Tips Guide on www.veexinc.com.

For more information on using the DI-1000MPO, see the DI-1000MPOQuick Guide on www.veexinc.-
com.

mailto:customercare@veexinc.com
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DI-1000MPO Fiber Analysis

There are two methods to inspect MPO fibers using the DI-1000MPO:

1. Touchscreen (standard)

Press the Capture Fiber button on the touchscreen for every MPO fiber properly focused, analyzed,

and scoped.

Press OK in the pop-up window to confirm the MPO fiber number, then adjust the scope controls

(horizontal (x-axis) control only) to navigate to the next fiber.

2. Fiber Scope button (fast)

Press the Capture button (located on the bottom of the DI-1000MPO fiberscope) successively to cap-

ture, confirm the MPO fiber number, and add the fiber screenshot to the list. As the x-direction (hori-

zontal control) is rotated to the next consecutive MPO fiber the logging actions are done on the

fiberscope itself. Scoping an MPO-12 fiber can be done under a minute.

Press New Group to create a new set of MPO images.

MPO Group - Add Image
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Aligning Fiber for Analysis

When using a DI-1000MPO+, which has a wider field of view, align the correct fiber between the two lines for
analysis.

The example below shows a completed MPO-12 cable inspection.

The key-up and key-down adapter that comes with the DI-1000MPO standard package is a straight-through
connection so the MPO fiber # at the start matches the MPO fiber # at the end (not flipped). When using the
adapter, fibers will be in the opposite orientation of the camera. In the below example, fiber #1 is on the right.

MPO Group - Completed (PASS)

To save MPO results, navigate to the Results tab once all fibers have been captured and press the Save but-
ton.



294 © VeEX Inc. All Rights Reserved. Platform Functions

To view results on the unit, on the Results tab navigate to thempo heading on the saved trace and press
Load. Tap each individual screenshot to view the individual MPO fibers.

MPO results
(Scope image appears on bottom right corner of the screen.)

Fiberscope MPO endface test viewed in an HTML browser
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DI-3000 Auto-Focus Digital Fiber Inspection Microscope

DI-3000 Wi-Fi Autofocus digital inspection scope

WiFi support requires host device/test set has built-in WiFi capability. See the test set's data sheet on
www.veexinc.com or contact VeEX Customer Care for more information.

mailto:customercare@veexinc.com
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Connecting the Fiberscope

Use an USB-A OTG cable (optional with purchase) to connect a USB to the micro-B USB port. The port
supports memory drives and USB add-on devices such as fiberscopes.

OPTICAL SAFETY

l Deactivate the laser before connecting or disconnecting optical cables or patchcord.

l Never look directly into an optical patchcord or optical interface while the laser is enabled. Exposure

to optical radiation for an extended period can caused irreparable damage to eyes.

l Never use a fiber microscope to check the optical connectors when a laser source is active.

The operator is assumed to have received basic training in fiber optics and related testing and measurement
practices.

Read the "Safety Information" on page 12 before beginning using optical features of the test set.

Fiber Scope image view requires the Fiber Scope Expert option to be enabled on the chassis/platform
except for the VS500 which can already include this option. This can be confirmed by viewing the device ID is
either -1500 or -2500.
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Attach the DI-1000/DI-1000MPO/DI-3000

Attach one end of the OTG cable (optional with purchase) to the microUSB port on the test set and the other
end to the fiberscope USB port.

Older analog fiberscopes require a USB adapter.

If using a DI-3000, WiFi can be used to connect to a platform with WiFi available. See below.

When the DI-1000, DI-1000MPO, or DI-3000 are powered, they will emit a blue LED. Select the tip that best
matches the connector endface that is to be inspected.

For more information about available connector tips, see the DI-1000 Digital Fiber Inspection Microscope
Adapter Tips Guide on www.veexinc.com.

After powering on and setting up the fiberscope, select the tip that best matches the connector endface that is
to be inspected.

Scope tips are secured in place with a locknut. There is a slot (specialty tips may have more than one slot) that
will ensure the tip is aligned properly to the top of the fiberscope prior to securing the locknut. Attach a tip by
rotating the locknut clockwise (tip faced away). Remove a tip by rotating the locknut counterclockwise (tip
faced away). With the correct tip fastened and secured, launch the Fiberizer application (PC, mobile, VeEX test
set) and plug into an available USB interface or connect to the WiFi network.

Rotate the round focus knob to manually bring the image into focus. For the DI-3000 scope, a built-in autofocus
button can also be used.

Once the fiberscope is detected, tap Yes in the pop-up window to enter the Fiberscope menu.

http://www.veexinc.com/
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Fiber Scope Detected Message

Alternatively, select the Test Application icon > Utilities > Fiber Scope.

Fiber Scope Connection Mode Selection (USB for direct connection, Wi-Fi for DI-3000 AP)

Select the USB Fiber Scope checkbox for wired fiberscopes, such as the DI-1000, DI-1000MPO, VS500 (dis-
continued), or DI-3000 via USB.
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SelectWiFi Fiber Scope to initiate a scan for an available DI-3000.

See the WiFi Wiz section for more information on setting up aWiFi Access Point if automatic scanning
fails.

The WiFi Access Point password is: "veex" plus the last six digits of the serial number of the
DI-3000 to connect with e.g. "veexA00700", where the serial number is SN:LA-3KA00700.
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Fiberscope Setup

Captured patch cord image files are saved within a folder directory. In the Setup tab, name each folder and file
in the directory and select a save increment.

Fiber Scope Setup - Page 1

l Scope mode: Sets Fiber Scope connection method.

l Local: Direct USB (wired) connection.

l Remote DI-3000: Wifi connection to DI-3000.

l Reset Con: Resets connection method currently used (Remote or Local) with fiberscope, so another

can be selected.

l Auto Save: Disable, Autosave on Tap, or Autosave after freeze. If Autosave on Tap or Auto-

save after freeze is enabled, the unit automatically saves and creates the filename using the Trace

ID after the test. The file location and name will display. Auto Save is available for single fiber ana-

lysis only.

l Disabled: Turns off Autosave function. When Autosave is disabled, results can be

manually saved on the Results tab after finishing the fiber endface inspection.

l Autosave on Tap: On the Capture tab, tap the screen to automatically save the cap-

tured image. “Tap screen to save” will appear to indicate that the feature is enabled.
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l Autosave after freeze: Automatically saves the captured image upon freezing the

image. (Auto-freeze enabled or normal Freeze.)

When Ask Before Save is selected, the Savemenu will display with naming and comment options.
The details entered in the following fields can be used to pre-set the filename automatically and increment the
fiber or test number automatically.

l Job ID, Cable ID, Fiber ID, and Trace ID are nested folders that store saved results. Folders are

nested in the following order: Job > Cable > Fiber > Trace.

Tap the blank fields to edit the names.

l Increment: Increments the selected ID name if an Auto Save option is selected.

Saved image files can be retrieved from File Manager or managed from the Results tab. Refer to "Working
with Saved Results, Profiles, Images" on page 279 for more details.

Fiber Scope Setup - Page 2
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Fiber Scope Setup - Page 3

Analyze Fiber Connectors

1. After assigning the scope mode and save options on Page 1, select the analysis profile from the Ana-

lysis parameters drop-down box on Page 2/2 of the Setup tab.

The analysis profile is based on the fiber endface connector inspected, as well as applicable to

MTP™/MPO (multi-fiber) connectors. .

l PC, SM RL ≥ 45 dB: SPC or UPC polished connector

l PC, SM RL ≥ 26 dB: Older connectors with flat or PC polish (used with LC/MU)

l APC, SM: Angled polished connector

2. Select the Tip Type from the drop-down box. Tip Type is used to optimize Pass/Fail analysis for cer-

tain types of connector tips.

l General: Encompasses standard SC, FC, ST, and other 2.5 mm ferrules. LC/APC and

E2000/APC should not use general tip type.

l LC: Lucent connector (male). Use on all 1.25 mm connectors with ceramic (LC/MU con-

nectors).
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l LC female: Lucent connector (coupler/bulkhead). Use when inspecting 1.25 mm type patch

panels, MUX and test ports.

l E2000™: Proprietary family of connectors invented by Diamond SA known for its low insertion

loss characteristics and built-in (latched) shutter. Use when inspecting Diamond E2000 con-

nector with ceramic ferrule.

l E2000/APC Metal: Use when inspecting Diamond E2000 APC connector with metal ferrule.

l Evolv™: Use when inspecting Corning Evolv terminal connector ports.

l LC APC short extended A6 female: Use when inspecting hard to reach LC/APC connector

coupler/bulkhead.

l MPO PC female: Use when inspecting SM ribbon cables with MPO/MTP via coupler.

l MPO APC female: Use when inspecting SM ribbon cables with MPO/MTP angle polished con-

nector via coupler.

l MPO MM female: User when inspecting MM ribbon cables with MPO/MTP connector via

coupler.

3. After the image is frozen, select the Auto center/Crop checkbox to take the current video frame and

center it by the detected fiber image inside the program window, i.e. in case of long (extension) tips

or handshaking. Initially, a blank screen will display. This is ideal for APC images. This is recom-

mended when inspecting Angled bulkheads/couplers with Shake OFF.

4. Select the Capture tab.
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Capture Images (View)

The Capture tab is the main user interface for the connector end face inspection and analysis. It presents a
real-time view of the connector’s end face allowing for alignment and focus. Page 1 of the capture screen dis-
plays a live image of the connector face and features analysis and freeze tools.

The fiber end face image will normally display near the middle of viewing window area. The exception will be
when inspecting bulkhead/couplers of APC connectors or using A6 type tips. The end face image will appear
off-center. AutoFocus and Shake OFF setting is recommended when inspecting couplers. Gently adjust cen-
tering while manually focusing the image and image will freeze as soon as focus is achieved.

For the DI-3000, press the autofocus (red target) button when the image is out of focus to enable the device's
automated focusing operation. With a steady hand, the end face will be promptly autofocused and ready for
capture.

Initially, there is no screen shown until Resume is pressed.

Real time video of the connector face. Red contours indicate scratches and defects.

Fiber Scope Capture - Dots vs Rectangles



Platform Functions © VeEX Inc. All Rights Reserved. 305

The radio buttons on the right panel do not indicate the current state or setting, they indicate the action that
would take place if pressed. For example, if “Analysis OFF” is tapped, the analysis function is turned OFF and
the button displays “Analysis ON”.

l Resume / Freeze: Stops the video capture from the fiberscope. If the optional Auto Freeze feature is

enabled, the test set will automatically freeze the image when it comes into focus. Once the image is

frozen, tap the image to save it.

l Analysis On / OFF: Turn ON/OFF the automatic Pass/Fail threshold defined by IEC 61300-3-35.

l Auto Freeze: Turn ON/OFF the ability to freeze the video automatically, when in Focus. The default

is set to OFF. To see the image after it freezes, tap Resume.

Auto Freeze may be useful when scoping certain angled polish fibers.

l Rectangles / Dots: Dots draw a red contour around scratches and defects. Rectangles highlight

scratches and defects without obstructing the view. The selection between dots or rectangles does

not affect the area calculation or the Pass/Fail results. Dots are set as default.

l Shake: Turn ON or OFF the ability to Auto Freeze or Analyze when probe image is unsteady, such

as when inspecting a female connector or bulkhead. It minimizes significant vibrations and unstead-

iness generated from the fiberscope being held. Typically, this function is not always needed with

the use of image focusing.

When inspecting bulkhead couplers or MUX/transceivers set Shake to OFF.

l MPO mode: Turn ON when inspecting ribbon fibers (MPO/MPT connectors). Create a New Group

for each MPO ribbon and Capture Fiber to save an image for each strand.

When inspecting MPO/MPT connectors, it is recommended to set Auto Freeze and Shake toOFF.
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Fiber Scope MPO mode

To save the image on the screen, tap the screen after freezing.

After saving, go to Results or > Utilities > FilesFiles to view the report and export to PDF or USB.

Fiber Scope Capture - PASS

In the example above, the message in blue states that the image can be saved when tapped. This indicates
that the Autosave on Tap option was enabled on Page 1 of the Setup tab. If Autosave after freeze were
selected, no message to tap the screen would appear.

Page 2 displays all numeric results from defect and scratch events found for all four zones. These are used for
the evaluation of the Pass/Fail criteria, according to the IEC 61300-3-35 standard. (Scratch requirements refer
to width.)

This table will also be included in the reports.
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Pass/Fail IEC analysis table
(Measured scratches and defects compared with threshold criteria for each fiber layer)
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Results/Reports

Fiber Scope Analysis
(For Fiberscope Results, Scope image appears on bottom right corner of the screen.)

The results screen is used to view previously saved results. Test results can be pushed/pulled from Fiberizer
Cloud. The directory displays the location of stored files. Connect to Fiberizer Cloud, then select the file(s) by
tapping them.

l Push/In Sync: Uploads locally saved results to Fiberizer Cloud. In Sync indicates the results have

been saved to Fiberizer Cloud successfully.

l Load: Loads the selected image onto the Capture tab.

l Save: Manually saves and names the image displayed in Capture (autosave is disabled). Once

saved, the files can be accessed in the "File Manager" on page 279 or R-Server.

l Modify: Select a file or folder in the directory to modify. Options to Rename, Remove, and upload

the selection to Fiberizer Cloud are available.

l Pull: When connected, pulls file from Fiberizer Cloud onto test set.

l USB Export: Exports files to USB stick. Choose Export Group to retain the tree format (sub-dir-

ectory) or Export Flat to create a single filename using sub-directories to build a name.

In the Result Files example above when choosing to retain the tree format, the highlighted 022-

tst001 results file can be found in the following directory after exporting:

>fx150build64_rc > sc-apc-m b01.

../../../../../Content/Procedures/V150_V300_Platform/Advanced_Tools/R-Server-testset.htm
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Fiberscope test viewed in an HTML browser

Reports can also be viewed as pdf files.
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Test Analysis Report

To view the report files, tap Utilities>Files>Save. The Fiber Scope test report can be viewed in JPG format or
exported to PDF. In addition, all fiber optic test results can be viewed using Fiberizer Cloud or the Fiberizer
Desktop Plus PC software. For more information on viewing reports, see "File Manager" on page 279.

Analysis Report (.jpg format)
The test report can also be viewed in HTML format.

Test Report viewed in an HTML browser
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Fiberizer Cloud

Fiber test results including Fiberscope images can also be uploaded to a registered Fiberizer Cloud account.
Registration is free.

Connecting to Fiberizer Cloud

To connect the test set to Fiberizer Cloud, you must be a registered user. For new users, go to the fiber-
izer.com website from a PC Internet browser to register before proceeding with these directions.

Go to http://fiberizercloud.com to register.

1. After registering, tap on Modify > Settings.

2. Enter the username and password, then tap Check. If the message Connection has been suc-

cessfully verified does not display, recheck the username and password.

3. Tap Select to choose a project folder to upload files to and tap OK.

4. Save or Discard the cloud login details.

Settings to connect to Fiberizer Cloud

Uploading/Downloading Files with Fiberizer Cloud

Before attempting to upload or download, ensure that the test set is successfully connected to Fiberizer Cloud.
Tap Push next to a directory item to upload it into Fiberizer Cloud. Tap Pull to download the directory collection
from Fiberizer Cloud.

The Project selection defines the project folder location on the Fiberizer Cloud account to which to save the res-
ults. The default setting uploads to the global root folder.

http://fiberizer.com/
http://fiberizer.com/
http://fiberizercloud.com/
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For a project folder to appear in the project list, it must be created in Fiberizer Cloud first. The test set can-
not create Fiberizer Cloud project folders.

After pushing results to the Fiberizer Cloud project, check the Jobs folder to which the saved cable folder was
uploaded. Use Fiberizer Cloud to create professional reports or serve as an online storage backup. The
example below shows MPO results on Fiberizer Cloud.

MPO Fiber View on Fiberizer Cloud
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Optical Power Meter (OPM)

The VeEX Inc Optical Power meters are made with fast and accurate testing in mind. They are used to meas-
ure the power running through a cable at a given wavelength, and interface with phone, PC, or other VeEX
devices to save and generate reports on the findings. This information is used to verify that the cable span is
working correctly and to find the source of the problem when it's not. When paired with a VeEX Optical Light
Source (OLS) or as part of a VeEX Optical Loss Test Set (OLTS), which includes both, WaveID can be used to
quickly test several wavelengths without having to adjust the OPM settings.

Optical Power Meter

Only optical power meters (e.g. Built-in or FX4x/8x OPM series meters) approved by
VeEX are supported. WaveID will work with OLS in CWmode only. Accessing the
Optical Power Meter module shuts down GPS and the atomic service.

Do not connect the fiber before opening the OPM application. First, zero the
meter with the dust cap closed before making any measurements.
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Connecting to the internal (built-in) OPM

1. Tap the X icon to close OTDR mode. The Fiber main menu appears.

2. Tap Optical Power Meter on the main menu. The OPM screen appears with the Caution warning.

Alternatively, access the OPM screen by selectingOptical Power(USB) from the Platform menu.

Connecting an External OLTS Device

1. Insert USB dongle into the test set's microUSB port and connect it to a VeEX Inc. supported Optical

Light Test Set (OLTS) device before launching the application.

2. Power on the external meter. Then, tap Optical Power Meter on the menu. The External OLTS

device(s) found screen appears.

3. Select the connected external meter and tap Connect to proceed to the external OPM menu or Use

Internal to use the built-in OPM menu if it supported by the test set. The OPM screen appears with

the Caution warning.

The Name of the External OLTS device is Displayed Once Detected
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OLS Menu

Setup and Measurements

OPM Menu
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l Wavelength: Matches the calibrated wavelength to the signal being measured.

l Wave ID: Detects the incoming wavelength automatically from a supported VeEX Inc.OLS. Use

when operating the OLS in continuous wave (CW) mode with or without Loop enabled.

l dB/dBm: Switches between dB and dBm measurement units. A Green dB button shows absolute

power level in dBm. A Blue dB button measures relative power loss in dB. Use the Set (Reference)

and Enter (edit Reference) to set Reference, edit Reference, and view measurements in three units:

dBm, dB, and Watts.

After toggling to the dB button to blue, the Set and Enter buttons appear.

l Set: Sets the reference value for the current wavelength.

l Enter: Edits current wavelength reference value.

l Hold: Freeze measurement to the last power or loss reading on the screen. “HOLD” appears next to

“Optical Power” when tapped. Tap Hold again to unfreeze it.

l Acquire: Loads current measured value into the Table tab. The Table tab indicates how many new

records have been temporarily saved into memory. In manual IL test mode, the Acquire button must

be used to capture each individual reading (e.g. same fiber at different wavelengths) unless Loop is

turned on.

If your device is equipped with a built-in clock, the saved measurement result will have a
time stamp.

To permanently save the table of results, you must save into a test file.

l Zero: Recalibrates the OPM to treat current conditions as zero. Used when measurement conditions

change significantly or to re-calibrate the OPM. Make sure the cover is shut on the OPM test port

before tapping Zero. When in doubt, recalibrate prior to making any measurements, e.g, when test-

ing in cold outdoor temperatures and then moving testing into a heated building.

Put the cover over the OPM test port BEFORE recalibrating.
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l OPM Server On:Remote control feature not currently supported. Broadcasts the IP address on the

current network for users to connect to the test set module's built-in optical power meter through Eth-

ernet/TCP/IP using Fiberizer LTSync Windows Desktop software for remote control and access.

l Mode: Designates the measurement specification built-in: PM1 (-70 to +10dBm), PM2 (-50 to

+25dBm), or PM3 (-65 to +15dBm). For specific information on the PM1, PM2, and PM3 spe-

cifications, see the platform's datasheet at www.veexinc.com.

Calibrating to Laser Source

To perform loss (dB) testing, the meter must be referenced (calibrated) to the Laser Source output.

To measure reference cable loss using the built-in light source (Loopback Referencing):

1. If beginning testing, zero the meter by closing the dust cap and pressing the Zero button.

2. Connect the port with the desired wavelength OLS to the OPM port using a patch cord.

3. Turn on dB measurement by toggling the dB button to blue.

4. Select the OLS tab, select the laser wavelength, and turn ON. Press Loop to cycle through all sup-

ported wavelengths.

5. Select the OPM tab and select the measurement wavelength or pressWave ID to automatically

detect the correct wavelength.

6. Tap Set to record the 0.00 dB point. A reference point is established and the calibrated LS can be

connected to the far-end of the fiber to measure the loss. Tapping Set will overwrite previously

saved reference value(s).

To measure reference cable loss using an external light source: 

1. Connect the OLS to the OPM port using a patch cord.

2. Turn on dB measurement by toggling the dB button to blue.

3. Select the measurement wavelength. If using a supported VeEX light source in CW mode, pressing

"Wave ID" automatically selects the correct wavelength.

http://www.veexinc.com/
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4. Tap Set to record the 0.00 dB point. A reference point is established and the calibrated LS can be

connected to the far-end of the fiber to measure the loss. Tapping Set will overwrite previously

saved reference value(s).

Measuring Power (dBm)

1. If beginning testing, zero the meter by closing the dust cap and pressing the Zero button.

2. Insert the fiber being tested into the OPM port.

3. Select the measurement wavelength. If using a supported VeEX light source in CW mode, pressing

"Wave ID" automatically selects the correct wavelength.

4. Tap Acquire to record a result. Acquired results can be viewed from the Table tab and saved from

the Results tab.

Measuring Loss (dB)

1. Set reference values for all testing wavelengths (refer to [Calibrating to Laser Source] for more

details.

2. Remove the reference cable and connect fiber to the OPM port on the unit.

3. Tap Acquire to record a result. Acquired results can be viewed from the Table tab and saved from

the Results tab.

Readings (Table tab)

OPM readings appear in the Table tab. Saving readings will permanently write data to the Results tab. More
than one reading can be saved at a time. Use this function to organize/filter results in project batches, so that
the correct set of results are grouped together appropriately. Pressing Remove will permanently remove the
readings from the current list.

To view and save (enter) test results into the Results table:

1. Select the OPM tab. Verify the insertion loss (IL) values are acceptable, then tap Acquire to load val-

ues into the Table tab. The Table tab title shows how many fiber records have been temporarily

saved in the format Table*-n NEW, where n is the number of new records.
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2. To view the active results table, select the Table tab.

3. To permanently save the fiber record locally, select the record(s) and press Save. The Result sav-

ing screen appears. The filename will default to the date/time stamp unless a specific file name is

entered.

The JobID/CableID/FiberID/TraceID fields determine the location to which the trace is saved. If these set-
tings are not set accurately, the trace will not save to the desired location.

4. Tap OK. The readings are saved to a file and the table resets.

To remove results before saving, select the checkbox next to the reading(s), then tap Remove.
After saving power or loss readings to a file, access the file in the Results tab.
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Results

Results can be saved to the test set, exported to USB, or uploaded to Fiberizer Cloud.

Results Management Menu

The results screen is used to view previously saved results. Test results can be pushed/pulled from Fiberizer
Cloud. The directory displays the location of stored files. Connect to Fiberizer Cloud, then select the file(s) by
tapping them. Refer to "Fiberizer Cloud" on page 311 for details on connecting to Fiberizer Cloud. Refer to
"Results/Reports" on page 308 for more details on fiber test results.

Use the following options when using the Results screen:

l Push/In Sync: Uploads locally saved results to Fiberizer Cloud. In Sync indicates the results have

been saved to Fiberizer Cloud successfully. To push the results to Fiberizer Cloud, ensure con-

nection to the network via Ethernet or WiFi, and then tap Modify>Settings to sync with Fiberizer

Cloud. Then, tap Push to sync saved files to the cloud.
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Fiberizer Cloud set up screen

l New: To create a new folder.

l Save: Saves results. Once saved, the files can be accessed in File Manager and R-Server (if avail-

able). Refer to "Working with Saved Results, Profiles, Images" on page 279 and R-Server for more

information.

l Modify: Select a file or folder in the directory to modify. Options to Rename, Remove, and upload

the selection to Fiberizer Cloud are available.

l Pull: When connected, pulls file from Fiberizer Cloud onto the test set.

l USB Export: Exports files to a USB stick. Choose Export Group to retain the tree format (sub-dir-

ectory) or Export Flat to create a single filename using sub-directories to build a name.

l Save continuously: To autosave results at a specified interval (1 to 60 seconds). Use this option to

check power drift.

../../../../../Content/Procedures/V150_V300_Platform/Advanced_Tools/R-Server-testset.htm
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Web Browser

A web browser is available in the Tools > Browsermenu and can be used to quickly verify Internet con-
nectivity.

The built-in web browser uses the management port IP connection. An active IP connection can be established
either through Ethernet or WiFi. The web browser defaults to VeEX's test website. Use the Web browser's nav-
igation bar to enter the name of the website you wish to reach. Navigation capabilities may be limited.
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Help

The Help option opens up the user manual. Use the scroll bars, table of contents, and hyperlinks to navigate
the content.

Help
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Software Update Process

1. To download the latest software version, go to www.veexinc.com and use any of the following

options:

a) Enter the full product name in the Search box, click on the Software section to expand it, and

download the appropriate software installer package.

b) Go to the >Support > Software section and enter the first four characters of the product's serial

number, to obtain the software installer package specific to the product.

2. Unzip the downloaded file(s) and copy the file ending in .tar.gz or .tar.xz to the root directory of a

FAT32 USB flash drive.

3. Connect the AC/DC adapter to the test set.

4. Turn off the test set and plug the USB into a USB-A to micro-B USB OTG adapter.

5. Connect the USB OTG adapter to the test set's micro-B USB port.

At this point, it is possible to perform a clean or standard software update. Be sure to back up all data prior to
performing a clean software update as it will reformat the internal storage and erase all user settings and test
results.

A clean software update will erase all user settings, test profiles and saved results. Use the
"USB Memory Browser" on page 283 in the >File Manager to back up all data prior to per-
forming a clean software update.

l Clean software update: Press and hold the Save and Power buttons simultaneously.

l Standard software update: Press and hold the Home and the Power buttons simultaneously.

In both instances, press and hold the buttons for at least 3 seconds, then release.

The unit will automatically locate and load the software file from the USB flash drive. Wait for the upgrade pro-
cess to finish.

After the software upgrade is completed, go to the Utilities > Aboutmenu to confirm the software version.

http://www.veexinc.com/
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Software Version is displayed in the About section.
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Certifications and Declarations

What is CE?

The CE marking is a mandatory European marking for certain product groups to indicate conformity with the
essential health and safety requirements set out in European Directives. To permit the use of a CE mark on a
product, proof that the item meets the relevant requirements must be documented.
Use of this logo implies that the unit conforms to requirements of European Union and European Free Trade
Association (EFTA). EN61010-1

For a copy of the CE Declaration of Conformity relating to VeEX products, please contact VeEX cus-
tomer service.

RoHS ComplianceVeEX QUALITY AND ENVIRONMENTAL POLICY

Our quality and environmental policy is to limit and progressively eliminate the use of hazardous substances
and chemicals in the design and manufacture of our products.

VeEX products are classified as Monitoring and Control Instruments under Article 2, Section (1), Category 9 of
the WEEE 2002/96/EC Directive.

mailto:customercare@veexinc.com
mailto:customercare@veexinc.com
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RoHS and WEEE Position Statement
The Council of the European Union and the European Parliament adopted Directive 2002/95/EC (January 27,
2003), to Reduce the use of certain Hazardous Substances (RoHS) in Electrical and Electronic Equipment,
and Directive 2002/96/EC onWaste Electrical and Electronics Equipment (WEEE), with the purpose of redu-
cing the environmental impact of waste electrical and electronic equipment. Both were later recast by Dir-
ectives 2011/65/EU and 2012/19/EU respectively. All VeEX products being placed on the EUmarket conform
with these directives.

Additional RoHS substance restrictions for the Monitoring and Control Instruments were adopted by EU Dir-
ective 2015/863 (March 31, 2015). These new restrictions will take effect from July 22, 2021. VeEX has estab-
lished a program to ensure that from July 22, 2021, all its products to be sold and shipped into the EUmarket
will conform with (EU) 2015/863.

VeEX Inc. is committed to comply with RoHS andWEEE Directives to minimize the environmental impact of
our products.

For more information about RoHS as it relates to VeEX Inc, go to www.veexinc.-
com/company/rohscompliance .

http://www.veexinc.com/company/rohscompliance
http://www.veexinc.com/company/rohscompliance
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About VeEX

VeEX Inc., a customer-oriented communications test and measurement company, develops innovative test
and monitoring solutions for next generation telecommunication networks and services. With a blend of
advanced technologies and vast technical expertise, VeEX products address all stages of network deploy-
ment, maintenance, field service turn-up, and integrate service verification features across copper, fiber optics,
CATV/DOCSIS, mobile 4G/5G backhaul and fronthaul, next generation transport network, Fibre Channel, car-
rier & metro Ethernet technologies, WLAN and synchronization.

Visit us online at www.veexinc.com for the latest updates and additional documentation.

VeEX Incorporated
2827 Lakeview Court
Fremont, CA 94538
USA
Tel: +1 510 651 0500
Fax: +1 510 651 0505

Customer Care

Tel: + 1 510 651 0500
Email: customercare@veexinc.com

http://www.veexinc.com/
mailto:customercare@veexinc.com
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